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Overview

Welcome to Colasoft Capsa.

Designed for packet decoding and network diagnosis, Colasoft Capsa monitors the network traffic transmitted

over a local host and a local network, helping network administrators troubleshoot network problems. With the

ability of real time packet capture and accurate data analysis, Colasoft Capsa makes your network transparent
before you, letting you fast locate network problems and efficiently resolve hidden security troubles.

With the help of Colasoft Capsa, you can easily accomplish the following tasks:

Network traffic analysis

Network communication monitoring
Network problems diagnosis
Network security analysis

Network performance detecting
Network protocol analysis

okl wnpE

Colasoft Capsa supports monitoring multiple adapters (enterprise edition only), letting you view the traffic passing
through your network via different adapters.

Advanced analyzers provide more detailed information about network traffic, allowing you to view the analyzed
data of email messages, FTP transfers, HTTP requests and DNS analysis.

Simple filters and advanced filters can narrow the target hosts, letting you quickly focus on suspect traffic and
identify the source of network troubles.

Statistics and graphs let you view network communications in various ways, bring you an overall and visual
impression of your network.

The featured Diagnoses list network diagnosis events and provide possible reasons and solutions; Matrix
dynamically shows you mapped network traffic between network nodes, and Reports provide real time statistic
reports of global network or specific groups.

Four built-in network tools Packet Builder, Packet Player, MAC Address Scanner and Ping Tool, make it possible
for you to create, edit and send out packets, replay packet files, scan Mac addresses, ping IP addresses and
domains during monitoring. In addition, external Windows applications or tools can be customized to add to the
program.

Flexible and intuitive interface is the outstanding feature of Colasoft Capsa, you can easily switch from an overall
statistics to the details of a specific network node, and even a rookie user can start to manage it in a few moments.

Colasoft Capsa, professional and enterprise

This manual serves for Colasoft Capsa 6.9 series, including two editions: professional and enterprise. The two
share many features. When the text refers to "Colasoft Capsa" without further qualification, it applies equally to
either edition.

The professional edition offers all the necessary features of a great network monitoring tool at an inviting price, it
can meet IT professionals' basic needs in network traffic monitoring and protocol analysis.

The enterprise edition has many more advanced features than the professional edition, such as capturing
loopback packets on local host, available statistic graphs and reports, advanced packets filters, simultaneously
monitoring multiple adapters, etc.

Edition differences
The following table presents the main differences between Colasoft Capsa professional edition and enterprise
edition. The features marked with Yes are available.

© 2009 Colasoft. All rights reserved. Colasoft®, the Colasoft logo, Capsa® are among the trademarks or registered trademarks of the company in
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Feature Professional Edition Enterprise Edition
Ethernet
compatible Yes Yes
Adapters adapters
Loop-back N/A Yes
adapters
Adapter amount opened in a project One Multiple
Network profile N/A Customizable
Summary statistics snapshot N/A Yes
Packet filters Simple Simple and Advanced
Graphs N/A Yes
Matrix N/A Yes
Reports N/A Yes
Network diagnoses Yes Yes

Version and upgrade

Version is a particular release of a software product. A version number is assigned by a software developer to
identify a particular program at a particular stage, before and after public release. Successive public releases of a
program are assigned increasingly higher numbers. Version numbers usually include decimal fractions. Major
changes are usually marked by a change in the whole number (e.g. Colasoft Capsa 6.0 and Colasoft Capsa 5.0),
whereas for minor changes only the number after the decimal point increases (e.g. Colasoft Capsa 5.2 and
Colasoft Capsa 5.5).

A version may have a couple of editions, whereas an edition may be involved in different versions of a software
product. Actual deployment features vary by product edition. In Colasoft Capsa version 5.0 and latter, the editions
are professional and enterprise.

Colasoft Capsa has two kinds of upgrade: version upgrade and edition upgrade, each is subject to specific policy.
You are always welcome to upgrade your product from a previous version to the latest one, whatever the upgrade
is major or minor, or from the edition professional to enterprise.

Checking version
You can easily check your product version or the latest version of Colasoft Capsa.

Current version
In some cases when you contact Colasoft you are required to provide your product version. To check product
version, open Help menu and choose About Colasoft Capsa....

Checking for the latest version
Colasoft suggests you to check for the latest version regularly. You may click Colasoft Home Page in the Help
menu or visit http://www.colasoft.com/analyzer/ to get the latest upgrades information.

Version upgrade

You can free upgrade your product to a newer version if your purchased maintenance hasn't expired when the
newer version is released. Otherwise you need to purchase a renewal maintenance.

The maintenance doesn't affect the use of product, if you wouldn't like to renew your product, you are allowed to
continue using the purchased version.

Edition upgrade

You can upgrade your product from an inferior edition to an advanced edition. For example, if you purchase
Colasoft Capsa professional originally and would like to upgrade it to Colasoft Capsa enterprise, you just need to
pay the price difference between these two editions.

© 2009 Colasoft. All rights reserved. Colasoft®, the Colasoft logo, Capsa® are among the trademarks or registered trademarks of the company in
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Install and Uninstall

Colasoft Capsa is easy to install and configure for a variety of operating environments. This chapter describes the
minimum system requirements for Colasoft Capsa and presents recommended configuration according to
different network scale. It illustrates how to install the program in various environments, explains how to configure
your system to get desired network data and gives some topologic examples.

Note: Please do not install Colasoft Capsa on a public machine or server to prevent unauthorized access to the
program.

System requirements

Colasoft Capsa can be installed on many Windows operation systems, such as Windows 2000, Windows XP and
Windows 2003. Your system's performance and configuration will affect the running status of Colasoft Capsa. The
following minimum requirements are the base line to install and run Colasoft Capsa normally; it would be better if
your system has a higher configuration, especially in a busy or big network.

Minimum requirements:

P4 1.2G CPU

512 MB RAM

Windows 2000 (SP 4 or later), Windows XP (SP 1 or later), Windows 2003 (SP2 or later), Windows Vista and x64
Edition, Windows Server 2008 and X64 Edition, Windows 7 32bit and 64bit Edition.

Internet Explorer 5.5 or higher

Recommended requirements:

P4 3.0G CPU

1 GB RAM or more

Windows 2000 (SP 4 or later), Windows XP (SP 1 or later), Windows 2003 (SP2 or later), Windows Vista and x64
Edition, Windows Server 2008 and X64 Edition, Windows 7 32bit and 64bit Edition.

Internet Explorer 6.0 or higher

Notes:

Supports Windows XP/2003 x64 Editions.

Multiple CPUs and dual core CPU are supported.

You are required to have the "Administrator" level privileges on supported operating system in order to load and
unload device drivers, or to select a network adapter for using the program to capture packets.

Installation and configuration

Colasoft Capsa can monitor and analyze the data transmitted in intranet and/or between intranet and extranet, or
over VLAN; however, only with correct installation and configuration can the program work properly. The following
sections introduce how to install and configure Colasoft Capsa in different network environments, including shared
network and switched network.

Installation Environment

Shared network and switched network are two common network environments today, before install Colasoft
Capsa, you should first know about the topology of your network.

Shared network
A shared network is also known as hubbed network which is connected with a hub.

Hubs are commonly used to connect segments of a LAN. When a packet arrives at one port, it is copied to the
other ports so that all segments of the LAN can see all packets. A passive hub serves simply as a conduit for the
data, enabling it to go from one device (or segment) to another. So-called intelligent hubs include additional
features that enable an administrator to monitor the traffic passing through the hub and to configure each port in
the hub. Intelligent hubs are also called manageable hubs. A third type of hub, called a switching hub, actually
reads the destination address of each packet and then forwards the packet to the correct port.

With a shared environment, Colasoft Capsa can be installed on any host in LAN. The entire network data

transmitted through the Hub will be captured, including the communication between any two hosts in LAN.
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Topology illustration 1:

Router

Install and Uninstall

Colasoft Capsa
Metwork Analyzer

Hukb

Server A Server B

Switched network

Switch is a network device working on the Data Link Layer of OSI. Switch can learn the physical addresses and
save these addresses in its ARP table. When a packet is sent to switch, switch will check the packet’s destination
address from its ARP table and then send the packet to the corresponding port.

Network with managed switches

Generally all three-layer switches and partial two-layer switches have the ability of network management; the
traffic going through other ports of the switch can be captured from the debugging port (mirror port/span port) on
the core chip. To analyze the traffic going through all ports, Colasoft Capsa should be installed on this debugging

port (mirror port/span port).

The following table presents the advantages and disadvantages of using a switch with mirror port.

Advantage
No additional facility required
No need to change network topology

Disadvantage

Occupies a switch port

Possible influence to network transmission
performance when meeting huge traffic

Topology illustration 2:

Router

=

Managed Switch

Sarver &

Analysis Porl

Colasoft Capsa

b"a‘? Metwaork Analyzer
-_— -l S

4’- -
T
~

Server B

Network with unmanaged switches
If your switch has no management function, you can:
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Install and Uninstall

Connect a tap with the line to be monitored
Taps can be flexibly placed on any line in network. When the requirement for network performance is very high,
you can add a tap to connect your network. The following table presents the advantages and disadvantages of

using a tap.

Advantage
No influence to network transmission

performance
No interference with data stream and raw data
Does not occupy IP address, free from network

Disadvantage

High cost

Additional facility (tap) required
Requires dual adapters
Cannot connect Internet

attacks
No need to change network topology

Topology illustration 3:

Colasoft Capsa

Router Netwark Analyzer

Single-port Tap

Unmanaged
Switch

Server A Server B

Connect a hub with the line to be monitored
Working on share mode, hubs are applicable for small networks.

Advantage

Low cost

No need to be configured

No need to change network topology

Disadvantage

Additional facility (hub) required

Interference to network transmission performance when
meeting huge traffic

Not applicable for big networks

Topology illustration 4:

Colasoft Capsa

Router Metwork Analyzer

Unmanaged
Switch

Sarver B

Sarver &
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Monitoring a network segment

In the case when you only need to monitor the traffic in a network segment (e.g. Finance department, Sales
department, etc.), you can connect the server on which Colasoft Capsa is installed and the network segment with
a exchange facility. The exchange facility can be hub, switch or proxy server.

Topology illustration 5:

L1 Router Colasoft Capsa

Metwork Analyzer
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Workstation Servers Application Servers

Note: Commonly management switches have the function of port mirroring (spanning); however, the port
mirroring configuration of one brand’s switch may differ from others, please refer to the documentation that comes
with your switch for information on the availability of this feature and the configuration instructions.

Switch and port monitoring

Switch is a network exchange facility operating at the data link layer (layer 2) and sometimes the network layer
(layer 3) of the OSI Reference Model. Classified by working protocols, there are two-layer switch, three-layer
switch, four-layer switch and multiple-layer switch. Switch also can be classified into managed switch and
unmanaged switch. Generally, three-layer switch and above has management function (managed switch).

Unlike hubs, switches prevent promiscuous sniffing. In a switched network environment, Colasoft Capsa (or any
other Colasoft Capsa) is limited to capturing broadcast and multicast packets and the traffic sent or received by
the PC on which it is running.

However, most modern switches (management switches) support “port mirroring”, which is a feature that allows
you to configure the switch to redirect the traffic that occurs on some or all ports to a designated monitoring port on
the switch. With this feature, you can monitor the entire LAN segment in switched network environment. Please
refer to the documentation coming with your switch for the availability information about this feature and
configuration instructions.

If your switch dose not support "port mirroring”, you can install Colasoft Capsa on a workstation connected to the
same hub as your Internet gateway, or on your Internet gateway (if acceptable), thus you can monitor all network
traffic between your intranet and the Internet.

A list of some managed switches (with port monitoring/spanning) which are commonly used is available on our
website.

Configuring a switch
Colasoft Capsa should be installed on the host/server connected with the switch’s mirror port (span port).

Mirror port configuration:
Mirror the way out port to the management port (mirror port), in this way the entire data transmitted into/out of LAN
can be monitored.

Mirror all way out ports to the management port (mirror port), in this way not only the entire data transmitted
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into/out of LAN but also the communication among hosts in LAN can be monitored. (Recommend)

Note: Different brands' switches may apply different mirror port configurations, please refer to the instructions
coming with your switch.

The following are two examples for CISCO switch using the "monitor" command in configuration mode:

Format:
#monitor session number source interface mod_number/port_number
#monitor session number destination interface mod_number/port_number

Examples:

Mirror session 1: mirror port 1-10 to port 12
#monitor session 1 source interface 1/1-10
#monitor session 1 destination interface 1/12

Mirror session 2: mirror port 13-20 to port 24

#monitor session 2 source interface 2/13-20

#monitor session 2 destination interface 2/24

Change the corresponding parameters when there are multiple mirror sessions or modules.

Installing Colasoft Capsa

Before install Colasoft Capsa, please carefully read the system requirements and the ReadMe file that comes with
the program. To avoid possible incompatibilities, it is recommended that you uninstall any earlier or trial version of
Colasoft Capsa and close all running applications.

Installation Process:

When you launch the installation file, the first window you will see is the Welcome screen, telling you that Colasoft
Capsa will be installed on your machine.

Read the License Agreement carefully in the next screen to understand our terms and conditions concerning
possession and use of Colasoft Capsa. You must accept the terms of the license agreement to continue the
installation.

The next screen presents the important information from the ReadMe file.

The next Select Destination Location dialog suggests the default location in which to install Colasoft Capsa. Use
the browse button to designate an alternate installation location.

The next Select Components dialog for you to select install which build-in tool listed in this page.

Select a start menu folder in the next screen. Use the browse button to designate an alternate start menu folder.
Select Additional Tasks in the next screen.

Now you are ready to Install Colasoft Capsa on your machine. Click Install to start installation.

When installation is complete, the final setup complete screen is displayed. From this dialog, you may choose to
view the ReadMe file or launch the program.

Uninstall

To uninstall Colasoft Capsa and its components, select one of the following:

Choose Uninstall from Colasoft Capsa program group. Open the Control Panel window and double click the
Add/Remove programs icon, search the list for Colasoft Capsa and then remove it.
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Getting Started

After install Colasoft Capsa on your machine, there are a few more things to do before it can start capturing
packets. This chapter describes how to launch the program and make it available for packet capture.

Launching Colasoft Capsa
You can launch Colasoft Capsa using the following ways:

Launch from the setup wizard
Select Launch Colasoft Capsa 6.x when you finish setup to start the program immediately.

Launch from the desktop

Check the option Create a desktop icon in the setup wizard, an additional icon of Colasoft Capsa @' will be
placed on your desktop. To start the program, just double click on the icon.

Launch from the quick launch menu
Check the option Create a Quick Launch icon in the setup wizard, then you can start it from the quick launch
menu in the task bar.

Launch from the Start menu
Open the Start menu and select All Programs, then click the grogram name from Colasoft Capsa 6.x
enterprise/Professional.

Invoke from command line
Use the Capsa.exe [[commandl <file>] format to invoke Colasoft Capsa.

License information
When you run Colasoft Capsa for the first time, a dialog will pop up requiring you to enter license information.

Colasoft Capsa 6.5 Enterprise Edition Evaluation

@T’E Please input your license information.

Iset narne; | colasoft user |

Compant! ||:|:|Ia5|:|Ft |

Serial nurmber: | |

License kew: | |

(a4 [ Cancel J [ Help J

Please enter your serial number and license key correctly. Your license information will be remembered and the
dialog will not appear again unless you reinstall Colasoft Capsa.

Serial number

A serial number is used for the identification of Colasoft Capsa to avoid usage of counterfeit license keys. When
you finish payment, a delivery email with the serial number, license key and other product information enclosed
will be sent to you. For the first time you run the program or if you reinstall the program, you will be required to
enter the serial number. It must match with the corresponding license key, otherwise you could not unlock the
product.

Note: Please keep your serial number in a safe place. You will need to provide it when you activate product by
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email/fax, or register to the Colasoft Customer Service.

License key

A license key is an authorization number indicating that Colasoft grants you the right to use this program. When
you finish payment, a delivery email with serial number, license key and other product information enclosed will be
sent to you. For the first time you run the program or if you reinstall the program, you will be required to enter the
serial number.

The license key is a private number, if you lose your license key, you can retrieve it from the Colasoft Customer
Service, or contact service@colasoft.com.

Product activation

Colasoft Product Activation is an anti-piracy technology designed to verify that software products have been
legitimately licensed. This aims to reduce a form of piracy known as casual copying. Activation also helps protect
against hard drive cloning. Activation is quick, simple, and unobtrusive, and it protects your privacy.

Product Activation works by verifying that a software program's license key has not been used on more personal
computers than intended by the software's license. You must use the license key and a serial number in order to
install the software and then it is transformed into an installation ID number. You use an activation wizard to
provide the installation ID number and serial number to Colasoft either through a secure transfer over the Internet,
or by fax/email. A confirmation ID is sent back to your machine to activate your product.

If you overhaul your computer by replacing a substantial number of hardware components, it may appear to be a
different PC. You may have to reactivate Colasoft Capsa. It is allowed to reactivate the program no more than five
times per day.

Privacy statement

The Colasoft Product Activation is an anti-piracy technology designed to verify that the software products have
been legitimately licensed.

When you activate Colasoft Capsa over the Internet, you are not required to send any personal information to
Colasoft, the product activation is completely anonymous.

When you activate Colasoft Capsa by fax or email, you are required to send the serial number and installation ID
number displayed on your screen to Colasoft. The installation ID number includes an encrypted form of the
product ID and a hardware hash, or checksum. No personally identifying data is included or required. The
confirmation ID is simply an unlocking code for the Colasoft Capsa installation on that particular PC. The
information that you provide will be securely stored by Colasoft and will be protected from disclosure to any third
parties without your consent.

During the product activation process, Colasoft creates a unique hardware identification that represents the
configuration of the PC at the time of activation. The hardware identification does not include any personal
information, any information about software or the data that may reside on your PC, or any information about the
specific make or model of your PC. The hardware identification identifies only the PC and only for the sole
purpose of product activation. Colasoft Capsa can detect the minor changes to your PC configuration. You will be
required to reactivate product if you reinstall operating system or use Colasoft Capsa on another PC.

Confirmation ID

The confirmation ID is very important to activate your product successfully. You can only run Colasoft Capsa for
no more than 15 times before it is activated.

After you correctly enter the serial number and license key, a dialog will appear to require you to activate your
product. You may choose to activate product over the Internet, or by fax or email.
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olasoft Capsa - Produc vation Wizard

‘Welcome to the Colasoft Capsa Activation Wizard,

You have not yet activated your copy of Colasoft Capsa. This
product will NOT run before you activate it.

To activate the product now, select one of the following and click the
Mext button. Please contact service@colasoft.com for any question.

(®iactivate by Inkernet (recommend);

() Activate by Fax or email (please allow bwo workdays ko process your
request)

If you want to update your license information before activate the
product, please click the below button:

Activation [ Enter Mew License Information. .. ]

< Back L Mext = ] [ Cancel ] [ Help

Activate product over the Internet (recommend)
It is very quick and easy, the activation process will only take a few seconds with a couple of clicks.

Activate by fax or emalil

If you select to activate product manually, it will need more time to finish. Please click the Get Confirmation ID...
button showed on the third page of the product activation wizard. After receiving your request, an IE window will
be opened and show you the Confirmation ID created by our system. Enter the Confirmation ID as required, your
product will be activated immediately.

Please do the Following:

1. Send an email or fax ta us at:

Ernail: service@colasoft.com
Fax: +86 28 55120911

2. Include the information belaw in your emailfFasx:

Serial Number: ‘ HEHE-HUBE-HEBE-HERE -HHAH ‘

Installation ID: ‘ REHH-HHEE-BEEE-REEE- B HE-REHE - R R ‘

3. Enter the User name, Company, Confirmation ID returned bo wou;

User name: | |

Comparny: | |

Confirmation ID; | |

e

Activaction ocamamm. >

Mext = [ Cancel J [ Help ]

Or, please provide us the Serial Number and Installation ID showed on the second page of the product
activation wizard. We will send back your confirmation ID as soon as possible.

Registration to Customer Service

When you run the program for the first time a dialog will appear to remind you to register your product. You are
recommended to register your product at your earliest convenience for getting timely customer services from
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Colasoft, please check the first option to connect with the Colasoft website for an immediate registration.

After registration and log in, you can download the latest release or gain the license key for new version, review
your product, retrieve license key, change your profile and get other services from Colasoft.

You may also use the following URL:
https://secure.colasoft.com/customer/main.php?module=customer_cp&action=regqister.

NIC Test Wizard

This Wizard can be activated from the Adapter Settings or from the Start Page by click the quick link. It provides
adapter setting and adapter test options.

¢ Adapter Test Wizand

This Wizard will assist vou in setking up the systemn to analyze your
nigtwark.

Please press the "Mext" button ko continue,

< Back |l Mext = I| [ Cancel ] [ Help

Adapter Selection: you can select multiple adapters.

‘2 Adapter

Please select one or more adapker(s) For monikar:

=] Local Adapker

] 10/100 Gigabit Ethernet CardBus PC Card

BE} 1arvell Yukon S5ES056 PCI-E Gigabit Ethernet Controller
] WMware Virtual Ethernet Adapter For YMnet1

] WMware Virtual Ethernet Adapter For VMnets

------ [] Localhost LoopBack.

Fhysical Address 00:1A:40:41:09:92(802,3)
Link Speed 100.0 Mbps
Max Frame Size 1500 bytes
IP Address 192.168.0.61/255,255,255.0
Default Gateway 192.168.0.1 (00:D0:41:26: 3F: 9E)
Adapter Skatus Operational
< Back ]L Mexk = J [ Cancel l [ Help

Adapter Test: test the adapter/adapters selected in the previous page.
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Adapter Test

Test stopped.

o 056 PCI-E Gigabit Ethernet Controller
o Promiscuous capkure best is successful,

Test is successful, seleted adapter is able to capture

kraffic For the network segment it is capturing on. Stark Test

[ < Back ]L Finish J [ Cancel J [ Help J

® The green tick means the test is successful.

® The red cross means the test is failed.

® The yellow exclamation mark means the test is in process and there are already some test results. More
details can be seen if you move your Mouse to the Item.

Test duration is displayed at the bottom. There is no limit for test duration, you have to stop it manually.

When test is over, whether it is successful or not, the time display will be replaced by a description of the test
result. If you press Next before the test is over or without pressing Stop button, a prompt will pop up to notify you
"stop testing first".

User Wizard allows you to select and test adapter/adapters to check out whether the installation and the
deployment is correct.

Start capture

Colasoft Capsa stands by if it does not receive a start capture command. To start capturing packets, click the
Start Capture Now button in the Start Page, or click the icon 0 in the toolbar. The label on the icon will change
to Stop Capture O when capture is under way.

Notice: Do not summon the NIC Test Wizard from Start page if you want to test the LoopBack. It won't be listed
there unless you summon Test from Adapter Settings.

Alternatively, you can select the Start Capture or Stop Capture command from the Project menu. You can also
start and/or stop capture using command line parameters. You will be required to assign adapter before packets
are captured and analyzed, see the Packet Capture chapter to get more descriptions about how to select adapter
and how to view captured results.

Packet Capture

Colasoft Capsa can capture packets from multiple adapters, once you give it the Start Capture instruction and
designate the adapter, it starts capturing packets in a project. You can open two or more projects to focus on
different packets, each project has its own settings and parameters. This chapter introduces how to select a
capture source for a project, how to view captured packet information and how to save results for future analysis
or comparison.

Using a project for capture and analysis
A project is a scheme of capture settings and a container for captured data. You can save a project to hard disk for
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reuse at a later time. Project is an essential ingredient in Colasoft Capsa, you must create a new project or open
an existing project before you start capturing packets or performance other functions.

Colasoft Capsa captures network traffic and analyzed packets on the conditions of project settings. Without
project, you could not do anything even just view old data. Therefore the first thing you should do after launch the
program is to create/open a project. You can choose to create a blank project, select a project template or open
an existing project. Details are described in below sections.

Blank project, saved project and project template

For the first time to use Colasoft Capsa, you can simply click the Start Capture Now button to automatically apply
the predefined settings for capture. You don't need to set project settings, except you have to select the adapter
for this project. Each time when you create a new project, you may always use the blank project to save the time
for setting. If you want to change the settings during capture, you could click the Adapter, Filter or Analyzers icon
in the toolbar, or General Settings... from the Project menu to open the Project Settings dialog, and after
alteration, save the project or save it as a template.

You can open a saved project (if applicable) with its data and settings from the Start Page or by clicking the Open
icon; but when you start capture, Colasoft Capsa will clear or reset some contents in the project buffer.

Colasoft Capsa supports project templates, you can first customize the settings for a project and then save it as a
template. Project templates can be easily loaded from the Start Page.

Opening multiple projects
Colasoft Capsa allows you to open multiple projects for focusing on different packets, each project has its own
project window, capture adapter and project settings, which requires you to operate individually.

Multiple projects let you compare your network under different conditions, helping you find out network problems
more easily. For example, when you have two network segments, you can open two projects: Project 1 focuses on
segment 1 and Project 2 focuses on segment 2.

Note: It may reduce your system performance if you open multiple projects and capture packets simultaneously.

Capture sources

For the first time when you start a capture, you must designate the adapters for the project. Even if you only have
one adapter, you still need to confirm it. If you check the option Always show project settings when start
capture in the Project Settings - General page, Colasoft Capsa will remember your adapter selection and in the
future capture, will not require you to select again.

Colasoft Capsa supports capturing packets from multiple adapters simultaneously (unique to enterprise edition).
To start capture, you must select a valid adapter at a minimum. All supported adapters are listed in the Project
Setting - Adapter page, you can highlight an adapter to see its property information in the lower pane. The
adapter selected will be marked with a tick in the check box.
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Project Settings

General Adapter | *F Filer || #1 Metwork " Bl Log || 53 Diagnosis

= Eﬁ Local Adapter
|:| 104100 Gigabit Ethernet CardBus PPC Card

CI-E Gigabit Ethernet Controller
|:| VMware Wirtwal Ethernet Adapter For YMnetl
<[] ¥Mware Yirtual Ethernet Adapter for YMnets
-] Localhost LaopBack

Property Walue

Packet Driver MDIS Protacol Driver

Physical Address 00:14:40:41:09:92(302,3)

Link Speed 100.0 Mbps

Max Frame Size 1500 bykes

IP Address 192,168.0.61/255,255,255.0

Default Gatewary 192,168.0.1 {00:D0:41:26:3F:9E)

Adapter Status COperational

——
Calculate netwark utilization Bandwidth: 100 : | Mbps v | [L‘J)

[]save as default settings L QK ] [ Cancel J [ Help J

Colasoft Capsa can capture packets from the following sources:

Ethernet adapters
Colasoft Capsa works with the most of common Ethernet adapters in marketplace.

Localhost TDI loopback traffic

Colasoft Capsa can capture The TDI loopback traffic on your local host, but you must install the Colasoft TDI
Driver first: open the Tools menu and click Packet Capture Drivers..., select Colasoft TDI Driver from the Driver
combo box and push Install. After finish the installation, your localhost LoopBack adapter will be added to the
Local Adapter list in the Project Setting - Adapter page.

Packet Capture Drivers

Platform: windows xP Y¥S. 1 Build 2600

Drriver: Colasaft TDI Driver

CSTDIARIES DLL InfFormation
File narne: CSTDIARPIESU.DLL
Path:  CMWINDOMWSY Syskem32\CSTDIAPIESU. I
Wersion:  W6,03.01.202

Size: 94205 Bytes

CSTDIS0 Driver Information
File narne:  CSTDISO.SYS
Path:  COWINDOWY S Syskem 32 Driver s\ CSTDIS0,5%S
Wersion:  W5.00.01.32

Size: 24832 Byltes
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It is allowed to change adapters during the capture process; however, some data in the project buffer will be
cleared or reset if you do so.

Clear Project Data |z|

The Following items will be cleared or reset

Clear statistic walues and graph data
Reset analyzers
Clear all cormeersations data

Clear all packets in packet buffer

Clear selected log data: [ 5elect all items
Mame Count
[ HTTP Requests 14

[] Email Messages

[ masm Activities

[] A activities

[ FTP Transfers

[ 10 Activities

|:| ¥ahoo Messenger Activities
|:| DMNS Queries

wol o o O O O

L K J [ Cancel ]

Project window
The project window of Colasoft Capsa is composed of the following components:

Window title
The window title shows the product name and the active project's name.

Menu bar
The menu bar provides many useful commands in Colasoft Capsa.

Toolbar
The toolbar contains the buttons for the most commonly used menu commands, you can add or remove the
toolbar buttons.

Start Page
The start page is the first screen you can see when you begin a new capture, which offers some common project
operations.

Dock windows

At the left section of user interface by default, the dock windows include Project Explorer and Project Status.
The project explorer dock window lists all network nodes and protocol nodes, letting you quickly select a target to
view related information in tab views. The project status dock window offers the overview information of project.

Tab views

Including Summary, Diagnoses, Endpoints, Protocols, Conversations, Packets, Matrix, Logs, Graphs and
Reports view, each presenting different information of the same node selected from the project explorer dock
window.

More descriptions about these components can be found in the sections below.
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Window title Menu bar Toolbar

* Project 1 - Colasoft Capsa [Capturing] - United States

File Edit ‘Yiew Project Tools ‘Window Help
| O£ 8| &. © 2| 00| & T & 0
| Cpen Save  Back Lo Stop Beoort  Sebtings Adapter  Filber  Bebwork 1o
B3 Projec Summary rDiagnoses rEndpoints rProtocoIs rConversations ﬁ 4r
® Project 1(3) A = | e
T Protocols Explorer (2) ol | &% @ El
@ Physical Explarer (49 Skatistics | Current | 4
Bgfi IP Explorer (Z) =/ Capture
@ Local Subnets (1) — Skart Date 2006-04-11
EEHe Internet Addresses (1) Start Time 13:16:04
SRe=F Lrit=d States (4) RS Durakion o0:01:21
< LW a0 gk 0 R = = Tralfic Bytes | Utilizat... bps | |
Total Traffic 4,088 KE | 0.000% 0bps
Praject Status 3 o= Inbound Traffic 1657 KE  0.000% 0bps
Packet fiters: Accept 3 Reject 2 Qutbound Traffic 2,401 KB | 0.000%: 0bps
Internal Traffic 0B 0.000% 0 bps
Etraor packets: o =
Broadcast Traffic Sent 0B 0.000% Obps
PREIGE GHLEE 173 Multicast Traffic Sent 0B | 0.000% Obps
Packets Iost: o I=IPacket Size Distribution Biytes | Lltlizat. .. bps
Packets accepted: [N 73 ==f4 832 B 0.000% 0 bps
Packets rejected: 100 65-127 132 B 0.000% 0bps
Buffer usage: | 12 KA 128-255 155 B = 0.000% 0bps .
Ce-Cd =] O 0000, 1 ho
For Help, press F1 \\ /
Dock windows Tab views

Menu bar

This is a listing of Colasoft menus, with a brief description of each item's function. Menu items followed by
suspension points (for example, Save As...) open a dialog or window. You can make menu choices either by
navigating the menus or by using the Ctrl key combinations shown beside certain items in the menus.

Description

Command

New Ctrl+N Creates a new project.

New From Template... Opens a new project from the saved templates.

Open... Ctrl+O Opens an existing project.

Save Ctrl+S Saves the current project to a file.

Save As... Saves the current project with a new name.

Save As Template... Saves the current project as a template.

Close Closes the current project.

Print... Ctrl+P Prints the current window in a format appropriate to its type.
Print Preview Previews the print effect.

Print Setup... Configures printer functions in the Print Setup dialog.

Import Packet File...

Imports the packets saved in a packet file to the current project.

Export Packet File...

Exports the packets in the current project to packet file.

Recent File A list of recently opened packet files, with the most recently opened
listed first. You can select a file from this list to open it.
Exit Quits Colasoft Capsa.
dit Me
Cut Ctrl+X Cuts the selection and copies to the clipboard.
Copy Ctrl+C Copies the selection to the clipboard.
Paste Ctrl+V Pastes the current contents of the clipboard.
Delete Del Deletes the current selections from Colasoft Capsa.
Find... Ctrl+F Finds a specific item in the Project Explorer dock window and
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Endpoints, Protocols, Packets, Conversations and Logs views.

Find Previous Shift+F3 Backs to the previous packet if applicable.

Find Next F3 Goes to the next packet if applicable.

Select All Ctrl+A Selects all items in the current window.

View Menu

Toolbar Contains many convenient icons for menu commands.

Status Bar Displays status alerts in a bar at the bottom of the project window.

Go To Chooses a condition to jump to.

Project Explorer Hides or shows the Project Explorer dock window.

Project Status Hides or shows the Project Status dock window.

Show Adapter Vendor Hides or shows the adapter vendor where displays the Mac
address.

Show Host Name Shows the alias for hosts.

Show Port Name Shows the alias for ports.

Refresh F5 Refreshes the contents of the current view.

__PoectMervc ..

Start Capture Fo Starts capturing packets. When capture is under way, the item is
displayed as inactive.

Stop Capture Stops capturing packets. The item is displayed as active when
capture is under way.

Clear Packet Buffer... Discards all the packets in the packets buffer.

Clear Project Data... Opens the Clear Project Data dialog and the selected items will be
cleared.

General Settings... Opens the Project Settings - General dialog.

Choose Adapter... Opens the Project Settings - Adapter dialog.

Packet Filter... Opens the Project Settings - Filter dialog.

Network Profile... Opens the Project Settings - Network dialog.

Log Setting... Opens the Project Settings - Log dialog.

Diagnosis Setting... Opens the Project Settings - Diagnosis dialog.

Name Table Opens the Name Table window.

Filter Table Opens the Filter Table window.

Packet Capture Drivers... Opens the Packet Capture Drivers dialog where you can install
additional drivers for packet capture.

Colasoft Ping Tool Opens the Colasoft Ping Tool dialog to ping one or more IP
addresses and domain names.

Colasoft Packet Player Opens the Colasoft Packet Player dialog to replay packet files.

Colasoft Mac Address Opens the Colasoft Mac Address Scanner dialog to scan the IP

Scanner address and Mac address in subnet.

External Tools Opens the Custom Tools dialog to invoke other applications or
tools.

Oitions... Opens the Options dialog.

New Window Opens an additional window for viewing the information of the
current project.

Close Closes the current project window.

Next Switches to the next window in sequence the current window.

Previous Switches to the previous window in sequence the current window.

At the bottom of the Window menu is a numbered list of open windows, with a checkmark beside the name of the
current or front-most window. Selecting a window from this list makes it the current window and brings it to the

front of the disilai.

Contents Launches the contents page of the Help documentation.
Search... Launches the help search
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Index Launches the help index.

Technical Support Loads the technical support page of the Help documentation.

Activate Product... Launches the product activation wizard.

Check for Latest Version Opens the Colasoft website to check for the latest version
available.

Colasoft on the Web Opens the Colasoft website, where you can check for the latest

version, register product, send feedback, visit the Colasoft home
page or the protocol website.

About Colasoft Capsa... Opens the About Colasoft Capsa window where you can find the
version, copyright and license information of the product.

Toolbar

The toolbar provides the button navigation for frequently-used tasks in Colasoft Capsa. By default, each button
appears with an icon and a name presenting its function; to hide the text, open the View menu and move the
cursor over Toolbar, then uncheck Icon Text.

O 2/ 0. .4 © 0 @m = ¥ 4 B @ &

Mews Open Save | Back  Forward Up Sbart Stop | Settings  Adapter  Filker Metwork Log  Diagneis  Filker Table

You can add more buttons to the toolbar. Choose Customize... from the View - Toolbar menu to open the
Customize dialog. Alternately, you can right click on the toolbar and choose Customize.... The Customize dialog
lets you manage add-in items that appear in the toolbar. To remove buttons from the toolbar, click the Toolbar
Options at the right of the toolbar, then move the cursor over the Add or Remove Buttons and the Standard
command, then uncheck the buttons you would not like to appear in the toolbar.

To hide the toolbar, right click on the toolbar and uncheck Standard.

Context menus

Many features of Colasoft Capsa can be launched from the context menus. With a right click on the display, you
can open the context menu bar which contents vary with the current view or current selection. The context menus
are described with corresponding display in the Dock windows and Tab views section below.

Start Page

Each time when you open a new project, you can see a start page which offers some quick links of the most
common project operations:
‘2 Project 1 - Colasoft Capsa

File Edit Y¥iew Project  Tools  ‘Window Help

0 2EHOC. ©.4|00| 0 = % & 8B @

MNew Open Save | Back  Forward Up Skart  “fop | Settings Adapter Filker Metwork Log  Diagnosis

Start Page l 4k

Colasoft Capsa 6.9 Enterprise Edition

=¥ Start Capture

Start capturing network traffic

[ Start Capture Mow ]

= Open File

Open recent files.

fooed.cap CDocuments and SettingstAdministratorDe. .

- Load Template

Load template settings.

Mo recent templates.

=¥ Quick Link

[ How can | implement the Capsa deployment to fetch the key informatio...

[ Atter the implementation, is the deployment correct? Test it
[ How can | get useful information from Colasoft Capsa®

Far Help, press F1 B |
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Start Capture
You can immediately start capturing packets by clicking the Start Capture Now button, Colasoft Capsa will
automatically apply the predefined settings of the blank project.

Open File
You can open a recently saved project file from the list; some contents in this project buffer will be cleared or reset
when you start capturing new packets.

Load Template
Colasoft Capsa supports project templates, you may save a project as template. When you open a template,
Colasoft Capsa will load its settings for capture.

Dock windows

Colasoft Capsa has two flexible dock windows: Project Explorer and Project Status, you can hide them or
change their position very easily. To hide a dock window, just click the & icon at the top of the dock window, it will
dwindle into a button on the left of project window (by default) and will not show its contained information unless
you place your mouse cursor on it. To recover the display, keep your mouse on the button and when the dock
window appears, click the & icon again.

A dock window can also be closed if you click the X icon, you can open it again by clicking its name in the View
menu or the icon from the toolbar.

To change the position of a dock window, you may push your mouse cursor on it and keep the left button down
when dragging it. It will go back to the previous position if you double click on the name pane.

The following is the common commands contained in the context menu of dock windows, which can be opened
with a right click in anywhere of a dock window.

Command Description Applicability ‘
Copies the selection as a text file and : .

Copy (Ctrl+C) puts it on the clipboard. Project Explorer dock window

Copy Tree Copies the data tree as a text file and Project Explorer dock window

puts it on the clipboard.
Unshows the Project Explorer dock

Hide Project Explorer

window.

Project Explorer dock window

Add to Name Table...

Adds or edits an alias.

Project Explorer dock window

Resolve Host Name

Resolves the name of the selected host.

Project Explorer dock window

Expand All Subnodes

Shows all subnodes.

Project Explorer dock window

Collapse All Subnodes

Unshows all subnodes.

Project Explorer dock window

Find Finds an item in the Project Explorer. Project Explorer dock window
Find Next Finds next item in the Project Explorer. | Project Explorer dock window
Refresh Refreshes the current view. Project Explorer dock window
Show Value Shows data in value. Project Status dock window

Show Percentage

Shows data in percentage.

Project Status dock window

Project explorer

The Project Explorer dock window is on the left section of project window by default, which allows you to view the
current status of each node and quickly switch among global statistics and the details of specific network nodes;
you can not see it if no project is created or opened. There are three groups in the project explorer: Protocol
Explorer, Physical Explorer and IP Explorer.
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Project name (three groups contained)

3 Project 1 (3)

EIT Protocal Explorer (2) —-—————
= Ethernet 11 {2)

=T Y

B-H UDR (3)

- TCP (3)

=) sy Physical Explorer (4]
"= Local Segment {14)

%4 Gateways (17 T Physical

@" Broadcast Addresses (1)

@ﬂ' Multicast Addresses (4)

Bg‘!‘g IF Explorer (3) -——m

E\@—. Local Subnets (1)

b= 192.168.0.0/24 (13)

B-Fh=  Local Host (1)

[+~ '5*= Broadcast (1)

e 192.168.0.10

----- 192.168.0.27 -——— Corresponding IP address

----- 192, 165.0.29

----- 192,168,062
----- 192.168.0.64 Status of node

----- 192,168.0.65 (packets is transmitting
..... thd the mde)
¢ - T5z2.165.0.89

----- 192,165.0,205

92,165,0,206
..... o o 19216500 Status of node
[ Multicast Addresses (2) (transmission was complete)
FH-®5= Internet Addresses (2)
Name Description \
Protocol Explorer This group lists network endpoints by protocol.

This group lists network endpoints by physical address. There are four sub-groups:
Local Segment, Gateways, Broadcast Addresses and Multicast Addresses.
This group lists network endpoints by IP address. There are four sub-groups: Local
IP Explorer Subnets, Private-Use Networks, Broadcast Addresses, Multicast Addresses and
Internet Addresses.

Physical Explorer

In the Physical Explorer and IP Explorer group, the arrows on the right of the each node’s icon indicate the
current status of the node. The node's icon and the arrows will green when the node transmitting packets and
become to grey when transmission complete. The upper arrow indicates packets transmitted in, the below one
indicates packets transmitted out from the node.

The number in bracket indicates the amount of the sub-nodes. Colasoft Capsa can list up to 1000 sub-nodes. If a
node has more than 1000 sub-nodes, e.g. 2000, then the node will be showed as xxx (2000) when collapsed and
xXx (1000/2000) when expanded.

Furthermore, the captured addresses will be grouped under countries in the Internet Addresses of IP Explorer
group if you check the Group IP address by its country in the General page of Project Settings dialog.
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er

Explorer (73
b= "This" Mebwarks (92)
Public-Ciata Mebworks (743
Loopback {96)
Metwork Interconnect {13
Private-Use Metworks (2)
Multicast Addresses (85

R T T T

[T TR TR TR AR TR R °

Canada (395)
Japan (§58)
Korea, Republic of (254)
Austria (550

South Africa (57)

Ttake (2170

China (459)

Spain {144}

Finland (513

The Project Explorer dock window and the tab views on the right section of project window are consistent in
displaying data. When you select a node in this dock window, the data displayed in tab views changes
accordingly.

The figure below is the right-click context menu of this dock window. In addition to the common context commands,
there is special command in this context menu - Ping. The Ping command used to invoke the build-in ping tool to
ping the IP address of the selected node in the Physical Explorer and IP Explorer group.

@ Copy Chrl+C
Copy Tree

Hide Project Explorer

@ Add ko Mame Table, ..

Resalve Host Mame

Ping 3
S~ Find... CtrHF
Find Mesxt F3
@ Refresh F5 1

The name of listed hosts can be resolved manually with the Resolve Host Name command from the context
menu with a right click on the display. It is also allowed to make alias and change text color from this dock window.

Project status

The Project Status dock window presents some general information of the current project.
Item \ Description

Enabled filters Shows the number of accepted filter and rejected filter.

Packets captured Shows the total number of captured packets since the capture started.

Packets lost Shows the number or percentage of lost packets.

Packets accepted Shows the number or percentage of packets matching the filters accepted for analysis, the
progress bar displaying the proportion of the packets accepted in the total packets
captured.

Packets rejected Shows the number or percentage of packets matching the filters excluded for analysis, the
progress bar displaying the proportion of the packets rejected in the total packets
captured.

Buffer usage Shows the buffer memory used so far in packet capture as a number or percentage, and
graphically by a progress bar which fills more of the width of the display as memory is
used: when 80% of the capture buffer is used, the color of the bar changes from blue to
yellow, eventually showing red as memory use approaches 100%.
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3 x
Packet fitters: Accept 3 Reject 0
Error packets: ]
Packetz captured: 31,783
Packets lost: 0
Packetz accepted: | [|NEIELEER
Packet= rejected: 0%
Bufter uzage; | 7O

The items Packets dropped, Packets accepted, Packets rejected and Buffer usage can be displayed either as
value (by default) or percentage, you can select from the context menu with a right click. In addition, with double
clicks on the Enabled filters, Packets accepted and Packets rejected item, Colasoft Capsa will open the
Project Settings - Filter page, or Project Settings - General page for the Buffer usage item, in which you can
modify the settings of filter or buffer usage. The Project Status window can be hidden and its position is alterable

Tab views

Tab View Description

Summary Presents the summary statistics of global network or specific network nodes.

Diagnoses Presents the diagnosis events of global network or specific network nodes.

Endpoints Categorizes and displays network traffic by hierarchical endpoints, physical
endpoints, or IP_endpoints.

Protocols Categorizes and displays network traffic by protocol.

Conversations Shows the Physical, IP, TCP and UDP conversations between pairs of endpoints,
the reconstruction of TCP streams is available.

Matrix Shows the network traffic between two nodes in real time. The nodes were arranged
in an elongated ellipse and lines between communicating nodes indicate the traffic.

Packets Shows a list of captured packets in the order they were received and offers the
detailed information of packet decode.

Logs Records the network communications of email messages, HTTP requests, FTP
transfers, DNS analysis, MSN activities, AIM activities, ICQ activities and Yahoo
Messenger activities. Primarily from any enabled advanced analyzers.

Graphs Presents a variety of graphs displaying network statistics in real time, based on the
node you select from the Project Explorer dock window and consistent with the
Summary view. You can use the Compare Mode to view two different graphs
simultaneously.

Reports Displays the real time statistics of summary statistics, diagnosis events and top 10
addresses, and all available graphs.

Colasoft Capsa has seven tab views, each focusing on different network information. The table below offers the

main usage of these views.

Each tab view (except the Graphs view, Matrix view and Reports view) has its own column/sub-column options,
you can right click on the column heading bar and select more columns to display. In the Endpoints view,
Protocols view and Conversations view, with a click or double clicks on a column heading, you can sort the data
in this column by ascending or descending, which helps you easily find the source of top traffic.
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Sort endpoints by Total Bytes

Summary rDiagnnsgs/V Endpoints rPrDtncﬁIs rCDnversatinns rl"-“latrix rF‘ackEts rLDgs rGraphs rFlepcurts ]

E_j Type All - IE‘ j‘_}_ ﬁ @ @
Mame | Tokal B';.:tes"-T Bykes Cuk | Bytes In | Tokal Packets | Packets In | Tokal Bykessi
= *4 Local Segment 3.086MB 22,623 MB 58,357 24,095 99,918%
=™ Local Host | 27.308 M) 2,787 MB 24,521 MB 53,428 29,693 97.204%
= ERasiarock:iFiaes EEELE 2787 MB | 24.521 MB 53,425 29,693 97.204%
“ W Eva | 27.302 ME] 2.783MB | 24.518 MB 53,325 29,651 97.182%
= Ereakek Semitad:78:CE 2,335 MB 1.920MB | 425.723KB 10,722 4,915 8.313%
- i officel | 2,299 MEB 1,554 ME | 425,723 KB 10,366 4,915 5.185%
i 1e2188.0.2 | 29,445 KB 29,445 KB 0B 233 i 0.102%
= EP0-Link:65: 75:49 | 555,794 KB 547.021KB | 11.773KB 3,289 108 1.942%
- - W officez | 208074 KB |  Z00.953KEB | 7.121KE 1,643 66 0.723%

You can switch among various views to see different packet information of a specific node by first selecting the
node from the Project Explorer dock window. If you find a suspicious item in a tab view, the Locate Explorer
Node command in the context menu (except the Summary view, Graphs view and Reports view) is able to let
you find and highlight its location in the Project Explorer dock window by IP address, physical address or
protocol, and at the same time, other tab views accordingly display the relevant information of this node.

The columns showed in tab views can be customized; you may show/hide specific columns or change the position

of a column.
Command Description Applicability
Copy (CHrl+C) Copies the selection as a text file and puts it AII tab views exgept Graphs view, Matrix
on the clipboard. view, Reports view.
Copies the selected column as text and Endpoints view, Protocols view, Packets
Copy Column

puts it on the clipboard.

view, Conversations view, Logs view.

Custom Columns

Shows/hides columns or changes the
position of columns.

Endpoints view, Protocols view, Packets
view, Conversations view, Logs view.

Locate Explorer Node

Locates the current node in the Project
Explorer.

Endpoints view, Protocols view, Packets
view, Conversations view, Matrix view, Logs
view.

Make Filter...

Opens the Packet Filter dialog and makes
a new filter on the basis of the selection.

Endpoints view, Protocols view, Packets
view, Conversations view, Matrix view, Logs
View.

Add to Name Table

Adds or edits an alias.

Endpoints view, Packets view, Conversations
view, Matrix view, Logs view.

Select All

Selects all items.

All tab views except Graph view, Matrix
view, Reports view.

Refresh

Refreshes the current view.

All tab views except Graph view.

The following is the common commands contained in the context menu of tab views, which can be opened with a
right click in anywhere of a tab view. The particular context commands of each view are described in the sections

below.

Summary view

Associated with your selection in the Project Explorer, the Summary view provides general statistic information
of the selected node. When you select the project root node, you can get the statistics of your global network; if
you select a specific network node, the view will present the particular information of this node.

Capture

Offers the information of start date, start time and duration of this capture.

General Errors

Offers the statistics of general errors, including total errors, CRC errors,
alignment errors, overrun errors and underrun errors.

Physical Errors

Offers the statistics of physical errors.
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802.3 Errors Offers the statistics of 802.3 errors.

Traffic Offers the information of total traffic, broadcast traffic and multicast traffic.

Packet Size Distribution Offers the statistics of packets based on size class.

Most Common Packet Sizes Offers the packet statistics of the most common sizes.

TCP Packets Offers the statistic information of TCP packets analyzed by the TCP
analyzer.

TCP Connections Offers the statistic information of TCP connections analyzed by the TCP
analyzer.

DNS Analysis g:fael;i (tarrle statistic information of DNS connections analyzed by the DNS

Offers the statistic information of SMTP connections and messages

SRS analyzed by the advanced Email analyzer.

POP3 Analysis Offers the statistic information of POP3 connections and messages
analyzed by the advanced Email analyzer.

FTP Analysis Offers the statistic information of FTP transfers analyzed by the advanced
FTP analyzer.

HTTP Analysis Offers the statistic information of HTTP requests analyzed by the advanced
HTTP analyzer.

All Instant MessengeActivities Offers the statistic information of all instant messenger activities.

MSN Activities Offers the statistic information of MSN activities.

AIM Activities Offers the statistic information of AIM activities.

ICQ Activities Offers the statistic information of ICQ activities.

Yahoo Messenger Activities Offers the statistic information of Yahoo Messenger activities.

By default, only some sub-columns are displayed. To view more statistic information in different columns, right
click in the display and put the mouse pointer on Choose Current Sub-columns and then check columns from the

context menu. Alternately, you can use the icon % to check more sub-columns.

The following table shows the information titles presented in the Summary view (when the project root node is
selected).

Click on the + (plus) or - (minus) signs at the left margin to expand or collapse individual items of the display.

In addition to the common context commands as other tab views, this view also has the following special

commands:
Save Summary Statistics... Saves the summary statistics to a file.
Snapshots Takes a snapshot for summary statistics; shows, hides or deletes a
snapshot.
Choose Current Sub-columns Chooses the columns to show corresponding statistics.
Choose Snapshot Sub-columns Chooses the columns to take snapshot.
Display Sub-column Title Displays the title of the sub-columns.
Display Grid Lines Displays the grid lines for the view.
Expand All Expands all items and displays the sub-columns.
Collapse All Collapses all items and hides the sub-columns.

You can take snapshots for the summary statistics at any time, which will be very helpful if you want to compare
your network state in the future. To get snapshots, click the icon i@ or right click on the view to open the context
menu, select the Snapshots command and Take Snapshot from the sub-context menu. Repeat the operations to
take multiple snapshots. There is no limit to the snapshots taken, but you can only see up to 16 snapshots on the
display.
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U Copy

E_j Save Summary Statiskics. ..

| Snapshots ] m@ Take Snapshat

Choose Current Sub-columns 2

Choose Snapshot Sub-columns— »
Show Sub-column Title
Shows Grid Lines

Expand All

Collapse Al
Select Al
@ Refresh

Diagnoses view

The Diagnoses view presents the diagnosis events of global network or selected network node. You can find a
diagnosis statistics according to network layers from the upper view, whereas the corresponding events are listed
in the lower subview, each event is assigned a severity level. By double clicking on an event, Colasoft Capsa will
open an Event Relative Packets window showing the related packet information to this event. To get a detailed
description and remedy suggestion, push the References tab in the lower subview (if applicable).

-
The diagnosis settings can be customized in the Project Settings - Diagnosis page by clicking the "@ button
from the toolbar.

Save As Display options Refresh
Vi
éSummary Di:glw'oints rProtocols TCDn\-'ersations rMatrix rPackets Logs | Graphs rReports l 4Pk
Mame Count
All Diagnosis Events 4, 075
Application Layer 132
=l Transport Layer 2,366
iy TCP Connection Refused 28
&y TCP Fast Retransmissions 1
iy TCP Part Scan z
iy TCP Repeated Connect Attempt 2,084
i TCP Reset Connection 245
i TCP Retransmissions 4
= Network Layer 17,200
iy ICMP Port Unreachable 4
i 1P Low Time-To-Live 17,196
-~ Ewvents
& \? - %2 [ ] ] ] ] | all Diagnosis Events: | 8,078 |
Seve, '\_ | Layer | Event | Deestination | Packet | o]
o Application ... | HTTP Server Slow Response Time (321 ms From Packet 4...  202.106.18... 46196 =
o Metwark La,.. | IP Low Time-To-Live {See Packet 46200) 227.1.2.7 46200
iy Transport L... | TCP Repeated Connect Attempt {See Packet 44744) 192,168.7.77 46201
o Metwork La,.. | IP Low Time-To-Live {See Packet 46204) 227.1.2.7 46204

Show evenis of the selected item

The Diagnoses view labels events with the following severity level icons:

Severity Level Icon Description

Information ¥ Indicates a normal message, no corrective action is required.

Notice i Indicates normal but significant conditions, may require special handling.

Warning o Indicates an error condition that requires attention and should be addressed soon.

Critical O Requires immediate intervention by administrators to prevent serious problem to the
network.
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Click on the + (plus) or - (minus) signs at the left margin to expand or collapse individual items of the display.

In addition to the common context commands as other tab views, this view also has the following special

commands:
Command Description
Upper View
Save Diagnosis Statistics... Saves the diagnosis statistics to a file.
Show Grin Lines Displays the grid lines for the view.
Expand All Expands all sub-items.
Collapse All Collapses all sub-items.
hvie a
Show Relative Packet in New Opens a new window to show relative packets information;
Window alternately, you can double click on the event.
Show Diagnosis Level Shows/unshows the events of selected diagnosis level.
Export Diagnosis Events... Exports the selected events to a file.

Endpoints view

The Endpoints view presents the detailed communications of each endpoint in network. You may use the combo
box to select a display type.

All
Displays all hierarchical address range, including physical addresses and IP addresses.

Physical
Displays endpoints by physical address.

P
Displays endpoints by IP address.

Click on the + (plus) or - (minus) signs at the left margin to expand or collapse individual items of the display.
The percentage columns present the percentage of total traffic, outbound traffic, inbound traffic and internal traffic.

The bottom sub-views offer the packet and connection details of the active endpoint, which can also be viewed in
a new window when you double click on the endpoint.

When the Show Details button pressed down, you can see the packets related to the current endpoint
shown in the lower sub-view. You may also double click on a row to open an Endpoint Details window.

Display types Make Fifter
Add to Mame Table
Save As Tree Layout
/ \Shgw Details / Locate Explorer Node
il
jﬂmmary r[)jagnosesf Endpaints rP'?ptocoI rCoﬁersaypn{rMatrix rF‘ackets Logs | Graphs rReports I 4k
Ld -~
E—{ Type &l r . TEEB-B- Refresh Endpoints: | 24
Mame | Total Bytes', | Bytes Qut | Total Packets | Total Bytes%s | Total Packets®h | #
= (2% Lacal Seqmert 2 i 12.262 KB 295 98.760% 99.662%
. - #Local Host I =4 kB 10,495 KB 208 54.,895% 70.270% |
- EPasiarock:1F: 1405 RN 054 KE 10,495 KB 208 54,895% 70.270% | |
" i Rachel | 1 10,373 KB 205 54, 207% 69,257 %
: Herax;00:00:00 | 64 B 0B 1 0.229% 0,336%
' localhost 64 B 0B 1 0.229% 0.336%
= E3lvrare 40:50: 7D 525 B | 526 B | 2] 1.893% | 0.676% |
i office.colasaft. com 528 B 526 B 2 1.893% 0.676%

In addition to the common context commands as other tab views, this view also has the following special
commands:
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0 and De ptio
Save Endpoint Statistics... Saves the selected endpoint and its statistics to a file.
Expand All Sub nodes Expands the hierarchical list of endpoints.
Collapse All Sub nodes Collapses the hierarchical list of endpoints.

Protocols view

The Protocols view displays the information of protocols used by network communications. The bottom
sub-views offer the packet and connection details of the active protocol, which can also be viewed in a new
window when you double click on the protocol.

You may use the combo box to select a display type.

All
Displays all hierarchical protocols.

Physical
Displays protocols based on Ethernet Il. For example, ARP, IP, IPv6, IPX, and so on.

IP
Displays protocols based on IP protocol. For example, HTTP, MSN, DNS, NetBIOS, and so on.
Notes: The TCP - Other and UDP - Other are the protocols Colasoft Capsa did not support yet now.

Display types Make Filter
Save As Show Details Locate Explorer Node
/ I yd
/{Summary rwagnoses rEndpoi*;/YPﬁatocy/r(:c:nversations rMatrix rPackets m@'aphs rReports ] 1k
! '

! Type Hierarchical - ? Ex| El' @ - — Refresh Protocols: | 25
Name | Bytes' | Packets | bps | Connections |

= Ethernet 11 ] 56,815 | 1.217 Mbps 2,370

2T 56,603 | 1.217 Mbps 2,370

= UDP 39,723 | 1.129 Mbps 0

- W Other EZEEE B 35,430 | 1.118 Mbps 0

- WDNS 383.765 KB 3,877 | 9.224Kbps 0

-5 NetBIos | 31,406 KB 297 | 2304 Kbps | 0

TName Service 26,365 KB 275 2,304 Kbps 0

L T Datagram 5., | 5,041 KB zz 0 bps i}

- WRTCP | 30,060 KB 87 0 bps 0

| 10,051 KB 30 0 bps 0

| 10,051 KB 30 0 bps 0

§ B EHTTP Proxy | 125 B 2 0 bps 0

& F 1P [ ] 3,067 MB 16,966 | 85,152 Kbps 2,370

L TEHTTR [ ] 2.142 MB 5,636 | 39.576 Kbps 172

o T Other | 322.208 KB 3,981 | 18.720Kbps 673

i W CIFS | 245,570 KB 3,256 | 15.312 Kbps 856

@B NetBIOs | 159,510 KB 2,475 | 12.672 Kbps 535

Click on the + (plus) or - (minus) signs at the left margin to expand or collapse individual items of the display.

When the Show Details button pressed down, you can see the packets related to the current protocol shown
in the lower sub-view. You may also double click on a row to open an Protocol Details window.

In addition to the common context commands as other tab views, this view also has the following special

commands:
0 and De ptlo
Save Protocol Statistics... | Saves the selected protocol and its statistics to a file.
Expand All Sub nodes Expands the hierarchical list of protocols.
Collapse All Sub nodes Collapses the hierarchical list of protocols.

Conversations view

The Conversations view dynamically presents the real-time status of Physical, IP, TCP and UDP conversations
between pairs of endpoints, the sub-views offer the related packets and reconstructed stream the active
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conversation. This view will replaced by Connections if open a project file or packet file of version 5.5 or before.
Sub-view Description ‘

Shows the related packets to the current connection. A connection will be kept in
Packets the Conversations view for two minutes after it is closed; when it is cleared from
the connection list, you can still find its related packets in the Packets view.
Unique to TCP connections list. Offers the reconstructed TCP stream of the
selected item.

Unique to UDP conversations list. Offers the reconstructed UDP data of the
selected item.

Stream

Data

Conversation list

The conversation list reveals what TCP and UDP conversations your network is making, captured conversations
are circularly stored to keep the display real time and dynamic. Colasoft Capsa will clear those conversations
having been closed for more than two minutes when the list reaches 1000 conversations. The conversation
related packets can be seen in the Packets view, HTTP conversations, Email conversations, FTP conversations
and DNS conversations can be seen in the Logs view, when a conversation is cleared from the conversation list,
you may find the corresponding information from these views.

Command Description

View Details in New Window Opens a new window to show the conversation details; alternately, you
can double click on the conversation.

Show Conversations Defines a condition and shows matching conversations.

Export Conversations... Exports the conversations to a file.

Send Packet Send captured packets from defined NICs.

You can view the conversation details by switching the sub-tabs at the lower section of the display, or in the new
opened Conversation Details window with double clicks on the selected conversation. When the Conversation
Details window is opened, the data displayed in it will be kept even after the connection is cleared from the
connection list.

In addition to the common context commands as other tab views, this view also has the following specific
commands:
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TCP stream
From this view, you can see the reconstructed data streams of the selected conversation. The data streams of
different directions can be distinguished by color, e.g. blue is for endpoint 1 to endpoint 2, green is for endpoint 2
to endpoint 1.

Save As  Refresh Select a stream direction

\ / /
GenW@‘Stream rca"ﬁ. Packe;!r@ Logs ]
hJ
£-al @
[j Both directions = 192.165.0.658, TCP port = 1763
= 54,233.189.104, TCPF port = 30

5> Endpointl to Endpointz

42 EndpointZ to Endpoint1 woelient £ie=UTF-8
Lt ls=GGLD, GGLD: 2004-09, GELD ensg=5z2under+updates 22
HTTP/1.1

hooept: image,/gif, images/H-xbitwap, imwagejped,
image/pipeg, application/x-shockwave-£flash,
application/vnd.ms-excel, application/vnd.ms-powerpoint,
application/mswvord, /%

Aocept-Language: ch-os

Referer: http://toolbar.google.com/ comoand, returneth—
hl=en&th—ver=2.0.114.9-big

Aoepept-Encoding: geip, deflatc

User-kgent: Mozilla/s4.0 (compaftible; MSIE 6.0; Windows NT
5.1; 3V1: Alexa Toolbar; .NET R 1.1.4322)

Host: www,.google.com \

Data streams
By default, the data streams are showed as ASCII. You can change the display to EBCDIC with a right click in the
view and select the Show as EBCDIC command from the context menu.
To save the TCP streams to a text file, press the Save As icon from the toolbar or select the command from the
context menu.

The preview size of TCP streams can be customized by opening the Options dialog from the Tools menu. When a
TCP stream goes beyond the size defined, only the contents within the size are shown. To view the whole
contents, you must redefine the preview size to a larger value.

General "i{g Format | % Decoder || L Analyzer

Always show maximumed window when start program,
Show warning dialog For invalid settings when start capture,
Disable windows suspend when capturing.

Disable smooth scrolling,

Disable list sorting if item count reaches: (2000 5
keep recent open file count: -

4
k. 4]
TCP stream preview size: 64 > |Kilobytes

Enable passive name resolution
Save Resolved Mame For IP address when capsa exit,

h

B
i

Remove unused names after days

I

ok J[ Cancel ][ Help ]
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Matrix view

The Matrix view shows the network traffic statistics. The line weight indicate the volume of traffic between nodes
arranged in an extensive ellipse indicate the traffic. You can quickly switch among global statistics and the details
of specific network nodes by switch the corresponding nodes in the Project Explorer. There will no data
displayed in this view if open a project file or packet file of version 5.5 or before.

& samplePacket - Colasoft Capsa [Stopped] [E=8[EcR |53
Hle Edit View Project Tools Window Help
0O 2 & o ® ¥ & 8 @ = a4 8
New Open Save : Start Settings Adapter Filter Network Log Diagnosis Name Table Filter Table Options Tools -
] Explorer el | Summaqr | Diagnosis | Endpoints | Protocols | Conversations™ Matri EQEEEES LlEQE l,ﬁ,r,a [IReportsi]} q i
& samplepacket (3) Iz - - @ E lj o Nodes: | 195/979
-4 Protocol Explorer (3) — u-"- i =
w-T Ethsmst () =l @ physical
B - Ethernat 802.2 (1 @ P I
& Ethernet SNAP (1) i h 7
-4 Physical Explorer (3) Trotfic Ty #
-~ Local Segment (300) Unicast
- - Broadcast Addresses (1 Multicast
e ST Broadcast =
=] Project Status 7 x | | Display Options %
Packet filers: No fiters enabled | | () show All Nodes E
Error packets: 0 Q Top 100 Nodes 1
Packets captured: 873 || & Top 100
Packets lost 0 Conversations

Packets accepled: ® Top 20% of Nodes
Packets rejected: L | i
Buffer usage: 3KB || | User Hidden Nodes(0)

'Y Online Resources Q

- Getting Start =i [

Invisible Nodes(784)
192.168.0.255(2)
T | [192.168.227.1(1)

4wl

For Help, press F1

The table below describes each of the parameters used to set up or save a statistic matrix.

Paramete De ptio

Matrix group The matrixes are grouped by matrix type, traffic type and display options.
Matrix title The title of the matrix.

Font size Select the display font size

Matrix option Select the display style of the nodes, lines and background.

User Hidden Nodes Show the hidden nodes if you hide them manually.

Invisible Nodes Show the hidden nodes if you choose a rule from the Display Options.

Packets view

The Packets view presents a list of captured packets and the packet decode information in Hex, ASCII and
EBCDIC. The following sections describes how to view a packet and its decode information, how to find related
packets, and how to change the layout of this view.

Button Description

Export Exports selected packets to a file in public formats such as Text and HTML.
Previous Backs to the previous packet if applicable.

Next Goes to the next packet if applicable.

Show Packet Show the packet list if check on this button.

List

Show Decode Show the packet decode window if check on this button.

Show Hex Show the Hex decode window if check on this button.

Layouts Select a layout of these three windows from the three predefined layouts. By
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default, the packet decode information are showed at the bottom of the Packets

view.

Make Filter Opens the Packet Filter dialog and makes a new filter on the basis of the selection,

The packet list will display the newest packet always if check this button. But when

Auto Scroll you select an item in the view, this button will stop execution until you check it
again.
Refresh Refreshes the current view.
Packet list
Summary rDiagnoses rEndpoints rProtocols rCDnversationsIMatri}/wPackets Logs | Graphs rReports I 4
H oo || - F-EE-Gs = - | Packets: | 28,641/56,815
Mo, | Date | Absolute Time | Source / | Destination | Protocal | Size | Source Port
13135 2005-05-31 | 11:03:36,938344 192.168.0.1?6[;?‘3 192.168.0.... MEDGM 260 138
13136  2005-05-31  11:03:36.938916  00:0D:60:75:260C4 | FR:FF:FF:F...  Ethernet 802.2 252
13137  2005-05-31  11:03:35.947767 | 00:00:60:78:26:C4 | FR:FF:FF:F...  Ethernet 802.2 102
13138  2005-05-31 | 11:03:37.392571  Office;445 Peter:1027 CIFS B4 445
13139 2005-05-31  11:03:37.392992 | Peter:1027 Office: 445 CIFS B4 1027
13140 | 2005-05-31 | 11:03:37.789068  00:0D:E0:76:26:C4 | FR:FF:FF:F,.. | Ethernet 802.2 | 102]
13141  2005-05-31  11:03:37.812965  Peter:1033 OfficesS001  Unknown TCP Prokocol 76 1033
=W Packet Info: fadillccoofllzF Fr FF FF FF PRGN
% Packet MNumber: 013140 ooog &0 78 ZB C4 00 54 EO EO
1‘5'_F| Actual Lendgth: 10& = o010 0z FF FF 00 &0 00O 14 00
~@P Avaisble Length: ag . || oo1g |00 00 OO0 FF FF FF FF FF
..... [ Tinesang: 2005-05-31 00z0 | FF 04 55 00 OO0 00 00 00
% 302.2 Header [os14] 0028 | 0D 60 72 ZBE C4 04 EE OO
: Eﬁi . [ 0020 | 00 00 00 00 00 00 00 a0
Destination Address: FF.FF.FF_F: oo3s 00 00 00 OO0 0o DND oo
[
I
Packet decode Hex/ASCIVEBCDIC view

The figure below is toolbar of Packets view.

Surnmary rDiagnoses rEndpoints rProtocols rCUnversations rMatri}/VPal:kets Logs | Graphs rReports

Export — (| O © - ¥ - B %3 = (2] —— Refresh
/ [ -~
Preiious” " Next Aulo Scroll  Send Packet
Show Packet List Make Filter
Show Decode Layouts Locate Explorer Node
Show Hex
Packet list

Matching to the setting of Packet buffer size and When buffer is full in the Project Settings - General page, the
packet list view offers the list of packets captured from the node selected in the Project Explorer.

By default, the packet decode information are showed at the bottom of the Packets view. Click the layout icons to
change the display. A packet decode window can be opened when you double click on a packet.

In addition to the common context commands as other tab views, this view also has the following special
commands:

Command Description
Opens a new window to show packet decode information; alternately,

DSl e G T b e you can double click on the packet.

Highlight Packet Highlights the current packet.

Adds, edits or deletes a comment for the current packet; the packet with

FEE SR a comment is marked with _d.

Shows the packet summary.

SN Automatic - show the uppermost protocol summary
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IP Summary - show the packet summary of IP protocols; if no IP
protocols, show the uppermost protocol summary

TCP/UDP Summary - show the packet summary of TCP/UDP protocols;
if no TCP/UDP protocols, show the uppermost protocol summary
Exports selected packets to a file.

Sends captured packets from defined NICs.

Sets the current packet as the relative packet.

Selects and highlights the related packets by source, destination, source
and destination, protocol or port.

Only shows the unselected packets.

Only shows the selected packets.

Shows all packets.

Export Packet...
Send Packet
Set Relative Packet

Select Related Packets

Hide Selected Packets
Hide Unselected Packets
Unhide All Packets

The columns in the Packets view offer many packet details. You can select more or less columns to show: right
click on the column heading bar and choose the More... command to open the Select Column dialog, check the
column headings you want to display.

If you only want to view those packets related to the current selection, you can first choose Select Related
Packets and a condition from the context menu, Colasoft Capsa will highlight all related packets; then right lick to
open the context menu again and select Hide Unselected Packets.

The table below lists the column headings available in the Packets view and the specific meaning they indicate.

Default \ Column Heading Description

*

No.

The packet number which is set automatically by
Colasoft Capsa.

Absolute Time

The actual time when the current packet is
transmitted.

The IP address or physical address where the

*
source current packet is transmitted from.
. Destination The IP address or physical address where the
current packet is transmitted to.
The protocol used by the current packet in
*
FIEEE transmission.
* Size The bytes of the current packet.
* Summary The summary for the current packet.
Date The date when the current packet is captured.
Delta Time The time span between the current packet and the

previous packet.

Relative Time

The time span between the current packet and the
relative packet (if no relative packet is defined, the
first packet is the relative packet).

IP Identifier

The identification number of an IP packet.

Source Physical

The physical address where the current packet is
transmitted from.

Destination Physical

The physical address where the current packet is
transmitted to.

Source IP

The IP address where the current packet is
transmitted from.

Destination IP

The IP address where the current packet is
transmitted from.

Source Port

The port number where the current packet is
transmitted from.

Destination Port

The port number where the current packet is
transmitted to.

Comment

The comment made for the current packet.
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You can rearrange the column heading bar by changing a column's position or width.

Packet decode
The packet decode view is a part of the Packets view, presenting the decode information of selected packet, you

can use the icon to show or hide it. Alternately, the packet decode information can be showed in the Packet
Decode window with double clicks on a packet row.

Next Show Hex
Previous | Show decode

Layout options

# Traffic.cscproj - Packet Decode (Global)

*YIEEE

=-Packet Info:

N
-Packst Mumber: 001346 |
-Bckual Length: 4 |~ |
Avaiablz Length: 74
- DateTime: 2005-05-13 10:54:19, 350636
-Ethernet 11 header: [0f14]
E---Destination Address: 00,0864, 1F, 14,95 {Asiarock Incorporation) [0/6]
E---Snurce Address: 00,08.64,59.E8. 2E (Asiarack Incorporation) [6/6]
*Protocol Type: 00300 (Internet IP TPy [1212]
= Internet Proktocal: | v
oooofllaz 05 00 oo oo oo 85 C4 05

QOOE | 03 00 84 00 & 00 44 00 00 0 03 03
00lc | 4 42 72 00 0% 00 00 00 OE 0E 00
002a | 22 00 04 00 04 00 00 00 O3 Q0 00 0o
0038 | 00 0B 64 1F 1A\ 55 00 OB 64 5S4 ES ZE
0046 145 00 00 3C

Hex Decode ASCII/EBCDIC

To show the Hex view, click the icon , which contains the actual packet contents in raw hexadecimal on the left
and its ASCII (or EBCDIC) equivalent on the right. The packet information in the packet decode view, Hex and
ASCII/EBCDIC view are consistent, when you select a section in one of these views, the corresponding portions
will be highlighted in the other views.

You may choose to show packet contents as ASCII or EBCDIC from the context menu by a right click in the Hex
view. If you want to save the data, you can select Copy Hex or Copy Text.

The layout of the Packet Decode window can be changed; use the icon and to rearrange the display.

The context menus of the packet decode view and Hex and ASCII/EBCDIC view contain the following useful

commands:
0 and De ptio
Copy (Ctrl+C) Copies the selection and puts it on the clipboard.
Copy Tree Copies the packet decode tree and puts it on the clipboard.
Expand All Expands all items of the display.
Collapse All Collapses all items of the display.
Copy Hex Copies the selected Hex codes and puts it on the clipboard.
Copy Text Copies the selected ASCII/EBCDIC text and puts it on the clipboard.
Show ASCII Shows the decoded information as ASCII.
Show EBCDIC Shows the decoded information as EBCDIC.
Logs view

The Logs view of Colasoft Capsa includes FTP Transfers view, Email Messages view, HTTP Requests view
and DNS Analysis view, from which you can find the records of TCP conversations, email messages, web
accesses and DNS analysis; in addition, in this Logs view you can monitor activities of four kinds of instant
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messengers: MSN, AIM, ICQ and Yahoo Messenger.

In addition to the common context commands as other tab views, this view also has the following specific
commands:

Command Description

Open Opens the reconstructed contents of the current log in a new
window.

Delete Deletes the selected logs.

Show Port in Client/Server Column Shows/unshows the port number in the Client and Server
column.

Export Log... Exports the logs to a file.

Logs - HTTP requests
This view presents the information of captured web accesses, you can open a listed URL with double clicks.

Export Locate Explorer Node
Log type \ Make Filter | Auto Scroll  Refresh Log counts
AR \
Sum?ﬂary rDiagnnseh rEru: oinks Pﬁ'rntmfs rCDD_yd'sf.;tiuns rr'-’latrix rF‘ackﬂl;/VLugs Garaphs iﬁlepnrts
v A
ﬁ‘HTTP‘Requests - - E%* 3 El- & -
Logs Tirmne | Client | Reguested LIRL | Met... | User Agent | Skatus...
131, 192,168.0....  htkpe v goodgle, comf GET Mozillaj4.0 ... 200
13:1... | 192.168.0.... | http:/ftoolbargueries.qoo... | GET Mozillaf4.0 ... 200
13:1... 192,168.0.... httpeffdata,alexa.comfdat,,, | GET Mazillaf4.0 ... 200
R;LLZE 13:1...  192,168.0.... htkpej v, goodle, com) GET Mozillaj4.0 ... 200
ey 131,  192,168.0.... bttpefftoolbargueries,.goo,.,, | GET Mozillaf4.0 ... 200
. 13:1... 192,168.0.... http:jidata,slexa.comidat,,, | GET Mozillaf4.0 ... 200
Ermail 13:1... 192,168.0....  htkped e, goodle, cormn) GET Mazillaf4.0 ... 200
Messages 131, 192.168.0....  httpeffwew google comfin,.. | GET Mozillaf4.0 ... 304
g 13:4,..  192,168.0....  hbkkpegdfeee, bycoves, corn) GET Mozillaj4.0 ... 200
Em 1314,  192,168.0,,.. bttpefitoolbargueries . goo,,, | GET Mozillaf4.0 ... 200
ETP 13:4...  192.168.0.... | http://data. alexa.comydat...  GET Mozilaf4.0 ... 200
Transfers 13:4...  192,168.0....  hkepedfeee bvcowes, comim,., | GET Mazillaj4.0 ... 200
8 13:4...  192.168.0....  httpffwes bvcows comfi.,.. | GET Mozillaf4.0 ... 200
a 134, 192.168.0....  httpffwess bvcows comli,, | GET Mozillaf4.0 .., 200
DMS Analysis 13:4...  192.168.0....  bttpeffwesw yoows comyfi.,. | GET Mozillaf4.0 ... 200

Note: a web page may be parsed into several URLSs, the URLs end with .css and .js can not be opened.
By default, Colasoft Capsa only captures the web requests from port 80. To capture the web requests from other

ports, click the Log icon ﬁ in the toolbar to open the Project Setting - Log page, then double click the HTTP Log
on the left and append ports to the Monitor Port pane on the right, use a semicolon to separate each two ports.
You may also modify other settings of HTTP Log in this page.

Logs - email messages

Colasoft Capsa can capture and analyzed the email messages transmitted in plain text, email list and related
information are displayed in the Email Message view. To view the reconstructed email contents, you can double
click on the selected email, it will be opened with your email client software; alternately, you can right click and
select the Open command from the context menu. Encrypted email messages can not be captured and
reconstructed.

Note: Captured emails may contain virus, please be cautious when you open email.
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Summary rDiagnDses rEndpoints rProtDcoIs rConversations rMatrix rF‘acket;/vLugs rGraphs rReports ]

4 Email Messages ~ @1 F -1 98 - 2] - Logs: | 46

Date | Time | Sender Na... | Sender Email | Receiver Name | Receiver Email | Subject | Size
Z005-05-30 13:11:17  "Smith" <testl@colasoft.c...  "egasw" <egaewi@dgmawe,.. | egeing 589
2005-05-30 13:57:39 | "karolin” Mail Delivery Subsy,..  "Smith" <testl@colasoft.c... | Returne.., 2792
2005-05-30 | 13:58:19 | "Smith" <testl@colasoft.c,.. = "Smith" «smithe@diangr.v... = agasfga 573
2005-05-30 135929 "Smith" <testl@colasoft.c...  "helloww" <helloww@siang.c... = Hello o572
2005-05-30 14:00:43 | "Smith" <testl@colasoft.c... <karclin@colaosft. .. ageqwa 590

To change the settings of email log, click the Log icon ﬁ in the toolbar to open the Project Setting - Log page,
then double click the Email Log to edit.

Logs - FTP transfers

You can view the detailed records of FTP uploads and downloads in this view. The FTP transfers are analyzed by
the FTP analyzer of Colasoft Capsa, to change the analysis settings for FTP transfers, click the Log icon ﬁ in
the toolbar to open the Project Setting - Logs page and select the FTP Log to edit.

4 FTP Transfers = @ ? - fg Bl 2 - ’Tgs:m

Ma, | Client | Server | Transfe... | Account | File Path/Marme | Duration
3 Micholas;1394 61,132.... 10:17:46  webmaster@lo,..  fhtdocs/Terms of Use after,doc 00:00;00, 735994
4 Micholas:1396  61,132.... | 10:183:06  webmaster@lo,,.  fhtdocs/TCPStreamview 00,00,00, 739305
5 Micholas:1400  61.132....  10:1&:51  webmaster@lo... | fhtdocs/CapsaS0u.chm 00:00:32. 754044
6  Micholas:1405  61.132.... | 10:20:56 webmaster@lo...  fhtdocs/Datasheet_Capsa_en.doc 00:00:10.086762
7 | Micholasi1407  61,132.... | 10:21:07 | webmaster@lo..,  fhtdocs/Datasheet_Capsa_en.pdf 00:00:12.098103
7 Micholas:1410  61.132..., 10:21:18  webmaster@lo,.. | fhtdocs/Capsa_TechSpecs, pdf 00:00:03.524860
9 | Micholas:1419  61,132....  10:23:49  webmaster@lo,., | fhtdocs/Screenshot/Capsas.0/TCPO9,,, | 00:00:01,409582
10 Micholas;i426  61,132.... 10:24:25  webmaster@lo,..  fhtdocsidoc.zip 00:00:03,621225
11 mMicholas:1428  e1.132.... 102448 webmaster@lo,..  fhtdocs/design.rar 00:00:06,533059
12 Micholas:1432  61.132.... 102552  webmaster@lo... | fhtdocs/affiliate Program After.dac 00:00:01.974887
13 Micholas:1433  61.132.... 1002555 | webmaster@lo...  fhtdocs/Download License Agreemen... | 00:00:01.911895
14  Micholas: 1434 61,132.... | 10:2%:58  webmaster@lo... | /htdocs/Privacy Statement after,doc 00:00:02,974855
15  Micholas: 1439 61.132.... 10:26:02  webmaster@lo,..  fhtdocs/Reseller Program After.doc 00:00:01,397620

Logs - DNS analysis
This view shows the details of DNS analysis results. The DNS Advanced Analyzer in Colasoft Capsa analyze the
DNS requests, replies and status. The DNS analysis are analyzed by the DNS analyzer of Colasoft Capsa, to

change the analysis settings for DNS analysises, click the Log icon in the toolbar to open the Project Setting -
Logs page and select the DNS Log to edit.

Surnmary rDiagnoses rEndpoints rProtocoIs rConversations rMatrix rPacketsJ Logs | Graphs ] Reports l

£ DS Analysis ~ | @ T - Bl 68 Bl (@) - m

Time Client Server Query Status Result

13:39:01 192.1658.0... | 61.139.2.6... | weaw,symantec.com | SUCCess CHAME=www, symantec. ...
133,19 192,168.0.,.  61.139.2.6,., liveupdate.symant...  Success CHAME=liveupdate.syma. ..
133340 192,168.0.,.  61.139.2.6,..  wwww,google,com Success CHAME=www.|.google.c...
13:3:42 192.1658.0,,, 61,139.2,6,,,  toolbargueries.go,.. | Success CNAME=toolbarqueries.l....
13:39:56 192.168.0.,,  61.139.2.6..,  wwww,colasoft,com Success A=07,15,229.157
13:39:58 192.168.0...  61.139.2.6... toolbarqueries.go... | Success CHAME=toolbarqueries.|....
1340028 192.168.0... |61.139.2.6...  wwww.etherlook.com | Success A=67.15.229.155
15:40:52 192,168.0.,.  61.139.2.6,.. www.protocolbase,., | Success A=F4,246,27.57

134111 192.165.0,,,  61,139.2.4,..  www.msn.cam Success CHAME=twrw, msn, com.n. ..

Logs - MSN Activities
In MSN Logs view you can monitor real-time information of all MSN activities, including date, time, node, session
name, as well as the message content.
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Summary rDiagnosis rEndpDints rProtocols rCDnversations rMatrix rPacketsf Logs | Graphs rR_e 4h
4o activiies | G F - B B S8 2] Logs: | 15
Logs Diate Time | MNodel | Session Mame | Content
2007-08-17 13:.., 192.168.,. | [unknown@207.46... *** kevin-zhou@msn,com has start
@ 2007-08-17 13:.., 192.168... | [unknown@207.46... =3 kevin-zhou@msncom said: hello

2007-08-17 13:... 192.168... | [unknown@207.46.... =3 kevin-zhou@msn.com said: kest

2007-08-17 13:... 192.168... | kevin-zhou@msn.co...  *** Good rain! has started the con
v 2007-08-17 13:.., | 192.168...  kevin-zhou@msn.co... == Good rain! said: okey
1;_&:‘5 2007-08-17 13:.., 192.168... | kevin-zhou@msn.co... <= Good rain! said: hello!
Ermail 2007-08-17 13:.., 192,168...  kevin-zhou@msn.co... <= Good rain! said: hello

Messages 2007-08-17 13, 192,168..,  kevin-zhou@msn.co... == kevin-zhou@msn,com said: wha

2007-08-17 13:...  192,168... kevin-zhou@msn.co... <= Good rain! said: Tdon't know, I'

HTTP
Requests

{"% 1‘ 2007-08-17 13:... 192.168...  kevin-zhou@msn.co... =23 kevin-zhou@msn.com said: wor
MSI\I 2007-08-17 13:... | 192.168...  kevin-zhou@msn.co... == Good rain! said: Colasoft Capsa
Activities 2007-08-17 13:.., | 192.168...  kevin-zhou@msn.co... <= Good rain! said: I copied that fr
}'2 2007-08-17 13, 192,168..,  kevin-zhou@msn.co... =3 kevin-zhou@msn,com said: pls s
(/\’5 2007-03-17 13:...  192.168...  kevin-zhou@msn.co...  => kevin-zhou@msn,com said: ok, 4
ATM 2007-08-17 13:... | 192,168.., | kevin-zhou@msn.co. .. | <= Good rain! said: You are welcom
Activities
)
FTP
Transfe < M ] S

All MSN messages are listed in time sequence, to view messages of a specific session, you can click the
desired session name in the session name column, then a text file will pop up to show all the messages of the
selected session.

& csim_session.ixt - Notepad

File Edit Faormat View Help

Eession Mame: kevin-zhou@msn.com - redcolor31%@hotmail. com

2007-08-17 13:48:47 %% Gpod rain! has started the conversation.
2007-08-17 13:48:47 <= Good rain! said: Dke¥

2007-08-17 13:48:55 <= Good rain! said: hello!

2007-058-17 13:48:58 <= Good rain! said: hello

2007-08-17 13:459:01 => kewin-zhou@msn.com said: what is colasoft capsa
2007-08-17 13:49:25 <= Good rain! said: I don't know. I'wve never heard
that before.

2007-08-17 13:50:03 =» kewin-zhou@msn.com said: wow, what a regret
2007-08-17 13:50:29 <= Good rain! said: Colasoft Capsa is a
prufess10na1 Eacket sniffer and protocol analyzer designed for network
analysis, packet sniffing, packet decoding and network monitoring. with
the ab111ty of real-time packet sniffing and accurate protocol
analyzing, Colasoft Ca?sa enables you to Tocate and troubleshoot
network problems guickly and efficiently.

2007-08-17 13:50:52 <= Good rain! said: I copied that from your well
know wehsite

2007-08-17 13:51:14 =»> kewin-zhou@msn.com said: pls see

www. colasoft. com for more information

2007-08-17 13:51:50 => kewin-zhouBmsn.com =zaid: ok, that's it, thanks
2007-08-17 13:52:06 <= Good rain! said: You are welcome.

To change the settings of MSN log, click the Log icon ain the toolbar to open the Project Setting - Log page
Then double click the MSN Log to edit.

Logs — Other Instant Messenger Activities Views of other instant messengers are same as MSN view.

Please refer to MSN view for more information.
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Graphs view

Unique to Colasoft Capsa enterprise edition. The Graphs view graphically presents the statistic data of the
current node. It contains a number of graph groups and multiple graph titles, including errors vs total packets,
network utilization, packet size distribution, packet size details and many more. The available graph titles and
display options will vary with the specific node you select from the Project Explorer.

Graph group Compare Mode Pause Refresh
i Legend box

Intervel options e
Graph title | Save As c:r;R types  Value options 3D view

'uml:;réry [Diagnoses Endppinks Esrotoradfs H’Cmsqersations rMa i rPackets Log; 'Eraphs rReports ] \ 4r
ﬁ‘ et{\lorkilackets v =] o & "Y Interval: 1 sec v Value: Per 1 sec value = le EI
Ervors PacKets v Network Packets (Global)

General *

=N

Utilization {bits)
Utilization {percentage)
[ Metwork Packets
Broadcast and Multicast
Packet Size Diskribution

TCP Analysis

»

TCP Connections
TCP 5%¥Ms, FIMs and Resets

Email Analysis

»

SMTP and POPS

Packets (Average per second)

FTP Analysis

»

Upload and Download (bytes)

HTTP Analysis 2006-04-11 16:14:36 20.08-04—1 11614356 2006-04-11 16:14:36
Elapsed Time (Interval: 1 second)

»

HTTP Requests
[ Total Packets

The table below describes each of the parameters used to set up or save a statistic graph.
Parameter Description

Available graphs are grouped by analyzer, each analyzer has one graph group; the

General group contains some commonly used statistic graphs, involving multiple
Graph group

analyzers.
Graph title The title of the graph.
Save As Saves the graph to a *.bmp, *.emf and *.png file.
Pause Refresh Temporarily halts refreshing the display.
The chart types which are available for the current node and the selected graph title.
Chart types
Value Selects a value type to see the graphic data.
Interval Selects a scale to set the refresh and sampling interval.
3D view Shows the graph in three-dimensional view.
Legend box Shows or hides the explanation of the colors appearing on the graph.
Gridline Shows or hides the gridlines on the graph.
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Reports view

Unique to Colasoft Capsa enterprise edition. A project report contains the statistic information of summary
statistics, diagnosis events, protocol statistics, top 10 IP protocol, top 10 physical addresses, top 10 IP addresses,
top 10 local IP addresses, top 10 remote IP addresses, and all available graphs with the current settings.

Save As Display Options

jSumrniar__y.-FDlﬁﬂoses rEndp-:ints rProt-:u:c-Is rCc-nversatinns rMatrix rF‘ackets Logs Graph;/vReports 4 b
E_j @ @ o Refresh Project 1.cscproj',Report

Report of Project 1.cscproj {* Colasoft Capsa

B3

[

Report generated on: 2006-07-12 14:27:08

Summary Statistics

Summary Statistics
Diagnosis Events

Protocol Statistics

TOP 10 IP Protocol

TOP 10 Physical Addresses
TOP 10 IP Addresses

TOP 10 Local IP Addresses
TOP 10 Remote IP Addresses

Statistics Values
Capture Count

Start Date 200&-07-12

Start Time 13:09:41

Duration 00:13:29
Physical Emors Count

Total Errors a

CR.C Errors o

Alignrnent Errars u] w

System options

The Options dialog contains some global options which apply to all the projects in Colasoft Capsa. There are four
pages in this dialog - General, Format, Decoder and Analyzer. Choose Options... under the Tools menu or click
the Options button in the toolbar to open the Options dialog, where you can make general options, define the
packet decoder, enable analysis models and choose the display format.
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Options - General
The General options let you set most popular settings of the project.

Options

l General |'={5 Format || L Decoder || (o Analyzer|

[¥llways show settings dialog when start capkure,

Always show maximumed window when skart program,
Show warning dialog For invalid settings when start capture,
Disable windows suspend when capturing,

Disable smooth scrolling,

Disable lisk sorting if item count reaches: (2000

; o
Keep recent open file count:
TCP stream preview size: Kilobytes

Enable passive name resolution

Save Resolved Mame For IP address when capsa exit.

Remove unused names after days
L Ok ] [ Cancel J [ Help J

Always show project settings when start capture.
If checked, Colasoft Capsa will always open the Project Settings dialog each time when you start a capture.

Always show maximum window when run Capsa.
If unchecked, Colasoft Capsa will remember the last setting of project window size and apply to next time when
you run Capsa again.

Always show project warning when start capture.
If unchecked, Colasoft Capsa will not show the warning dialog when you start a new capture.

Disable smooth scrolling.
Instant scrolling will be enabled in effect if you check this option.

Disable windows suspend when capturing.
The power option schema in your system control panel will be override. You can not standby or hibernate your
system without stop Capsa from capturing.

Disable list sorting if item count reaches:

The sorting function will be disabled when the listed items reach the limitation. The default count is 2000.

TCP stream preview size:

You may customize the preview size of TCP stream, the default size is 64 KB. When a TCP stream goes beyond
the limitation, only the contents within the defined size are shown in the Stream view.

Keep recent open file count:
Define a limit for keeping recent open file.

Enable passive name resolution
Enable passive name resolution, Colasoft Capsa will automatically resolve the name of captured IP address.

0 Save Resolved Name for IP address when Capsa exit.
By default, Colasoft Capsa will automatically save the resolved names for IP addresses when you exit. If
uncheck, the resolved names will lose when you exit without saving them.
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0 Remove unused names after
Colasoft Capsa will remove the resolved names which unused more than 2 days in default.

Reset
Click this button to restore the predefined settings.

Options — Format

The Format dialog let you customize the format of data display. You can define the formats for data display,
including decimal places of normal number, decimal places of percentage, byte format, bit format, bytes per

second format and bits ier second format.

General | =& Format | [ Decoder || &) Analyzer|

Decimal places of normal number: 3 e
Decimal places of percentage: 3 :
Eyte format: B, KE, ME, GE, T& v|
Bit: Farrnak: b, kKb, Mb, Gb, Th b |
Bwtes pet second Format: |E||;.sJ KBps, MBps, GBps, TBps % |
Bits per second Farmat: ||:-|:-s, kbps, Mbps, Gbps, Thps  w |

L a4 ][ Cancel J[ Help ]

e Decimal places of normal number
The display precision of a number. You can customize the decimal places though the thousandth in
default.

e Decimal places of percentage
The display precision of a percentage. You can customize the decimal places though the thousandth in
default.

e Byte format
By default, Colasoft Capsa displays packets sizes and the traffic in an appropriate byte unit, such as B, KB,
MB, GB, or TB. Which unit is selected depends on how large each packet or the current traffic is. Users
can define the unit from the combo box.

e Bit format
By default, Colasoft Capsa displays packets sizes and the traffic in an appropriate bit unit, such as b, kb,
Mb, Gb or Th. Which unit is selected depends on how large each packet or the current traffic is. Users can
define the unit from the combo box.

e Bytes per second format
Rate at which bits of information are transmitted. Colasoft Capsa displays the rate of information in an
appropriate unit, such as Bps, KBps, MBps, GBps or TBps. Users can define a display format from the
combo box.
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e Bits per second format
Rate at which bits of information are transmitted. Colasoft Capsa displays the rate of information in an
appropriate unit, such as bps, Kbps,
Mbps, Gbps or Thps. Users can define a display format from the combo box.

Options - Decoder

The packet decoders are the essential engines to decode packets. All available decoders are enabled by default,
but you can close those you don't need to increase the program performance. If you close a decoder in the list,
Colasoft Capsa will not decode the specific protocol elements when encounters a packet of the same type until
you enable it again, as a result you can not view the decode information of that packet.

To open the Options - Decoder page, select Options... from the Tools menu and then press the Decoder tab. All
decoders are listed by protocol and marked with a tick indicating they are enabled, use the check box before every
decoder to disable it.

Options
| General || £ Formatl L Decoder | R nnalvzer|
Protocol Decoder I
aH Colasaft &H Packet Decoder
ARP Colasoft ARP/RARP Packet Decoder
BOOTP Colasoft BOOTP Packet Decoder =
CIFS Colasoft CIFS Packet Decoder
COPS Colasoft COPS Decoder -
CHZP Caolasoft DHCP Packet Decoder
DNS Colasaft DNS Packet Decoder
2= Calasoft EGP Packet Decoder
ESP Colasoft ESP Packet Decoder
Ethernet 802.2 Colasoft Ethernet Frame Decoder
Ethernet 802.3 Colasoft Ethernet Frame Decoder
Ethernet II Colasoft Ethernet Frame Decoder
Ethernet AP Calasoft Ethernet Frame Decoder
Finger Colasoft Finger Packet Decoder
FTP Ctrl Colasoft FTP Packet Decoder
FTF Data Colasoft FTP Packet Decoder
GRE Colasoft GRE Packet Decoder 3|
— . e e f =
‘ Ok, J [ Cancel J [ Help J
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Options - Analyzer
The Analyzer page list the advanced analyzers, all of them are enabled in default. To reduce resource occupation

and improve the global efficiency, users can close a analyzer by uncheck the box before it to get more clear view
of the analysis results.

Options

| General || %1 Format || 1 Decoder 1 Analyzer

Mame

Email Analyzer Module

ARP &nakyzer Module

FTP Analvzer Module

IP Analyvzer Module

HTTP &nalyzer Module
MNetBIOS Analyzer Module
CMS Analyzer Module
Instant Messenger Anakyzer

L [l 4 ][ Cancel ” Help ]

When you disable an analyzer in the Analyzer page, Colasoft Capsa will stop analyzing the corresponding
protocol elements or displaying the analysis results in the relative views or settings until you enable it again. The
following table is the views affected by every analyzer.

Analyzer Relative views or settings

_ Summary view, Logs view, Reports view, Graphs view, Project
Email Analyzer Module . : : : :
Settings - Diagnosis, Project Settings - Log

ARP Analyzer Module Diagnosis view, Reports view, Project Settings — Diagnosis

Summary view, Logs view, Reports view, Graphs view, Project
FTP Analyzer Module . : : : :
Settings - Diagnosis, Project Settings — Log

IP Analyzer Module Diagnosis view, Reports view, Project Settings — Diagnosis
Summary view, Logs view, Reports view, Graphs view, Project
HTTP Analyzer Module . : : : :
Settings - Diagnosis, Project Settings — Log
NetBOIS Analyzer Module Resolves host name passively if uncheck this module.

Summary view, Logs view, Reports view, Project Settings -
DNS Analyzer Module _ ) _ .
Diagnosis, Project Settings — Log

Instant Messenger Summary view, Logs view, Reports view, Project Settings -

Analyzer Diagnosis, Project Settings — Log

For example, uncheck the HTTP Analyzer Module. The statistic information HTTP Analysis in the Summary view,
Logs view, Reports view, Graphs view and the HTTP Requests group in the Logs view are disable. And in the
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Project Settings dialog, the HTTP Events in the Diagnosis page and the HTTP Log in the Log page are disabled
too.

Project Settings

| General || Adapter || “F Filter || 2% Netwark || 5 Log L4 Diagnasis |
Al |E General
Log Buffer Size (KE) 51z
DMS Hosk or Domain Mot Exist | Diagniosis Log File (s) Disable
DS Server Error | [T General | 53 Adapter | ? Filter Ii‘i Nehmk!;_E\_! Lu-:|| @ Dlagnosts
DMS Server Slow Response Time |
FTF Data Connection Failure - g . _ | (S ';:;:
FTP Non-FTP Traffic Fi D‘“_"’mm’:ﬁi"a
FTP Server Returned Error
FTP Server Slow Response Time 4 Time:
TF Client Error [¥] F¥P Data Connection Fa’”"
[#] FTP Mor-FTF Traffic
HTTP Server Errar POR3 NorPORS Traffic F
TP Server Slow Re POP3 Server Returned Ervg
[#] POP3 Sarver Slow Respongs Time
[¥] SMTP hNon-SMTE Traffic
POP3 Server Returned Error ed
POP3 Server Slow Response Time & Time
SMTP Man-SMTF Traffic = 'E:l”:;‘c et
SMTP Server Returned Error [ TCP Fast Retr
SMTP Server Slow Response Time [#] TEP Trovabid Checksum
F| I"@ Transpark Laver TCF Low Window
< | H [ TCP Port Scan =
= g - ¥
e () & (@) (2 @ (@) | |
[]5ave as default settings L QK J [ Cancel J [ Help J
Project Settings |Z|
Adapter ” *F Filer ” ’1" Metwark | £ Log I@ Diagnosis |
d = DNS Log
<[] b5 Conditions Log Buffer Size(kE) 204
= Email Log

<[] Conditions

| &) DNS Log
[] DMs Conditions Log Buffer
=] Ernail Log

AIM Log

<[] Conditions

ICO Log

<[] Conditions

Yahoo Messenger Log
<[] Conditions

[] Conditions

10 Log

[] Conditions

B. [v] ¥ahoo Messenger Log
------ [] Conditions

EENENE

[]5ave as default settings
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Restarting capture

When you stop the current capture, all of the packets currently in the buffer are retained. If you then restart
capture, Colasoft Capsa will clear or reset some items from the packet buffer in order to keep the data displayed
accurate and up to date. Theses items include statistic values, graph values, logs, conversations and the packets
stored in the packet buffer.

The log data of advanced analyzers can be cleared optionally, including email messages, FTP transfers, HTTP
requests, DNS analysis, four IM activities and diagnosis events. If you don't want to lose these data, you should
save the project before restart capture.

Restart Capture |X|

Restart will clear or reset the Following items:

Clear statistic values and graph data
Reset analvzers
Clear all conversations data

Clear all packets in packet buffer

Clear selected log data: [1zelect all items

Mame Count
[] HTTP Requests

] Email Messages

] MaM Activities

[] AIM Activities

[ FTP Transfers

[ 10 Activities

|:| ‘ahoo Messenger Activities
|:| DS Queries

[ O e I s I s I s e Y e

L K J [ Cancel ]

Automatic capture

It is allowed to set Colasoft Capsa to automatically open a project and start capturing packets, the data saved in
the project will be cleared.

On the default installation category of Colasoft Capsa, the command line would be started from:
C:\Program Files\Colasoft Capsa 5.0 Enterprise

To automatically open a project file .cscproj or load a template file .csctemp, the command would be:
Capsa50u.exe/autostart <Project File or Template File>
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Project Settings

In Colasoft Capsa, every project has its own adapters, filters and analyzers, the Project Settings dialog lets you
customize the settings for the current project. You can define project settings before starting capture or during the
process of capture. Click the Settings button in the toolbar to open a Project Settings dialog, where you can
make general options, change project adapter, add or modify filters, customize network profile, set conditions for
logs and select diagnosis events.

Notice: If you check the Set as default settings option and confirm, the current project settings will be saved as
default and will be applied to any new created project.

Project settings - general
This page provides some general project options.

Project Settings

General | Adapter ” “F Filter ” ;’ Mebwork, " & Log ” @ Diagnosis|

Packet buffer size: 16384 2| Kilobytes,

wihen buffer is Full: |Discard oldest packets (ring buffer) ~ |
Auto save packet file
Limit each packet to Bytes,
() single file
O Mulkiple Files

a

Save in folder: | |

Base file name: | | ?
Split File ervery I:I Dy
Keep all files Keep most recent files
Statistics Settings
Enable detail protocol statistics of each endpaint, [ ] Enable conversation statistics of each protocal,
[C]Enable detail statistics of packet size. [[] Group 1P address by its country,
[JEnable custam part
Always show project settings when start capture.
[5ave as default settings i 84 J ,_ Cancel J ,_ Help J

Packet buffer size

By default the packet buffer size is 16384 KB. You may change the value, but you must take the size of your
system memory into account, because captured data is stored in the packet buffer and, when you save a project,
the data contained in it will be saved to your hard disk.

The size you set will also affect the packet list view. The bigger size you set, the more packets you can see in the
packet list view.

When buffer is full
When the number of captured packets reaches the packet buffer size you have specified, Colasoft Capsa will do
one of the following:

Discard oldest packets (ring buffer)
It is recommended to discard the oldest packets when the packet buffer is full, Colasoft Capsa will store new
packets and keep the packet buffer up to date.
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Discard new packets
All new captured packets will be discarded after being analyzed and will not be saved to the packet buffer.

Discard all old packets
Colasoft Capsa will empty the packet buffer and then append new packets to it.

Stop capture
Colasoft Capsa will stop capturing new packets.

Note: Don't choose this option if you would not like to cease capture.

Auto save packet file
If checked, Colasoft Capsa will automatically save packets to a single file or split files as you define.

Limit each packet to Input a value between 60 and 65535 to specify how many bytes are to be saved from the first
byte when program saving the packets into file form.

This is a useful feature for users who would like to send packets to technicians for analyzing but also want to keep
the detail information in the packets confidential.

Single file
All packets are saved to a same file.

File name

Specifies a name for the packet file. Click the B button on the right to open a dialog for defining a save path for
the packet file.

Multiple files
Packets are saved to the files split by time or size. To reduce the total size, you may choose to only keep the most
recent files.

Save in folder

Specifies a folder name and the save path for all files. Click the Q button on the right to open a dialog for
defining a save path for the folder.

Base file name
The portion of a file name to the left of the period separator. Colasoft Capsa allows very long file names. Click the

button to view an example of the base file name.

Split file every
Chooses a rule for splitting the file if the file size is too big. You can split files by time or file size - months, days,
hours, minutes, KB, MB.

Keep all files
Saves all split files in the defined save path.

Keep most recent
Specifies the number of most recent files for saving.

Statistics Settings

You can save system resources if uncheck the following statistics options.

Enable detail protocol statistics of each endpoint.

If check this option (by default), you will not see detail protocol statistic information of endpoints (except root
nodes).

Enable detail statistics of packet size.
If uncheck this option (by default), you will not see the statistics of Most Common Packet Sizes in the Summary
view.
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Enable detailed protocol statistics of each conversation
If check this option (by default), you will not see the detailed protocol statistics of each conversation in the
Conversations view.

Group IP address by its country
If uncheck this option (by default), the captured IP addresses will not be grouped under countries in the IP
Explorer group of the Project Explorer dock window.

Enable custom port
Check this option if you want Capsa to monitor non-standard ports, and then click the button E] to add ports.

Always show project settings when start capture
If checked, Colasoft Capsa will always open the Project Settings dialog every time when you start a new capture.

Project settings - adapter

Each time when you start a new capture, you are required to select the adapter. Available adapters are listed in
the Project Settings - Adapter page, you can choose one or more adapters (only one adapter can be opened in
the professional edition ) for the current project. When an adapter is highlighted, some brief descriptions about this
adapter will be showed on the lower Property pane. In this page you can also test the selected adapter. See
"Capture sources" for more references.

Project Settings

General Adapler | *F Filer ” g% Metwork " @ Log ” 4 Diagnosis

[=] = Local Adapter
|:| 107100 Gigabit Ethernet CardBus PC Card
Marvell Yukon 8 56 PCI-E Gigabit Ethernet Controller
[] ¥Mware Wirtual Ethernet Adapter for ¥Mnet1
w[[] ¥Mware Yirbual Ethernet Adapter for YMnetd
“[7] Localhost LoopBack.

Property Walue

Packet Driver NDIS Protocol Driver

Physical Address 00:14:40:41;09:92(802,3)

Link Speed 100.0 Mbps

Max Frame Size 1500 bytes

IP Address 192,168.0.61/255,255.255.0

Default Gateway 192,168.0.1 {00:D0:41:26:3F:9E)

Adapter Status Operational

—
Caleulate network utilization Bandwidth: oo = | Mbps v | [ Test ‘D

[]5ave as default settings L k. ] [ Cancel J [ Help J
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Test
To test a adapter you just need to select on adapter and click test at the right bottom, a dialog box will pop up and
how the test information.

Adapter Test

Testing selected adapter(s), please waiting...

BR Marvell Yukon 88E8056 PCL-E Gigabit Ethernet Controller
" /1, Capburing traffic: no packets captured vet,

Duration Time: 00:00:10

L Stop Test J [ Cancel l

It is allowed to change adapter during the capture process, however, in order to keep the data displayed accurate
and up to date, any change to adapter settings will clear or reset some project items, e.g. statistic values, graph
data, analyzers, conversations and packet buffer. Log data are optionally cleared, including email messages, FTP
transfers, HTTP requests and diagnosis event logs.

&

Clear Project Data

The Following items will be cleared or reset ;

Clear statistic values and graph data
Reset analyzers
Clear all conversations data

Clear all packets in packet buffer

Clear selected log data: [ zelect all items
Tarme Count
] HTTF Requests 14

1 Email Messages

[ M3h Activities

[ A Activities

[] FTP Transfers

[ 1) Activities

|:| ‘ahoo Messenger Activities
|:| DS Queries

L R I e (A o |

L Ok J [ Cancel ]
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Project settings - filter

This page allows you to set filters for analyzing packets. You can add a new filter or select from the Filter Table
lists some predefined filters, or import filter from a file.

X

Project Settings

| B General | €5 Adapter | T Filter |a% Metwork. | 55 Log | & Diagnosis |

Adapter

Accept only
packets NOT
matching 1
fitter.

ety |
P HTTP packets

matching any of E .
[@ POP3 Metch

¢N0t higtch .

[ % SMTR ] Match
SMTP packets !

Mat hgteh '

|
'E;:jTrash Bl B Analyzer [ Export b

[5ave as default settings L k. ] [ Cancel J [ Help J

Accept
By clicking this button (if applicable), you can change the current filter's status, Colasoft Capsa will accept the
packets matching this filter for analysis.

Reject
By clicking this button (if applicable), you can change the current filter's status, Colasoft Capsa will not accept the
packets matching this filter for analysis.

Up
By clicking this button (if applicable), you can move up the current filter.

Down
By clicking this button (if applicable), you can move down the current filter.

Add

Click on this button and choose to create a new filter or add from the Filter Table. When you choose New,
Colasoft Capsa will open the Add Filter dialog, where you can insert a simple filter or an advanced filter. When
you choose From Filter Table, you can check one or more predefined filters and decide the rule. The new added
filters will be graphically displayed one by one, which status and position can be changed with the Accept, Reject,
Up or Down button.
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Add Filter
Simple Filker | advanced Filker |

Filter name: |Filter5 | Filker colar:
Comment: |Packet Filter | ) accept (O Reject
Address Filker

Address 1 Address 2

|IP\.-'4 address v | OISR |.0.nv address v | ?

Both directions v

192.168.0.68 v|@ | 3
CIPort Filer

Park 1 Part 2

Single port ? BEETaR Ay pork 7

Both directions

Protocol filker

Ethernet 11 Ethernet 1T
Remave
L ol ][ Cancel J Help
Edit...

To modify the current filter, click the Edit... button and open the Modify Filter dialog, note that the modifications
made from this dialog is only project-related. To modify the filters in the global Filter Table, you must open the

Filter Table by clicking the button @ in the toolbar.

Remove
When this button pressed down, the current filter will be removed from filter list and can not be recovered.

Import...
You can import filter from a saved filter file.

Export

Click on this button and choose to export all filters or just selected ones.
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Project settings - network

Colasoft Capsa lets you configure your own network profile (enterprise edition only). In the Network page of
Project Settings, you can customize one or more physical endpoints or IP endpoints, accordingly the network
nodes in the Project Explorer will be reassigned or renamed.

The Auto Detect button is to automatically detect you network configuration, you may also load a network profile
from a file, or save your current settings to a file.

ES

Project Settings

| General || Adapter || “F Filer | !ﬂi Netwiork |ﬁ Laog || ) Diagnosis|

B& Physical Endpoints A add
Bg Lacal Seqrent
“{#% Local Host 3 Edit...
3 Gateways 3

{74 Broadcast Addresses Remove
o Multicast Addresses
B;ﬁ; 1P Endpoints

E!@ Lacal subnets
= 192.168.0.0/24

TR

i Local Host
]
Broadcast
2 "This" Netwarks Dawn
%% public-Diata Mebwarks )
Gateway

Please enter IP addresses, IP ranges or netmasks of this
aroup, one entry per line,

192.168.0.1 [#] Limit sub-nodes: {1000 :
Auto Dekect

[]5et as defaulk group

Import...
Set as local group

Export...

| -
R

[]save as default settings L ik ] [ Cancel Help J

Add

By clicking this button (if applicable), you can add a new group as a sub-group in the selected group.

Edit
By clicking this button (if applicable), you can change the group's name.

Remove
Deletes a selected group from the list (if applicable).

Up
By clicking this button (if applicable), you can move up the current group.

Down
By clicking this button (if applicable), you can move down the current group.

Auto Detect...
Auto detects the settings of current NIC, gains the information of network configuration and the gateway.

Import...
Import a network profile in *.cscnet format.

Export...
Export the current network profile to file in *.cscnet format.
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Project settings - Log

Log setting dialog box is a place where you can set up conditions for these listed logs. You can also reset
conditions to the default settings, or import a specific log setting, or export the current log settings. To save the
current settings as default settings you need to tick in the bottom box. You can open this dialog box by clicking the
Log button in the toolbar..

The settings or modifications made in this page will impact the results displayed in the Logs view.

Project Settings |X|
| General || Adapter || ? Filter || it Networkl & Log | % Diagnosis|
= DNS Log
Log Buffer SizekB) Z043
- Yahoo Messenger Log
~[[] Conditions
[]save as default settings ‘ [0]4 I [ Cancel J [ Help J

Reset
Resets the selections to default position.

Reset All
Resets all selections to default position.

Import
Import a log file in *.cscdiag format.

Export
Export the current settings of log page into a file in *.cscdiag format.
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Email log

In the setting page, you can define the email log's buffer size, select log file format, enable Colasoft Capsa to save
email contends and set conditions for the display of email logs. The settings or modifications made in this page will
impact the results displayed in the Logs - Email Messages view.

See the figures below as setting examples.

Project Settings Z|
| General || Adapter || ? Filter || a% Networkl & Log | % Diagnosis|
= Conditions
Attachment Ignore
Size Range (KE) 1024
Sender Address @colasoft.com
Receiver Address
= Exceptions
Attachment Ignore
Size Range (KE)
Sender Address
Receiver Address support@colasoft, com
Receiver Address
The address of email recipient.
=-[#] ‘fahoo Messenger Log Blark ezxceptions will be ignored by system; the logical
D Conditions relationship between exceptions is "MD" if there is any
other exception defined.
Reset  Reset all
Import
(@)= export
[]5ave as default settings ‘ QK I [ Cancel J [ Help J

By default, the email log is enabled and the log buffer size is preset as 1024 KB. If you disable the email log, you
can not see any email log information from the Logs - Email Messages view. The log buffer size is customizable;
when the email log buffer is full, Colasoft Capsa will discard the oldest email logs and append the new ones to it.

By clicking the browse button and check "Save log file to disk", you can select to save all captured email
logs to a single file or multiple files which are split by time or size.

Conditions

Check this option and then you can define one or more conditions for logging, blank conditions will be ignored by
system, system will log all items if there is no condition defined; the logical relationship between conditions is
"AND" if there are more than one condition defined.

Exceptions
Define the logging conditions of being excluded by system, the logical relationship between exceptions is "AND" if
there are more than one exception defined.

Save Email Contents

To view the real contents of a logged email, you must enable Colasoft Capsa to save email contents and
designate a location in advance. When this option is disabled (by default), you can only see email log information
in the Logs - Email Messages view and can not open the email.

By clicking the browse button E] and check Save log file to disk, you can select to save all captured email logs
to a single file or multiple files which are split by time or size.
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Log File Settings

Save log File ko disk

() single file

File: narne:

Crvepwrite the existing File

(%) Multiple files

Save in Folder: |C:'|,Program Files\Calasoft Capsa 5.5 Enter| E

Base file name: |Emai| | @

Split: file every | 1 — | | Day w |

(Keep all files (%) Keep mosk recent files

L Ok, I [ Cancel J [ Help J

Single file
All packets are saved to a same file.

File name

Specifies a name for the packet file. Click the Q button on the right to open a dialog for defining a save path for
the packet file.

Multiple files
Packets are saved to the files split by time or size. To reduce the total size, you may choose to only keep the most
recent files.

Save in folder

Specifies a folder name and the save path for all files. Click the E] button on the right to open a dialog for
defining a save path for the folder.

Base file name
The portion of a file name to the left of the period separator. Colasoft Capsa allows very long file names. Click the

button to view a example of the base file name.

Split file every
Chooses a rule for splitting the file if the file size is too big. You can split files by time or file size - months, days,
hours, minutes, KB, MB.

Keep all files
Saves all split files in the defined save path.

Keep most recent
Specifies the number of most recent files for saving.

© 2009 Colasoft. All rights reserved. Colasoft®, the Colasoft logo, Capsa® are among the trademarks or registered trademarks of the company in

the United States and/or other countries. All other trademarks are property of their respective owners. 58/58




Maximize Network Value

eN Colasoft Project Settings

FTP transfer log

In the setting page, you can define the FTP log's buffer size, select log file format, and set conditions for the
display of FTP logs. The settings or modifications made in this page will impact the results displayed in the Logs -
FTP Transfers view.

The setting operations in this page are similar as email log, please refer to Email log for more descriptions.

See the figure below as setting examples.

Project Settin, X
] BSs Ll
| General | Adapter " ? Filter || 3% Networkl @ Lag I@ Diagnosis|
=[] DNS Log B Conditions
“-[[] DNS Conditions File: Size (KEB)
=[] Email Lag File Mame .zip
<[] Conditions © Exceptions
FTP Lag Fil ) 0-200
Conditions File Mame
HTTF Log
<[] Conditions
<[] Conditions
AIM Log
o[ conditions
=[] 12G Log File Size {KB)
<[] Conditions The size of FTP files {value, value range or the
=-[#] fahoo Messenger Log ;Umbilnaltiozl'i of the bwa),
it ample 1:
[ Condiions Sample 2:125-200
Sample 3; 21;125-200
EBlank exceptions will be ignored by system; the logical
Reset R " relationship between exceptions is "AMD" if there is any
eset a other exception defined.
/ Import
Export
[]5ave as default settings L [8]'4 ] [ Cancel ] [ Help ]
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HTTP log

In the setting page, you can define the HTTP log's buffer size, select log file format, and set conditions for the
display of HTTP logs. The settings or modifications made in this page will impact the results displayed in the Logs

- HTTP Transfers view.

The setting operations in this page are similar as email log, please refer to Email log for more descriptions.

See the figure below as setting examples.

Project Settings

General || Adapter || “F Filter || % Network| @ Log qu} Diagnosis|

DM Log
~[] DMS Conditions
Email Log

Reset all

Reset
i Import

2 Conditions
Content Type imaqgyqif
Request Method POST
Status Cade 200
LRL

B Exceptions
Content Type
Request Method
Status Code

(€] [ (@) (@) ~—ewor

URL

Set Filkers For HTTP URL; multiple URLs are separated with
semicolon.

Sample 1: colasoft,com

Sample 2! htkpeffna, colasoft.com

Sample 3: colasoft.com;protocolbase. net

EBlank exceptions will be ignored by system; the logical
relationship between exceptions is "AND" if there is any
other exception defined.

[5ave as default settings

L Ok i[ Cancel ][ Help
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DNS log

In the setting page, you can define the DNS log's buffer size, select log file format, and set conditions for the
display of DNS logs. The settings or modifications made in this page will impact the results displayed in the Logs -
DNS Analysis view.

See the figures below as setting examples.

Project Settings £|
| General Adapter || “F Filter || a% Network| & Log | ) Diagnosis|
DMS Log = DNS Conditions
Query
Skatus Successful
=2 DNS Exceptions
Query
Status all
Query
Sek Filkers for DNS query name; multiple query are
‘fahoo Messenger Log separated with semicolon, e.g: wwww, 163, com;
i WAL, SING . Com,
[ Conditions Blank conditions will be ignored by svstem; the logical
relationship between conditions is "AMD" if there is any
other conditions defined.
RTt Reset all  Import
[@]=——export
[J=ave as default settings L Ok J [ Cancel ] [ Help J
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MSN Log
To enable MSN log settings, you have to tick in the box next to "MSN Log". In this dialog box you can define the
log buffer size(KB) and decide whether to save log files to disk.

If you want to save the log files in the disk for future reference, you can click "...", then a "Log File Settings" dialog
box will pop up, where you can make detailed saving settings.

Project Settings |X|
| General || Adapter || “F Fileer || A Networkl & Log | G Diagnosis|

#| DHS Log = MSN Log
“[[] DMS Canditions Log Buffer Size(kE) 2048
Email Log Log File{s) Disable E.]

FTP Log

[ Conditions Log File Settings
HTTP Log

-[] Conditions Save log file to disk

<[] Conditions ) Single file
AIM Log
<[] Conditions File name:
100 Log
<[] Conditions Owerwrite the existing File

/ Y¥ahoo Messenger Log (#) Multiple files
“[[] Conditions
Save in Folder: | | E
Base file name: | |
Split: File every |1 — | |Dav v |
. (& keep allfiles () Keep most recent ICI file:s
[[]=save as default settings L 2K J [ Cancel J [ Help J

Conditions is a place where you can make settings for Account Name and Content. Blank conditions will be
ignored by system, system will log all items if there is no condition defined.

Project Settings |X|
| General ” Adapter " ? Filker || ﬁ Networkl @ Log | % Diagnosis|

-] DNS Conditions Account Mame user 1@msn. com
Email Log Content hella
@ Exceptions

Account Mame

Content
HTTP Log
[ Conditions
M3N Log
Conditions
AIM Log
Conditions
~[] Conditions Flease define one or more conditions For logging, blank
Yahoo Messenger Lag conditions will be ignored by system, system will log all
T [] Condtions items if there is no condition defined; the logical

relationship between conditions is "MD" if there are more
than one condition defined,

[[]5ave as default settings L (o] 4 ] [ Cancel ] [ Help ]

The settings or modifications made in MSN Log page will affect the results displayed in the Logs - MSN Activities
view.
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Other IM Logs

The settings or modifications of other IM Logs are similar with that of MSN Log; please refer to MSN Log for more
information

Project settings - Diagnosis

This setting page lists all available diagnosis events, all are enabled by default. You can view the description and
other references for an event in the right section when it is highlighted in the left section, the color, severity level
and some other parameters (if applicable) can be customized.

If you disable a diagnosis event in this page, you will not see it in the Diagnoses view.

Project Settings

General || Adapter || *F Fileer || #% Metwark " 5l Log | L& Diagnosis l

= Diagnosis Analyzer | |2 SMTP Server Slow Response Time
=-B& application Layer Color M oo0
FTF Data Connection Failure Severity @ Notice
FTP Mon-FTP Traffic Server Slow Responses Time (msy 150
FTP Server Returned Error
FTP Server Slow Response Time
HTTP Client Error
HTTP Mon-HTTP Traffic
HTTP Request Mok Found L
HTTP Server Errar
HTTP Server Slow Response Time
POP3 Mon-POP3 Traffic
POP3 Server Returned Error
POP3 Server Slow Response Time
SMTP Mon-5MTP Traffic
SMTP Server Returned Error
SMTP Server Slowe Response Time
=B Transport Layer
Disa.bleﬂ.ﬂ - [¥#] TCP Cannection Refused Reset

TiCP Fast Retransmissio
[7] TCP Invalid Checlestm | o)
2|

il 1 >
(6] @ [§-— oo
LY

SMTP Server Slow Response Time

Description:
The average response time from the server is equal
to or highet than the Slovy Responze Time threshold,

Possible causes and solutions:
The SMTP server is overloaded,

[J5ave as deFauIt;&wgs Import L [8]'4 ] [ Cancel J [ Help J
AN
Enable All Invert Selection Reset All
Enable All

Enables all listed diagnosis events, Colasoft Capsa will diagnose all network events. The more diagnosis events
enabled the more resource and memory will be occupied.

Disable All
Disables all listed diagnosis events, Colasoft Capsa will not diagnose network event.

Invert Selections
Inverts the position of all events.

Reset
Resets the selections to default position.

Reset All
Resets all selections to default position.

Import
Imports a diagnosis file in *.cscdiag format.

Export
Exports the current settings of diagnosis page into a file in *.cscdiag format.
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Data Management

When your project buffer is full, Colasoft Capsa will discard some packets to keep the displayed packets
up-to-date, use the assistant functions of Colasoft Capsa you can protect important packet information from being
discarded. Colasoft Capsa allows you to copy, export, print and import packet information, details are described in
the sections below.

Saving

Saving a project

To save a project with all its settings and captured packets, you can:
Use standard keyboard command Ctrl + S.

Click the icon E in the Toolbar.

Select the Save command from the File menu.

The project will be saved as .cscproj file and stored in hard disk, when you want to have a review in the future, use
the Open command from the File menu or Start Page and select the file name to open it.

Save in; | |=) Colasoft Capsa 6.2 Projects b | hj I'_? % *

N @ Email. cscprof
@ || HTTP2578 cscpraj
My Recent @ Office 1.cscproj
Documents | Traffic 05247, cscproj

My Computer

e
@ e 7
My Mebwaork.  Save as type: | Colasaft Capsa Projects [* cscpro)) “ |

Saving project data

By clicking the Save As icon @ you can save project data from the Summary view, Diagnoses view,
Endpoints view, Protocols view, Connections - General and Connections - Stream view to a text file. The
charts in the Graph view can be saved in .bmp format.

Saving as template
You may save the settings defined to a template file and be applied to new projects in future. There are two ways
to save as template:

Save from the File menu
Open the File menu and select Save As Template....
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Save from the Project Settings dialog
Click the Save As Default Template... button from any page of the Project Settings dialog.

Copying and pasting

If you want to save packet information to a file, you can make a selection first in the project window (use the Shift
key or the Ctrl key to select multiple items, if applicable), right click and choose a Copy command, then open a file
and paste the selection to it.

There are several kinds of Copy command in Colasoft Capsa:

Command Description

Copy Copies the sleeted item in text format.
Copy Tree Copies all involved items in a tree.

Copy Hex Copies the Hex contents of packet decode.
Copy Text Copies the text contents of packet decode.
Copy Column Copies a specific column in text format.

Copied contents can be pasted to Excel, Word, and other Windows applications.

Importing and exporting

Import from a file

In addition to the files in *.cscpkt (Capsa 5.x and 6.x Packet File) and *.cpf (Capsa 4.0 Packet File) format, you
may also import data from Network Associates Sniffer packet files, EtherPeekv7/ TokenPeek / AiroPeekv9 /
OmniPeekv9 packet files, *.dmp (TCP DUMP) and raw packet files. The Matrix view will blank and the
Conversations view will displayed as Connections view if import a project file or packet file of version 5.5 or before.

Import steps:
Select Import from File... from the File menu.

Specify the file name, file type and open mode in the opened dialog.
Confirm your operation in the enquiry dialog.

A pop-up dialog will inform you when the file is successfully imported.

Import Option

File Inforrnation

Create Time: 2006-01-12 02:23:35 File Size: 1.635 MB
File Format: Colasoft Capsa 5.5 Packet File Packet Count: 4695
Firsk Packet Time:  2006-01-12 10:22:52 Last Packet Time: 2006-01-12 10:23:34
|:| Range
2006-01-12 10:22:52 2006-01-12 10:23:34
B Eimne:
By Mo.:
0B 327 566 KB 655.132 KB 0.960 B 1.280 MB 1.509 MB
By size: ;
Packet Buffer
Packet Buffer Size: 2| Kilobytes
When buffer is full, discard oldest packets {ring buffer) R |
[ < Back ] L Mexk > J [ Firiish ] [ Cancel ] [ Help
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Export to a file

Captured packets and related information can be exported to a file in public formats such as Text and HTML.
Packet list information can be exported from the Packets view, Connections view and Logs view.

Export steps: (take the Packets view as an example)
Highlight the selected packets (use Shift or Ctrl key to select multiple items).

Right click and select Export Packet..., or click the icon ? from the toolbar.

Specify the file type and items in the opened dialog.

Export to File

Select file bvpe:

\CsY)
HTML Files (*.html)

Colasoft Capsa Packet File {*,cscpkk)
Sniffer Packet File (*.cap)
EtherPeckiarioPesk Packet File (wa) (*.pkt)
Raw Packet File {*. rawpkt) b

libpcap{tcpdump, Ethereal,ete. ) (*.cap) =
libm e anibench man Ebharaal abe 4 0% dmed I

< i | )|_

Select items ko export

(3 selected items in list

) allitems in list

< Back L Mext = J [ Cancel ] [ Help

Define the path to save the export file.

Export to File [g|

Save exparted file in:

| Files\Colasoft Capsa 6.3 EE\ExportPacketData, bxb | [ J

[ < Back ]L Mext = J[ Cancel ] ’ Help ]

Check the columns you want to export (only applicable for *.txt, *.csv and *.html format), then finish the export.
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Export to File

Select columns to export:

Mo, -
Date
absolute Time
Delta Time
Relative Time
Source
Destination
Protocol

Size

IF Identifier

| I -

£ I | =
Select all calumns

l

[ < Back. IL Finish J [ Cancel ]

A dialog will inform you when packets have been exported successfully; you can open the file from the dialog
directly.

Export to File

The file “iC:\Program Files\Colasoft Capsa 6.3
EE'ExportPacketData. txt" has been exported successfully,

WWhauld wau like ko apen the file or open the containing Falder?

[ Open File ] [Open Zontainting Folder ] L Zancel J

Printing
You can not print or print preview selected information during the capture process until you stop the program.
When you choose the Print command from the File menu or click the icon from the toolbar, only the visible

listings will be printed. To print selected items, use Shift or Ctrl key to set a print scope. If you would like to print
more columns' information, you must show desired columns first. Colasoft Capsa supports printer printing and
PDF printing, you can use the Print Setup command in the File menu to define printing options.

The information of packet decode or connection details can not be printed directly from tab views, but you can
print from the Packet Decode window or the Connection Details window.
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Statistics

Colasoft Capsa calculates a variety of key statistics in real time, and presents these statistics either as numeric
data or in intuitive graphical displays. You can save, copy and print these statistics, or generate statistic reports.

Summary statistics provide general statistic information of global network or a specific network node, including
traffic, packet size distribution, most common packet sizes, TCP analysis and other statistic information from the
advanced analyzers.

Snapshots are a helpful tool to record the summary data for a future reference.

Endpoints statistics present the details of network activities on every endpoint. You can choose to display all
hierarchical endpoints, or just physical endpoints or IP endpoints.

Protocols statistics present the information of protocols used in network communications. The display structure in
this view is the same as the Protocols group in the Project Explorer.

Graph statistics (unique to enterprise edition) display the statistic information in graphical way. In addition to the
common graphs like error packets, utilization, packet size distribution and packet size details, you can also see
the graphic statistics based on the results from the advanced analyzers.

Reports statistics (unique to enterprise edition) are based on the above statistic information. A report contains
summary statistics, protocol statistics, top 10 physical addresses, top 10 IP addresses, top 10 local IP addresses,
top 10 remote IP addresses, and all available graphs.
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Matrix

Unique to Colasoft Capsa enterprise edition. The Matrix view includes individual tools to customize the display
types of network traffic. This lets you quickly create a picture of all the traffic or sending/receiving traffic. The
nodes around an elongated ellipse display the hosts in your network, the line weight present the volume of traffic
between nodes. The green color reveals the traffic is transmitting current now and the black color displays the
transmission is completed by default. When you drag nodes to a new position, the connecting lines rubber-band.
Colasoft Capsa will popup a notice if the captured nodes exceed 1000.

& samplePacket - Colasoft Capsa [Stopped] =8 FoE )
: Fle Edit View Project Tools Window Help
B = A | . o = F & B & =] L &
© MNew Open Save [ac Forwarg Start Sic Settings Adapter Filter Network Log Diagnosis Name Table Filter Table Options Tools~ B
Explorer R ~"summary | Diagnosis | Endpoints | Protocols | Conversations Matrix | Packets | Logs | Graphs | Reports | 4
© samplepacket (3) Ml ap- O E @ - | Nodes: | 979
g-T‘ Protocol Explorer (3) physical = |
| @-¥ Ethernet 1 (2) =S @r
| @-¥ Ethernat 802.2 (1) )
i — -3 il
© -V Ethernet SNAP (1) Tratflc Type i
5] a5 Physical Explorer (3) Unicast
{ @™~ Local Segment (300) Multicast
1™ Broadcast Addresses (1 Broadcast
T PO P PP SRR
Ll L | *+ Display Options 2
(=] Project Status & x & show All Nodes 1
Packet fiters: No fiters enabled (3] Top 100 Nodes =
Error packets: a O Top 100
Pachsts captured 38713 Conversations
Packets lost o O Top 20% of Nodes
Packets accepted New... -
Packets rejected: 0 %
Buffer usage: 3KB | | User Hidden Nodes(0)
'Y Online Resources 3 ox
- Getting Start =) ,é‘
Invisible Nodes(0)

For Help, press F1

Matrix display options
The matrix view has two sections: matrix list and display pane. You can customize the matrix pictures by setting
the parameters in the matrix list and display pane.

Display List
Matrix Type Provides two types address matrix - Physical address and IP address.
Provides three traffic types — Unicast, Multicast and Broadcast. By default this view
Traffic Type shows the traffic of global network, you can select one or two types to view the
specific traffic.
Display Options Provides three predefined display options types and customizing display options.

The matrix list shows the matrix groups and the title of available matrix for the current node.

Display Options
This pane offers three predefined display options - Show All Nodes, Maximum 100 Nodes and Maximum 100
Conversations. You can also customize your own display options by click the New... button.
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Display Options
Mame: |Maximum 100 Modes |
Max Count: | 100 - |
Order By
Object: |Ncu:|es L¥3 |
value: |T0tal Packets w |
(%) Highest O Lowesk
Lo | [ Cancel

Display Pane
Character Size

er-H- @ @-

Matrix Option

Character Size
Click the dropdown button in the display pane to select a character display size.

Matrix Option
The Matrix Option includes Show Ellipse Border, Max Node Count and Color Setting.

Matrix Option

[ show Ellipse Eorder

Max Mode Count: 1000 -

Color Setting

Ellipse Border: E] Background:
Tilke: Text: E] Active: E]
Highlight: ()

Line:

Bidirectional Traffic:

Cne Way Traffic:

Mode:

Send Packets Only:
Receive Packets Only:
Send and Receive Packets:

Selected:

UL

[ Reset L OF, J[ Cancel

User Hidden Nodes

The User Hidden Nodes pane lists the nodes which have been temporarily hidden. You can hide the nodes you
didn’t interested in currently from the matrix picture.
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IJser Hidden Modes(12)

feeds,china.msn.cam
207 .46,2.37

C.MNSM, COm

ey, colasoft, com
192.168.0.1
192.168.0.28
192.1638.0.66
192.168,0,208
61.139.2.69
rad.msn.com, nsakc, nek
msnbanner, allyes, com
msn. allves.com

The number in the bracket on the header of the User Hidden Nodes pane shows the number of hidden nodes. In
this pane, you can restore the selected nodes to the matrix by right-clicking in the pane and choosing Show
Selected Nodes from the context menu, or restore all the hidden nodes by choosing Show All Nodes. To hide the
nodes, select a node, right-click, choose the Hide command from the context menu, select This Node Only, This
Node and It's Peers and Nodes That are not Peers to This Node from the sub-context menu.

Arrange

Hide r This Mode Only

Make Filker This Mode and Its Peers

Resaolve Mame Modes That are nok Peers to This Mode

Add ko Mame Table

Locate Explorer Mode
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Invisible Nodes

The Invisible Nodes pane lists the nodes which have been temporarily hidden in the matrix because they do not
match the settings in the Display Options pane. The number in the bracket on the header of the Invisible Nodes
pane shows the number of invisible nodes. You cannot restore these nodes unless you choose Show All Nodes
in the Display Options list.

Summary | Diagnosis | Endpoints | Protocols | Conversations” Matrix | Packets | Logs | Graphs | Reports 4b
er- |- @@ @ -  Nodes: | 100/579
1 Physical . .
® p IP Matrix
Traffic Type & [

Unicast

Multicast
Broadcast

Display Options 2

m

& show all Nodes

® Top 100 Nodes

O Top 100
Conversations

O Top 20% of Nodes
New... —

User Hidden Nodes(0)

Invisible Nodes(879)
192,168.0.255(2)
192.168.227.1(1)
192.168.227.255(1)
205.188.179.233(1)
| alb.adtechus.comi1)
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Diagnoses

Colasoft Capsa diagnoses your network from the captured packets and lists all diagnosis events with a severity
level. From the Diagnoses view, you are not only able to see the event count by network layer, but also know
event-related information such as source, destination, packet number, etc. The severity level indicates the event is
an informational message, a minor error or a critical error.

The subviews in the lower section provide more and detailed information of the current row selected from the
upper view, for example, when "Application Layer" is highlighted, the subview Events present all diagnosis
events on the application layer. In addition to the default columns, you can reach more column information by
clicking on the column bar and select "More...". Colasoft Capsa also lets you open a new window to show
event-related packets with double clicks on an event. The subview "References" offer a description for the current
event with possible causes and solutions, which is helpful for troubleshooting your network.

According to the severity levels of diagnosis, Colasoft Capsa contains four kinds of events:

Information

The Information severity level (labeled as ‘4‘") indicates the current event is a normal message, no corrective
action is required.

Notice
The Notice severity level (labeled as 0) indicates the normal but significant conditions of the current event, it
may require special handling.

Warning

The Warning severity level (labeled as .-'_'?5) indicates an error has occurred which requires your attention and
should be addressed soon.

Critical

The Critical severity level (labeled as E‘) indicates the serious error conditions which requires immediate
intervention by administrators.

This chapter provides a list of references information for all diagnosis events, including event description, possible
causes and solutions.

Diagnosis references - application layer
Colasoft Capsa offers expert diagnosis for the following application layer events.
Severity: Notice

Event Description Threshold Possible causes and solutions
The domain name referenced in *The requested domain doesn't
the query does not exist. Information exist.

*User types in an invalid domain.

Domain Name is
Inexistent

DNS Server Slow The average response time from

Response Time the server is highgr than the The web server is overloaded.
Slow Response Time threshold.
The server response to the *Format error
required host or domain is not *Server failure
DNS Error implement. *Refused
*Not Implemented
*Reserved

The average response time from

HTTP Server Slow | the server is equal to or higher LIRS

Response Time than the Slow Response Time T'.m.e 150 LR S e et
milliseconds
threshold.
The average response time from | Slow Response
POl Serve_r =100 the server is equal to or higher Time - 150 The POPS3 server is overloaded.
Response Time : -
than the Slow Response Time milliseconds
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threshold.
The average response time from Slow Response
SMTP Servgr Slow | the server is equal to or hlgher Time - 150 The SMTP server is overloaded.
Response Time than the Slow Response Time s
milliseconds
threshold.
The average response time from
FTP Server Slow the server is equal to or higher LG
. 9 g Time - 150 The SMTP server is overloaded.
Response Time than the Slow Response Time .
milliseconds
threshold.
Severity: Warning
Event Description \ Possible causes and solutions

The failure of a HTTP client’s
authentication request results in the | Check for invalid login username or password.
immediate denial of authentication.
A HTTP 80/TCP connection contains | * An application running on TCP port 80
non-HTTP traffic. produces non-HTTP traffic.

* Verify the traffic content of source station and
destination station.

HTTP Basic Authentication
Failure

HTTP Non-HTTP Traffic

HTTP server returns a 5xx error
HTTP Server Error code to indicate a server error; the
client’s request is usually valid.

A POP3 client fails to log in to a

POP3 Logon Failure Check for invalid login username or password.

server.
A POP3 110/TCP connection * An application running on TCP port 110
contains non-POP3 traffic. produces non-POP3 traffic.

FOLREAN GOl TN * Verify the traffic content of source station and

destination station.

A SMTP client fails to log in to a

SMTP Logon Failure Check for invalid login username or password.

server.
A SMTP 25/TCP connection * An application running on TCP port 25
contains non-SMTP traffic. produces non-SMTP traffic.

LR B L * Verify the traffic content of source station and

destination station.

A SMTP client fails to log in to a

SMTP Logon Failure Check for invalid login username or password.

server.
A SMTP 25/TCP connection * An application running on TCP port 25
contains non-SMTP traffic. produces non-SMTP traffic.

SIS AN * Verify the traffic content of source station and

destination station.

A FTP client fails to log in to a

FTP Logon Failure Check for invalid login username or password.

server.
A FTP control 21/TCP connection * An application running on TCP port 21
ETP Non-FTP Traffic contains non-FTP control traffic. produpes non- F_TP control traffic. _
* Verify the traffic content of source station and
destination station.
FTP Data Connection Ar_l initiated FTP data connection * A firewall blocks the FTP data connection.
fails to be created. * The FTP server does not accept PASV FTP

Failure ;
data connections.

A Telnet client fails to log in to a

Telnet Logon Failure
server.

Check for invalid login username or password.
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Severity: Information

Description Possible causes and solutions

* User types in an invalid Uniform Resource

HTTP Request Not HTTP server returns this error when Location (URL).
Found the requested URL was not found. * The connection to the web server is
broken.

HTTP server returns a 4xx error code
HTTP Client Error other than 404 (Request Not Found)
to indicate a client error.

Severity: Critical

Event Description Possible causes and solutions
A POP3 connection or request is
rejected by a POP3 server after a TCP
POP3 Server Returned connection has already been * The client issues an invalid command.
Error established. * The server is busy.

A SMTP connection or request is
rejected by a SMTP server after a TCP
SMTP Server Returned | connection has already been * The client issues an invalid command.
Error established. * The server is busy.

A FTP connection or request is rejected
by a FTP server after a TCP connection
FTP Server Returned has already been established. * The client issues an invalid command.
Error * The server is busy.

Diagnosis references - transport layer
Colasoft Capsa offers expert diagnosis for the following transport layer events.
Severity: Notice

Event Description Threshold Possible causes and solutions

* A TCP Server resets a client connection
if the client has been idle for too long.

An established TCP * Many older Web browsers use Reset
connection has been reset Connection to shut down their HTTP

TCP Reset Reset Inactive S
by one end of the connections; however, newer browsers

nactive : connection after the Reset connection - 15 are better at complying with the TCP
Connection . . seconds . }
Inactive Connection disconnection procedures. Due to the fact
threshold is reached. that many older browsers are still in use,

TCP Reset Connection events are very
common in many of today's LANS.
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The sender does not
receive an acknowledgment
(ACK) from the receiver,
and therefore retransmits

* The acknowledgment packets are being
transmitted via a slower path.

* The network load is very high.

* The receiver or router is overloaded.

TCP
Retransmission

the packet.
Severity: Warning

Event Description Threshold Possible causes and solutions

A client is attemptin A firewall may be blocking the SYN
TCP Repeated . ) ping packet sent from the client to the

multiple times to establish a
Connect Attempt . server, or ACK packet sent from the

TCP connection. .

server to the client.
A client's initial TCP * A client is requesting a service
. . that the host does not offer.
TCP Connection connection attempt has :
. * There are no more available

Refused been rejected by the target

host resources on the server to accept

) new connections.

The percentage of * The acknowledgment packets are

retransmissions on a Too Many being transmitted via a slower path.
TCP Too Many . . . .
Retransmissions connection is equal to or Retransmissions — * The network load is very high.

higher than the Too Many 10% * The receiver or router is

Retransmissions threshold.

overloaded.

TCP Fast
Retransmission

A TCP sender retransmits a
packet before Fast
Retransmission threshold is
reached.

Fast Retransmission —
150 milliseconds

* The acknowledgment packets are
being transmitted via a slower path.
* The network load is very high.

* The receiver or router is
overloaded.

TCP Invalid Checksum

The checksum of a TCP
header and/or data is in
error. The checksum value
is calculated by the sender
and written to the packet,
and then recalculated from
the received packet by the
receiver. It indicates an
error if the two values are
different.

* There is a faulty device on the
network.

* |f the checksum of all local
packets are showed as invalid, it
may be the checksum offload
feature has been enabled; in this
case, the adapter performs the
cycle-intensive process of
calculating CRC, the Windows
TCP/IP stack does not calculate the
IP and TCP checksums and leaves
them as 0x0000. Colasoft Capsa
collects the copy of each outgoing
packet before it goes to the adapter.
To fix this issue, you need to disable
the adapter's Offload Transmit IP
Checksum and Offload Transmit
TCP Checksum feature in the
advanced setting dialog.

TCP Zero Window Too
Long

The window size of one end
of a TCP connection being
zero is longer than the time
specified by the Zero
Window Time threshold.

Zero Window Time —
500 milliseconds

* The receiver is very busy.

* There are insufficient network
buffers in the receiving station.

* This is an indirect result of an
application program's behavior. For
example, the application may be
waiting for some other events
happening, or the application may
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not be releasing the frame buffer.
* An application is very slow.

TCP Slow ACK

The time a connection has
exceeds the average

connection plus the Slow
ACK Time threshold.

taken to acknowledge data

acknowledgment time of the

milliseconds

Slow ACK Time — 250

* The acknowledgment packets are
being transmitted via a slower path.
* The network load is very high.

* The receiver or router is
overloaded.

TCP Port Scan

A local or remote station is
scanning the network for
opening TCP ports.

Port Scanning is an intrusion
indicator.

UDP Invalid Checksum

The checksum of a UDP
header and/or data is in
error. The checksum value
is calculated by the sender
and written to the packet,
and then recalculated from
the received packet by the
receiver. It indicates an
error if the two values are
different.

There is a faulty device on the
network.

Severity: Information

Description Threshold Possible causes and solutions
* A server drops the connection because of
improperly configured resources or router
problems.
* A user aborts the Web connection due to
An established TCP connection has slow response from a server.
TCP Reset been reget by one end Qf the * Many glder Web browsers use Reset
: connection, this results in an Connection to shut down their HTTP
Connection I S
abnormal termination of the TCP connections; however, newer browsers are
connection. better at complying with the TCP
disconnection procedures. Due to the fact
that many older browsers are still in use,
TCP Reset Connection events are very
common in many of today's LANs.
The TCP window size has been
TCP stuck for three or more consecutive _ _ _ .
Window packets and has dropped below a Window Frozen — | Check the source station for insufficient
percentage of the maximum 50% network application.
Frozen . :
observed window for this
conversation.
The TCP window size has dropped
TCP Low below a percentage of the maximum | Low Window — Check the source station for insufficient
Window observed window for this 10% network application.
conversation.
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Diagnosis references - network layer
Colasoft Capsa offers expert diagnosis for the following network layer events.

Severity: Notice

Event Description \ Possible causes and solutions

IP Time-To-Live An IP packet with a time-to-live field * There is a routing table error somewhere in the

Too Low set to O or 1 indicates that the packet | network.

is about to expire. * The packet is looping.

* The originating IP host transmitted the packet with a
low TTL to begin with.
* Try to locate the source of the original packet.

IP Fragment An IP packet has been fragmented * A fragment has been dropped by a switch or router.

Missing and one of the fragments is missing. * The traffic on the LAN is heavy.

This will usually result in a
retransmission.

IP Zero Broadcast
Address

An IP packet is being sent with the old
IP broadcast address of 0.0.0.0.

* This is an obsolete form of TCP/IP broadcast
address.

* Check the source endpoint for applications that may
be sending this packet.

Severity: Warning

Event
ICMP Destination
Unreachable

Description
A station receives an ICMP destination
unreachable message.

Possible causes and solutions
The destination network does not exist.

ICMP Host Unreachable

A station receives an ICMP host
unreachable message.

The destination host does not exist.

ICMP Net Unreachable

A station receives an ICMP network
unreachable message.

The destination network does not exist.

ICMP Parameter
Problem

A station sends an ICMP message
indicating a parameter problem.

ICMP Port Unreachable

A station receives an ICMP port
unreachable message.

The destination port is not active on the station
that sent the message.

ICMP Redirect for Host

A station receives an ICMP redirect
message with the Code value set to 1
(redirect datagrams for the host).

A router may have sent the message to inform
this station that a better route exists to its
intended destination.

ICMP Redirect for
Network

A station receives an ICMP redirect
message with the Code value set to 0
(redirect datagrams for the network).

A router may have sent the message to inform
this station that a better route exists to its
intended destination.

ICMP Source Quench

A station receives an ICMP source
guench message.

The station that sent the message may be down
or rebooting.

IP Invalid Header
Checksum

The checksum of an IP header is in
error. The checksum value is calculated
by the sender and written to the packet,
and then recalculated from the received
packet by the receiver. It indicates an
error if the two values are different.

There is a faulty device on the network.

IP Duplicate Address

There is more than one MAC Address
associated with the same IP address.

* The newly assigned network address is not
unique in the network and conflicts with the
existing network addresses.

* The dynamically allocated network address is
not proper.

* |f the MAC addresses are routers, this is not a
problem.
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Diagnosis references - data link layer
Colasoft Capsa offers expert diagnosis for the following data link layer events.

Severity: Warning
Event
ARP Too Many

Unrequested
Response

Description

The percentage of unrequested
ARP response of a physical node
is equal to or higher than the
Unrequested Responses
threshold.

Threshold

Unrequested Responses -
50%

Diagnoses

Possible causes and
solutions

Check the source and target
physical node for possible
ARP spoofing.

ARP Request

The number of ARP request

* Sample Time - second

Check the source station for

address via ARP requests.

Storm packets per second exceeds the | * ARP requests/sec - 10 the application that sent the
ARP requests/sec threshold, ARP requests.
indicating that an ARP request
storm has been detected.

ARP Scan A station is scanning the network Check the source station for

the application that performs
the scanning.
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Graphs

Unique to Colasoft Capsa enterprise edition. In addition to the standard statistical views, Colasoft Capsa also
offers instant graphs which allow you to view your network situation in graphic way. You can view graphic
statistics not only for a global network, but also for specific network nodes.

There are multiple graph titles and display options available; this chapter explains how to view graphs, how to
select display options and how to save the graphic data.

Graphing statistics
The graphic data in the Graph view and the statistic information in the Summary view are consistent, you can see
that from the following figures.

Summary rDiagnoses rEndpoints rF‘rotocols rCDnversations rMatrix rF‘ackets Logs | Graphs rReports

Wl s @ @-
Skatistics | Current
Capture
Physical Errors
802.3 Errors
Traffic
[=IPacket Size Distribution Bytes Brwkess Bits Btz Packets
<=H4 24,500 KB 19,500%: 200,704 kb 19.800% J92
65-127 11 677 KB 9.437% 95,656 kKb 9.437% 143
128-255 26717 KB 21.5029% Z218.864 kb 21,502% 170
256-511 Q5183 KE 7.692% 77.968 Kb 7.692% 29
Eiz-1023 19653 KB 15.883% 161,000 kb 15.883% 28
1024-1517 31E671EER 258, 506%: 259,448 Kb 25.506% 22
>=1518 0oe 0, 000%: 0hb 0.000% 1]
TCP Packets

TCP Connections
DMS Analysis
SMTP Analysis
POP3 Analysis
FTP Analysis
HTTP Analysis

Surmmary rD|agnoses rEndpmnts rProtocols rCUnversatlons rMatrlx rPackets Log; Graphs | Reports b
QPacket Size Diskribution = . @ o B b j .@ Value: Cumulated totals -
Errors Packets 2 Packet Size Distribution (Global)

Errars Packets vs
Mormal Packets

Phesical Errors
802,35 Errars

»

General

Ukilization {bitsy
Utilization {percentage)

Packets (Cumulated totals)

Metwork Packets

Broadcast and Multicast

Packet Size Distribution
TCP Analysis x
Email Analysis ¥
FTP Analysis ¥
HTTP Analysis x

M =54 [Hes1zr W12s-255  []256-511
Daiz1023 [l1oz4-1517 [l==1515

Both the Summary view and Graph view offer statistical data about your network. However, the Summary view
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only presents the instant statistical data, whereas in Graph view you can see the historical data in a certain time
span, e.g. last 120 seconds.

Note: By default, Colasoft Capsa only collects the data on intranet nodes continuously, the data collecting on an
Internet node are not initiated until you select it.

Graphs go with the current node, to get global graphs, you must enable no filter and select the project root node in
the Project Explorer dock window.

Graph display options
The Graph view has two sections: graph list and display pane. The graph list shows the graph groups and the title
of available graphs for the current node, different nodes may have different graph groups and titles.

Group ‘ Corresponding ‘ Description
Analyzer
Error Packets | None Contains the graphs presenting the statistics of error packets.
General All analyzers Contains the commonly used statistic graphs.
TCP Analysis | TCP analyzer Contains the graphs presenting the statistics of TCP

connections.
Contains the graphs presenting the statistics of email messages.

Email Analysis | Email analyzer

FTP Analysis FTP analyzer Contains the graphs presenting the statistics of FTP transfers.
HTTP HTTP analyzer Contains the graphs presenting the statistics of HTTP requests.
Analysis

There are a number of icons at the top of the graph display which may vary with the graph title you select from the
graph list, you can use these icons to control the display.

Bar Chart
{Owver Time)

Area Chart Interval Options

{Qwver Time) Gridiine

\ / \

Value Options

= - ol & Inkerval: 1 sec T Walue: Per 1 sec value = E:B E=
Line Chart Fig Charnt / Legend Box
{Owver Time) (Relative Values) 30D View
Bar Chart

(Relative Values)

Colasoft Capsa provides the following chart types:

Type
Line chart (Over Time)

Chart Options

Value Options
Cumulated totals;
Per second;

Per interval value

Interval Options
1 sec; 5 sec;

30 sec; 60 sec;
120 sec; 300 sec;
600 sec; 3600 sec

Area chart (Over Time)

Normal stacked area;

100% stacked area;
Clustered area

Cumulated totals;
Per second;
Per interval value

1 sec; 5 sec;

30 sec; 60 sec;
120 sec; 300 sec;
600 sec; 3600 sec

Bar chart (Over Time)

Side-by-side bar;
Stacked bar;
100% stacked bar;
Clustered bar

Cumulated totals;
Per second;
Per interval value

1 sec; 5 sec;

30 sec; 60 sec;
120 sec; 300 sec;
600 sec; 3600 sec
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Bar chart (Relative Values) Cumulated totals; Average
per second;

Last 1 second;

Last 5 seconds;

Last 30 seconds;

Last 60 seconds;

Last 120 seconds;

Last 300 seconds;

Last 600 seconds;

Last 3600 seconds

Pie chart (Relative Values) Cumulated totals; Average
per second;

Last 1 second; Last 5
seconds;

Last 30 seconds;

Last 60 seconds;

Last 120 seconds;

Last 300 seconds;

Last 600 seconds;

Last 3600 seconds

The interval options you select will affect the data displayed in this view, the following table presents the available
sampling duration of every interval option.

Interval Option | Sampling Duration

1 sec 100 sec
5 sec 500 secs
Clizlozl eels 60 sec 100 mins
3600 sec 100 hours
1 sec 4 mins
2 sec 8 mins
5 sec 20 mins
10 sec 1 hour
30 sec 2 hours
Root Nodes =S 4 hours
120 sec 8 hours
300 sec 1 day
600 sec 2 days
1800 sec 5 days
3600 sec 10 days

In addition to the alterable chart types and options, the appearance of graphs also can be controlled.

Icon \ Usage

3D View Change the graph display from two-dimensional to three-dimensional or
reverse.

Legend Box Toggle or untoggle the display of legends.

Vertical Gridline Show or hide vertical gridline for the graph.

Horizontal Gridline Show or hide horizontal gridline for the graph.
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Highlight an item
The highlight function in the Graphs view let you focus on any item displayed in graphs view. Colasoft Capsa will
highlight the item you interested in when you push your mouse on it.

Packet Size Distribution (Global)

24

18 —

1024-1517
19
2006-10-235 15:19:15

15 —

| YA

Packets (Average per second)

Hl 7 :
Ll | e a2l
¥ g | ! £ F

—ﬁ Ha 1]
IHEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEL ____1i
2006-10-23 151847 2008-10-23 1519:07 2006-10-23 1519:27

Elapsed Time (Interval: 1 second)

10241517

For example, selects the root node in the Project Explorer dock window, choose the Packet Size Distribution
and the 1 sec interval in the Graphs view and push the mouse cursor on the golden item. You will see the below
figure - the items are fades except the golden item and a popup description under the mouse cursor. The
description means there are 19 packets which size 1024-1517 bytes at the 15:19:18, 2006-10-13.
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Compare mode

The compare mode of graphs lets you compare two distinct graphs simultaneously in a view. Click the icon
from the toolbar to split the display into two sections, each section has its own graph groups and display options.
You can select a same graph title and different display value or interval value, or two graph titles with same
display value and interval value.

Qutilization (bits) - (=] o Elg' Bl - Intereal: 1sec + Yalue: Per 1 sec value < le l_ll_
Errors Packets ¥ Utilization (bitS) (GIObﬂ“

General 3
90.000 Kbps

[ Ukilization (hits) |
|kilization {percentage)
Metwork Packets
Broadcast and Multicast
Packet Size Distribution

50.000 Khpz —

30.000 Kbps —

Average per sec

TCP Analysis 0 bps NN NN NN
2006-04-11 1720035 2006-04-11 17:20035 2006-04-11 17:20:35

Elapsed Time (Interval: 1 second)

L

Email Analysis

<«

FTP Analysis

L34

HTTP Analysis . Litilization (bits)

L34

4 packet Size Distribution = =1 ) @IE" Bl - B 75 Interval 1sec  ~ Walue: Per 1 sec value = a

Errors Packets vy & Packet Size Distribution (Global)
General 3
)

Ukilization (bits) a

Itilization {percentage) %

Metwork Packets = E

Broadcast and Multicast >
| Packet Size Distribution | <
TCP Analysis v 2006-04-11 17:21:46 2005-04-11 17:21:46 2006-04-11 17:21:46

Elapsed Time (Interval: 1 second)

Email Analysis y B
FTP Analysis P B ==64 [Hes-127 128255 [ 256-511

Upload and Download 5121023 [l1024-1517 [l ==1518

fhutes) he

Saving graphs

You can save graphs from the Graph view as bmp/gif/jpg/png format. Click the icon @ in the toolbar to open a
Save As dialog, specify the file name and file type, then click Save to confirm. Colasoft Capsa saves one graph
each time, repeat the above operations if you want to save multiple graphs.
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Reports

Unique to Colasoft Capsa enterprise edition. The reports view provides the real time reports of global network or a
specific groups. A report contains the statistic information of summary statistics, diagnosis events, protocol
statistics, top 10 IP protocol, top 10 physical addresses, top 10 IP addresses, top 10 local IP addresses, top 10
remote IP addresses, and all available graphs with the current settings.

To get a HTML report, click the button @ By default, reports are saved at: %My Documents%\Colasoft
Capsa\Reports\Project Name, you can define the save path.

Report of Project 1 ‘* Colasoft Capsa

Summary Statistics
Diagnosis Events

Protocol Statistics

TOP 10 Physical Addresses
TOP 10 IP Addresses

TOP 10 Local IP Addresses
TOP 10 Remote IP Addresses
Graphs

Summary Statistics

Statistics Yalues
Capture Count
Physical Errors Count
802.3 Ervors Count
802,3 Total Errars 1]
202,3 One Collision 1]
202,23 More Collisions L]
02,3 Max Collisions [l
202.3 Deferrals o
Traffic Count
Packet Size Distribution Bytes Packets Avg Utilization Auvg bps  Avgpps
=64 T2.750 KB 1,164 0.002% 1.524 Kbps 2,977
65-127 34,660 KB 456 0.001% F2E,179 bps 1.166
128-255 35.486 KB 198 0.001% T43.485 bps 0.506
2596-511 81.096 KB 224 0.002% 1.69% Kbps 0.573
512-1023 25,230 KB 42 0.001% S28.614bps 0,107
1024-1517 171,389 KB 118 0.004%  3.5%1 Kbps| 0,302
»=1518 0B 0 0.000% 0.000bps 0,000
Most Common Packet Sizes Bytes Packets Awg Utilization Auvgbps  Awgpps
64 Bytas T2.750 KB 1,164 0.002% 1.524 Kbps 2,977
66 Bytas 16.500 KB 256 0.,000% 345,692 bps 0,655
1510 Bytes 156,309 KB 106 0.003% 3,275 Kbps 0,271
TOP 10 IP Addresses
Mame Percentage Inbound Parcentage Cutbound Bytes Packets
T webmaster 56.408% I 39.085% 401,174 KE| 1,300
&) 205202245101 2,020% | 27.999% 126,113 KB 196
€J211.196.154.96 15.653% [ 2.145% 99979 KB 736
T website 2.485% [ [} 4,064% 52, 717TKB 370
) 21119615479 | 2.347% [ T.588%) 42,158 KB 126
€J64.233.189.104 | 2.315% [} 2,399% 24.004 KB 128
J1zro01 0.000% Il 0,000%) 17.875 KB 286
&) 205.202.245,250 1,719% i 1.793% 14,756 KB 58
&) 205.202.214.246| 0.884% [} 2,002% 12,125 KB 40
& ed. 588023 0.823% Il 0.555% 5789 KB 30

Reports options
You can customize the reports by change the settings in the Report Options.

Click the @ button to open the Report Options dialog and change the settings. The Summary Statistics,
Diagnosis Statistics and Protocol Statistics were displayed in table format but the others were displayed in chart
and table formats. Click the Reset button, the settings will be reset to default position.
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Report Options

Surmmary Skatistics

Diagnosis Stakistics

Protocol Statistics
Top IP Protocols

MTop |10 4| Table Otep |10 Chark

Top Physical Addresses

[#] Top Table [Otop |10 Chart

Top IP Addresses
Top Table [ITop 0 Chart

Top Local IP Addresses

Top Table D Top u] Zhatk

Top Remote IF Addreses

Top (100 2| Table CJtop |10 Chatt

L K J[ Cancel ] [ Help J

Statistic reports

In this view, you can get statistic reports of the global network or a specific group. View a group or global statistic
reports by selectlng the corresponding group's name listed in the Project Explorer.

Ed F'rll]El:tE 1 x _rEndpculnts rPrntDcols rCcunversatlons rMatrlx rF‘ackets Logs Grapl}s/Repurts 4k
=§= Pr ...,_____‘_-‘ E_j E @ Project 1'\Report
El ﬁ Physical Explorer (3)

-~ Local Segment (16} Report of Project 1 ‘* Colasoft Capsa
@_—J Gakeways (1)
@B Broadeast Addresses (1} Report generated on: 2006-07-17 14:31:33
,*'fg IF Explorer (3
“  Local Subneks (1) L
Broadcast Addresses (1 B Summary Statistics

[

B Yo Internet Addresses 4y | M Diagnosis Events

B Protocol Statistics

B TOP 10 IP Protocol

B TOP 10 Physical Addresses

i e 1 = WEndpnints rProtDcDIs rCDnversatinns rMatrix rPackets Logs Grapl}s/vllepurls ‘2
® Project 1 (3) 3 -
& % protocol Explorer (1) S1IREE RE| |192.153.D.DI24\Repnrt‘
Ela Physical Explorer (3)
- ® @ Local Segment (16) Report of 192.168.0.0/24
a Gateways (1)
@"' Broadcast Addresses (1
EI ;#‘ IP Explorer (3}
EI@ Local Subnets (1)

Feport generated ont 2006-07-17 14135153

----- 192.165.0.112
----- 192.165.0.124
----- 192, 165.0,206

TOP 10 Local IP Addresses
TOP 10 Remote IP Addresses

E@ 9z 163, B Summary Statistics
[+ LDcaI Host(l B Diagnosis Events
- Broadrastil) | |W Protocol Statistics
_____ o2 | |m TOP 10 1P Protocol
..... 192.16a.0.90 | |™ TOP 10 Physical Addresses
----- 192,168.0,92 M TOP 10 IP Addresses
[ |
[ |
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Filters

The filters in Colasoft Capsa decrease the packets to be analyzed and displayed, enabling you to focus on what
you are really interested in. However, to get a primary impression of your network communications, you'd better
not to set any filters unless you are practiced in using this program.

Colasoft Capsa has two kinds of filters: global filters and project filters.

Global filters

Some commonly used protocols filters are predefined and listed in the Filter Table, which can be applied to the
current project by clicking the Add button and select From Filter Table.... Please note that the modification to
global filters must be made in the Filter Table.

¥ Filter Table

: Rl Edit ‘Window  Help

EESE X P
Default ]

Mame i | Commenkt

? ARPIRARP ARP or RARP packets

? Broadcask Broadrcast Packets

¥ CIFs CIFS Packets

¥ DHCP CHCP packets

F DM DNS packets

? FTP FTP data or control packets

FHTTP HTTP packets

T ICMPv ICMPy4 packets

F IPv4 IPv4 Packets

F Multicast Multicast Packets

¥ MetBIOS MetEIOS Packets

¥ FOP3 POP3 packets

¥ PPPCE PPPoE Packets

¥ SME SME Packets

F SmTP SMTF packets

& TCP TCP packets

¥ LOP LIDP packets

¥ YLAN 502, 1 YLAM 302,10 Packets
For Help, press F1
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Project filters

You can define project filters in the Project Settings - Filter page. The filters defined in this page are only applied
to the current project unless you tick the Set as default settings checkbox. Colasoft Capsa graphically displays
project filters, you can easily accept, reject a filter or change its status. The flexibility of Colasoft Capsa lets you
accept some filters and at the same time reject some others: the packets matching the Accept filters will be
analyzed and the packets matching the Reject filters will be discarded.

Project Settings ﬁ|
| General " Adapter | ? Filter |a% Mebwoark, " & Log || o) Diagnasisl
Adapter
Accept anly
packets MOT
miatching 4
filter .
packsts [@ :EE ket Jm'_
matching any of PRcRELs E -
3 fiters. e :
[@ POP3 hteh |
¢Nnt Match
[@ SMTP Mtch
SMTP packets !
Mot hatch :
!
Presne (oo v
[]5ave as default settings L (0]'4 1 [ Cancel J [ Help J

This chapter describes how to create, modify, and use filters for network analysis, you may also find some
examples which can help you be familiar with filters more quickly.
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Adding a project filter

Click the filter icon ? in the toolbar to open the Project Settings - Filter page, to add a project filter, you can
choose to create a new one or select from the global Filter Table with predefined filters listed.

Add a new filter

Click on the Add button and select New... to enter the filter setting page. The Simple Filter tab lets you quickly
make the most commonly used filters by address, port and/or protocol. For example, if you check the box of
Address filter, select IP address and enter 192.168.6.100 in Address 1, keep Both directions and select IP
address and enter 221.236.12.213 in Address 2, after you confirm your operation and return to the previous page,
you can see the filter you just define listed with a tick indicating that it is accepted. After click Ok to confirm, only
the packets transmitted between 192.168.6.100 and 221.236.12.213 will be analyzed.

The Advanced Filter tab is for you to create more complex filters with a wider range of filter parameters, including
address, port, protocol, packet value, packet size and packet pattern. You need to select a logical rule for a single
filter, the logical rules can be And, Or or Not. See "Advanced filters" for more descriptions.

Add from filter table

Click on the Add button and select From Filter Table... to open a dialog which lists all predefined filters, you can
check one or more filters, before confirm your selection, you need to decide a filter rule: accept or reject the
packets matching filter for analysis.

Add by captured packet

If you want to make a filter on the basis of a captured packet or item, just right click on the item and select Make
Filter.... from the context menu, Colasoft Capsa will fill in the filter automatically. This function is available for the
Diagnoses - Events view, Endpoints view, Protocols view, Packets view, Connections view and Logs view.

New filters can be made at any time and will go into effect immediately.
Make filter by packet

Summary rDiagnnses rEndpoints rProtncnIs rCnyGersat'inns rMatrVPackets Logs | Graphs rReports ]

# OO0 ERRENBEFEE = @

Ma, Absolute Time | Source ;‘EJestinatinn ‘| Size | Protocol | Source Port | Destination Pork
FEZEZ  11:03:5... | 137.227.232. ... 192.168.0.“68... 1,510 | HITE 20 1E10
2EZE3 Ju}

Prrrrel HModify Filter

(]

35285 e : 50
e imple Filter | advanced Filter | 1 L0
2Ezg7 y 2
Filker name: | ilker 1 1 | i : 1
. Filter colar: @ &
2Ezg3 77
e Cammentk: | | ®accept O Reject n
35291 Address Filker 7
BEE3Z Address 1 Address 2 &l
3EZ93 Direction 7
IPv4 address w7 IPv4 address v ﬂ ]
3E5z94 | | i i | | "
|Both directions hd | [
3EZ9E 137.227.232.135 v|@ 192,168.0.68 Vlm u
35296 E'T-‘
25297 u
Port: Filker o
[l Part 1 Fart 2 TR
|Single park v |@ Lirection |Single port w |@
Both directions w
a0 v |@ | | 1510 v |E
Pratocal filker
HTTP Ethernet INIPYTCPIHTTR
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Accepting or rejecting a filter
In Colasoft Capsa you can accept some filters and at the same time reject some others. The packets matching to

the accepted filter will be passed to analyzer and analyzed by Colasoft Capsa, and in reverse if you set the filter as
a rejected filter. To accept or reject a filter, you can:

Decide filter rule when adding/editing filter

Packet Filter, |
Simple: Filker | Advanced Filker |

Filker Marne: |Oﬂ"iCE1 | Filter Colar: E
e R sk
Comment: |F‘acket Filker |<® Accept () Reect >
Address filker e
Address1 Addressz
|IP subniet v | ? Diecticn |F\n3-' address w |@

|Both directions A |

vl@ »

|192.168.2.0/24

Change filter status with the Add/Reject button

Project Settings Z|
| General || Adapter | ? Filter |a% Metwark, " @ Laog || ) Diagnosis|
Adapter Click these buttons to %ﬂ#v[ﬂj
the current filter status "““-.._
Accept only = e
packets NOT
matching 1 Up
fitter.
Diown
-
packets [@ :EE et LEeh
matching any of RACKELS . | -
3 fiters. gt Match :
[@ POP3 hstoh™y
it e = Rilter status: Accept
[@ SHITF Match_i—t""
SMTP packetz !
Nt hiatah :
;
lE_‘j'Trash Biox B Analyzer [m
[]save as default settings ik ] [ Cancel J [ Help J
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Saving, editing and removing a filter

Saving a project filter

When you finish the setting of a filter and confirm, Colasoft Capsa will save the filter and list it in the Project
Settings - Filter page. However, since the projects in Colasoft Capsa are all independent, the filter settings of a
project can not be shared by other projects unless you designate the filter setting as default. With the command
Set as default Settings..., you can save a filter and its settings in the configuration category of system, each time
when you open a new project, you can see the filter listed in the Project Settings - Filter page.

Both simple filters and advanced filters can be set as default.

£

Project Settings

General Adapter | T Filter |a% Metwork " 5 Log || ) Diagnosis|

Adapter
Accept only
packets NOT
matching 1
fiter.
i |
packets [ T :EE ot Match
matching any of PACHELS | :
@ POP3 Match
¢Nut hatch
[ 2 SMTP I Match
SMTP packetz !
Mot hlateh

:
B
'ﬁj rash Box B Analyzer Eport ¥

L [o]4 ][ Cancel J[ Help J

Editing a filter

To edit a filter, double click it from the filter list or use the Edit button. You can make modifications either in the
capture process or when Colasoft Capsa stands by, after confirmation the modifications will be go into effect
instantly.

Note: You are in danger of losing the specified parameters you have already entered as moving from the
Advanced Filter page to the Simple Filter page, you have an opportunity to abort the operation when a warning
appears.

Removing a filter

To delete a filter, make a selection from the filter list and click the Remove button. If you have set the filter as
default, this operation will disable the previous setting.
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Importing and exporting filters

Import filters

Colasoft Capsa lets you import filters from the files in .cscpflt format. Click the Import... button and select Import
Filter from File..., Colasoft Capsa will open the project file and list all available filter files, select one to open.

Project Settings

| ] General | &3 adapter | T Filter |.’1" Network | 55 Log | &4 Diagnosis

I: Adopter Accept
Reject
Import Filter,
Lp
Look in: |E) Projects "| '\) l'_’ 2 '
Ciawun

D [
My Recent | ||[] Port5001. cscpfl
Dacuments ] Traffic.cocpilt

¥ Edit,..

Desklop Remove

ty Documents

o7

Fdp Connpuiter Export  F

-~

File name: |F'acketsize.c:scpf|t V| L Open J el J [ Help ]

ty Network, Files: of type: | Colasoft Capsa Packet Filter File [ cacpflt) v | [ Cancel ]

If you decide to clear the current filter list when asked, only the filters imported will be showed; if you select No, the
filters imported will be appended to the current filter list.

Colasoft Capsa |E|

5\ ? ) Would vou like to clear current: Filker list?

L Yes J[ Mo J[ Zancel ]

Export filters

To export filters, click the Export... button. When export filters, all the items in the filter list will be exported to a file
in .cscflt format, which can be imported later by other projects.
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Simple filters

The Simple Filter page allows you to customize some commonly used filters by address, port and/or protocol in a
single filter. When multiple parameters are chosen they are connected by logical And statements. That is, packets
must match all of the conditions in order to match the filter.

Packet Filter

Simple Filer | advanced Fiker |
Filker Marme: |0fﬁC81 | Filker Calar: E

Comment: |Packet Filter | (@ accept () Reject

Address filker

Addressi Addressz

|IP subnet w | Direction |.0.nv address v | 7
Both directions A4

192.166,2.0/24 v|E] | »

Port Filker

Part1 Partz

|Multiple ports Biestion |.0.nv port v | ?
Bokh directions v

|60;445;1433;3369; v|E] | y

Protocol filker

ICMP Ethernet INIPYICMP
IGMP Etherniet INIPIIGMP Remove

L K ][ Cancel J Help

The simple filters defined can also be seen in the Advanced Filter page as below.

Add Filter X]

Simple Filker | Advanced Filker
Filker narne: |0fﬁCEl | Filker colar: E}

Comment: |Packet Filter| | @ accept (O Reject

*
9 Address
192168.010

ZTandr Sor- Janor (& X |E

=§= Praotacal
Ethernet [NARP

et
[N

L ol ][ Cancel J[ Help J
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Address filter

You can set an address filter by physical address, IP address, IP range and IP subnet. To define an address filter,
check the checkbox of Address filter first, select an address type from the upper combo box of Address1, then

input an address into the lower combo box or select from the name table. Click the E] icon to get references if
you are not familiar with address formats.

The combo box of Direction is for you to specify the send/receive relationship between the two addresses. You
should select Both directions to match all packets going in either direction between address 1 and address 2,
otherwise you could instead match only traffic going from address 1 to address 2, or match only traffic going the
other direction.

Similar as Address1, you must select an address type and enter a valid address in Address2 , or simply choose
Any Address. You can select an address from the name table for both Address1 and Address2 by clicking the
icon. Below is an example of address filter.

Address filker
Addressi

Addressz

|IF‘ subnet - | ? DIFEEH |F\nv address

vl
|Both directions hd @

vlm »

|192.166.2.0/24

Port filter

To define a port filter, check the Port filter checkbox, select a port type and input parameters with correct format
in Port1. Notice that if you select Multiple ports, the ports you enter must be separated with semicolon. Other
settings are similar as the Address filter section.

Below is an example of port filter.
[#] pot Filker

Port1

|Multi|:-le porks

¥

|80;445;

¥

Direction

|Both directions

]

Partz

|Multiple ports

¥(z]

|1433,-3389,-

¥(2]

Protocol filter

To define a protocol filter, check the Protocol filter checkbox, click the Select button to open the Protocol Filter
dialog, find protocols by the first alphabet of the protocol name, then select protocols by checking the
corresponding check box and click OK to confirm your selection. The selected protocols are listed in the pane at
the bottom of the Simple Filter page, you can delete a protocol item from the list with the Remove button.

Below is an example of protocaol filter.

Protacal fileer

Name
1P
1GMP

Fath
Ethernet IPICHP
Ethernet IIP\TGMP

Protocol Filter,

Type:

Hierarchical v

3

5[] 1P (Internet Protocal) N
[ &H (S1PP Authentication Header)
[ EGP (Interriet Exterior Gateway Prakocal)
[ EIGRP {Enhanced Interior Gateway Reuting Pratocal)
[ ESF (SIFF Encapsulated Security Payload)
[ GRE {Generic Routing Encapsulation)
7 [#] TCHP (Internet Control Message Protocal)
[ 1CMPve (Intermet Cortral Messags Fratocol Yersion &)
BRI IGHP (Internet Group Management Protocol)
[] 1RP (Interior Gateway Routing Protocol)
[ 1P (Inkermet Fratocal Yersion &)
#-[] 05PF (Open shortest Path First Routing Protacal)
[ FIM (Protacol Indspendant Multicast)
[ PUP (ierax) Parc Universal Packet)
[ RSP (Resource Reservation Protocol)

8- [7] TCP (Inkernet Transmission Cantrol Protocal)

i o i
I

Wil_

o ][ condd | [ Heb ]

Advanced filters
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In addition to make simple filters by address, port and protocol, you can also choose packet size, packet value and
packet pattern as filter parameters, which are available in the Advanced Filter page. Advanced filters are unique
to Colasoft Capsa enterprise edition.

To create an advanced filter, click the Filter icon ? from the toolbar to open the Project Settings - Filter page.
Click the Advanced Filter tab, you can see a screen with some icons and the text And, Or, Not representing the
rules for settings advanced filters. The filter name, filter color and comment can be customized, if you check the
check box of Set as default, this advanced filter will appear in the filter list each time when you open a new
project.

Add Filter; |£|
Simple Filker | Advanced Filter
Filter name: |PEL'E" | Filter color: E]

Comment; |Packet Filker| | @ accept () Rejeck

Faand v 3o~ |Thnat| (2 X | LB

And

L |
L 1
T Address Size
DD:DQ:BEI:FS:S... M ==1024

o

Or
Not

L el ,H_ Cancel ],_ Help ]

You should specify a rule before adding a new filter item using logical And or logical Or statement; logical Not
statement is for you to not accept the current filter item. The table below provides brief descriptions for these rules
and other commands available in the Advanced Filter page.

Command Description \

Set as default The settings and rules in this filter will be saved, it will appear in the predefined
filter list when you start a new project.

And The logical And statement shows the relationship of these filters is paratactic,
that is, the packet to be captured must meet all these filters.

Or The logical Or statement shows the relationship of these filters is random.

Not All packets except those matching the criteria inside this logical Not filter will now
be passed to the next stage.

Edit Opens the corresponding dialog to modify the parameters involved.

Delete Deletes the selected filter.

Show Icon Shows filter icon for each filter item.

Show Details Shows details of each filter item.

You may define Address filters, Port filters and Protocol filters in either the Simple Filter page or the Advanced
Filter page, but Packet Value filters, Packet Size filters and Packet Pattern filters can only be defined in the
Advanced Filter page. It is allowed to switch between the Simple Filter page and the Advanced Filter page,
however, you are in danger of losing the specified parameters you have already entered as moving from the
Advanced Filter to the Simple Filter page, you have an opportunity to abort the operation when a warning
appears.
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Click the rule And or Or and select a filter item to define, the rule Not is disabled unless you choose an existing
filter item first. The following are some setting examples.

Packet Value filter

Packet Yalue Filter, |X|

Length: | 5
Offset: |12 - ﬂ]
Mask! |III:<FFFF |
Data order: |Netwu:urk byte arder | |
Operatar: |= " |
Yalue bype: |HE>€ e |
Value: |DxDBDE 3
Packet Size filter
Packet Size Filter, |X|
Packet size:
5= v||1024 2 |byte(s)
L Ok J [ Cancel ] [ Help

Packet Pattern filter
You can set packet pattern filters by ASCII, HEX, UTF-8 or UTF-16.

Packet Pattern Filter

Twpe: |HE>¢: L3

Patterm:

00805 3
Match case

Start offsst: |12 -

End offset: |13 ~

L Ok J [ Cancel ] [ Help
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Filter table

By clicking on the button E from the toolbar you can open the Filter Table which offers the most frequently
used protocol filters predefined by system. This table lets you export, edit or delete the listed filter, you may also
import filter from file or add a new filter. The change to this table is global.

= Filter Table =3

¢ Fle Edt window Help
Default }
Mame | Comment
Frce | TCPpackets
FuoP UDP packets
FFP FTFP data or control packets
Fonc Modify Fil
Q?DNS adify Filter,
FHITP ]
*;HTTPS Simple Filter | Advanced Filker | Double click on the filter to edit
TioMe 7
Filker name: Filter color:
T ARF or R | [: :
Q?POP Comment: |TCP packets |
e
Q?SMTP [] address Filer
Q? Telnet Address 1 Address 2
F NetBIOS Physical address ? Riesten Any address ?
FRPC Eioth directions
TP » »
(R HER (7S [CIPort filker
Port 1 Part 2
Single part ? DIEETEm Any pork ?
Bioth directions
» »

Protacol filter

Name Path Select

TCP Ethernet INIPATCP

Remave

L Ok ][ Cancel _H_ Help ]

© 2009 Colasoft. All rights reserved. Colasoft®, the Colasoft logo, Capsa® are among the trademarks or registered trademarks of the company in

the United States and/or other countries. All other trademarks are property of their respective owners. 97197




"\;Colasoft"’ Command Line Parameters

Maximize Network Value

Command Line Parameters

You can invoke Colasoft Capsa or launch the Help documentation using command line parameters. To open the
command line window, you can click the Start menu and select the Run... command, input capsa in the Run
dialog and click OK to confirm.

Then start the command line from the installation category of Colasoft Capsa, e.g. C:\Program Files\ Colasoft
Capsa 6.1 Enterprise.

Command line formats:
Capsa.exe <.cscproj> | <.cscpkt> | <.cpf> | <.cap> | <.pkt> | <.rawpkt> - opens an existing project or packet file.
Example: Capsa.exe C:\Traffic05624.cscproj

Capsa.exe /autostart <.csctemp> - opens an existing template file and start capturing packets.
Example: Capsa.exe/autostart "C:\Documents and Settings\Eva\Desktop\Traffic05624.csctemp”

Capsa.exe /? or /help - displays the Help information for command line.
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CP Reconstruction

Colasoft Capsa can reconstruct TCP conversations. The captured TCP conversations are listed in the
Conversations view, to see the reconstructed contents, you should first select an item from the conversation list,
then push the Stream sub-view tab at the lower section of the display, or double click the selected conversation to
open the Conversation Details window, where you can see more conversation details, including streams and
logs.

When a TCP stream is in plain text format, its contents are readable in the Stream view. Below is some example
stream of a HTTP conversation.

¥, Traffic.cscproj - Conversation Details [192.168.0.28:2905<->67.15.229.1... [= [B)[X]

File Edit ‘Window Help

% Packey/y-@ Stream ]

£- a2 192.168.0.28:2905 <-> 67.15.229.157:80" Packets: | 10

Endpoint 1: IP address = 192.168.0.25, TCP port = 2905 -
Endpoint 2: IP address = 67.15.229.157%, TCP port = &0 B
GET /pub/js/cs menu web.js HTTP/1.1 B
Aocept: /%

Feferer: http://www.colascoft.com

Loecept-Language: en—-us, ch-cn:g=0.5

Loecept-Encoding: gzip, deflate

If-Modified-3ince: Thu, 01 Sep 2005 03:40:55 GHT

If-MNone-Match: "3d406d-b77-43167547"

Tzer—Agent: Mozillafs4.0 (cowmpatikble; MSIE 6.0; Windows NT 5.1; 3Vi:

LWMET CLE 1.1.4322) Alexa Toolbar)

Host: www.colasoft.com

Connection: Keep-ALliwve

Cookie: wisitorid=2489; PageMNumw=3; UserCookie=114:2996495354

HTTPS1.1 200 0OF

Date: Fri, 14 Apr 2006 05:16:52 GHT

Jerver: Apachesz.0.46 (Red Hat)

Last-Modified: Thu, 01 3ep 2005 03:40:55 GHT 7

k.l FEIL P e B PO Lo Y Pl R ]

For Help, press F1

To view a HTTP conversation in its original format, select a HTTP conversation from the Packets sub-view. All
logged HTTP requests are presented in this sub-view, check to Stream sub-view or double click a URL to open it.
A HTTP conversation may contain numbers of URLs, some of them can not be opened, e.g. the URLs ended
with .css and .js.
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Name Table

When you start capture, the nodes in your network will be automatically identified and displayed by their logical or
physical addresses in the Project Explorer and tab views. The Name Table lets you create and edit the alternate
name for physical addresses, IP addresses and ports.

This chapter explains how to assign your own symbolic names to make packet-related information easy for
recognition.

Adding to name table
You can add alias to the name table from the Project Explorer dock window or tab views.

Add from the Project Explorer dock window
Select a node and the Add to Name Table... command from the context menu with a right click, then make alias
and set color in the opened dialog.

Add to Hame Table |§|

Lo |

Twpe: |F‘hysical Address w |

Resolve Address

Physical Address | 00:0B:64:24:F2:i54

Resolve Mame

Alias: | |

]

[ Zancel

Text color; @ [ Help J

Add from tab views

You can make alias in all tab views except the Summary view, Protocols view and Graph view. Highlight a row
and right click, select the Add to Name Table command and a type from the context menu, in the opened dialog
give a new name to the selected item, you may also alter its color. Once you click OK to save the settings all the
packets matching to your selection will be showed with the new name and color.

One packet may involve multiple aliases because you can alter the name for physical addresses, IP addresses
and ports, e.g. officel for source IP and office2 for destination IP.

Surnrary rDiagnDses rEndpDints rPrDt-:ucu:uls rc::unversati-:uns rMatri}/rPackets Logs

# o0 EERGE ¥ = %% 2

Mo, | Absolute Time | Source | Destination | Frotocol |
ZZ  1&:07:07.10FZ354 officel:http officef:1911 HTTP
23 1é:07:07.3386532 officel:http officez:1911 HTTP
Z4 | 16:07:07_ 444758 officeZ:1911 cfficel:http HTTP

25 | 16:07:10.187158  localhost:-1909 localhost?
Z&  1&:07:10.18752Z7 localhost:1520% localhost:

z7 1&:07:10.187662  officeZ:191E wr. colasofy. . |  HTTPS
za lE:D?:lD.ESEESD/fyGEalhDSt:lSDS localhost: 1209 ok
Alias for source IP Aliaz for destination 1P

Name table window
The Name Table window lets you insert, edit, delete or find alias. To open the Name Table window, click the
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Tools menu and select Name Table, or just click the icon E from toolbar. In the Name Table window, you can
view alias for physical addresses, IP addresses and ports.

Export Edit  Select a display type Clear current filter
Import Find Filter parameter

88 Narne Table

/| TCP-UDP Port

3Com-nsd 1742
JCorm-arnpa 629
3com-nek-mgrt 2391
Jcom-tsmux 106
Zrom-webview 2339

3d-nfsd 2323

3ds-Im 1538

3l 1511
3m-image-Im 1550
4-tieropmcli 2934 7

For Help, press F1

This window offers the following commands:

Name \ Hot Key Description

Copy Copies the selection and put it to clipboard.

Insert... Insert Adds a new record to the alias list.

Edit... Edits the name or text color of the selected alias.

Delete Delete Removes the selected record from the alias list.

Select All Selects all alias records.

Find... Ctrl+F Finds an alias item in the list.

Filter Set an alias condition to only display those records matching the filter.
Clear Clear the current filter and display all records.

The alias records in the Name Table window are able to be printed, you may have
a preview by the command in the File menu. To switch between the Name Table window and project windows,
just open the Window menu and make a selection.
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Logs

The logs in Colasoft Capsa can record global or scope-specific network events, containing four types of log
primarily generated by the advanced analyzers: HTTP requests, email messages, FTP transfers, DNS analysis
and four instant messenger activities: MSN activity, AIM activity, ICQ activities, and Yahoo Messenger Activities.
Colasoft Capsa enables all logs by default, you can change each log's settings in the Project Settings - Log page.
If a log is disabled, you will not see the results in the Logs view.

Summary rDiagnDsis rEndpDints rPru:utDcu:uIs rCnnversatiDns rMatrix rPackEt;/wLugs Graphs | Re 1 b
QHTTF‘ Requests - @ ? A E* Ev ﬁ% @
Logs Tirne: | Client | Server | Requested URL | Method | St | Serwvet M

10:33:42  192.168.... | 74.53.47....  httpfweww . umpef... | GET 304 | HTTR{:

@ 10:33:42  192.168.... | 74.53.47....  httpffwesw umpef.., | GET 304 | HTTR{:

10:33:43  192.168.... | 74.53.47....  bttpfwesw, umpef..,  GET 304 | HTTR{:

REZTLILF;I:S 10:38:43  192.168.... | 74.53.47....  bttpeffwesw umpef...  GET 304 | HTTRY:

- 10:45:04  192.168....  192.168.0... htkpeff192.168.0.1...  GET 200  HTTR):
Lé 10:47:53  192.168.... | 218.30.82... http:f/stakt0?. cp.ici... | GET 200 | HTTR{: )
Ernail 10:48:58 192.168.... |rad.msn.c...  httpeffrad.msnico... | GET 200 HTTR{:
Messages 14201 192.168.... msn.cdna.. | bkbpeffmsnoallyves.c.., | GET 200 | HTTR)—

Jile) 1400 192.16&8...,  rad.msn.c,.. | hekpeffrad.msneco,,.,  GET Z00  HTTR:

’:"; 104902 192.168.... | 219.153.5... bttoemsoms.allve,.. | GET 200 | HTTR{:

MﬁN 10:49:10  192.168.... |rad.msn.c...  httpeffrad.msn.co... | GET 200 | HTTR{:

Ackivities 1::53:116  192.168.... | 72.14.255... httpfftoolbar.goo... | GET 200 | HTTR{:
IJ 10:54:38  192.168.... | 218.30.82... httpf/stakb07.cp.ici...  GET 200 | HTTR{:
(_{/:S 10:57:35 192.163.... | 64.215.16... httpffcicg.comfxt...  GET 200 | HTTR{:
AIM 15735 192.168.... | 64.215.16... httpefidf.icg.comfc...  GET Z00 | HTTR|:
Ackivities 157:35  192.168....  64.215.16... httpffc.ico.comi=t...  GET 200  HTTR):
m 10:57:37 192.168.... | 64.215.16... httpf/df.icg.comfc...  GET 200 | HTTR{:
_— 10:57:38  192.168.... | 64.215.16... httpf/df.icg.comfc...  GET 200 | HTTR{:
FTR 10:57:39 | 192,168.... 64.215.16..,  htkpefidf.icg.comfe... | GET 200 | HTTR{:
Transfers | ynezan 192.168..  64.215.16... httpofidficn.comic.. | GET 200 HTTR|:
ﬁ 10:58:09  192.168.... | 64.12.164... httpedichiicg.comfc...  GET 404 | HTTR|:
10:58:14  192.168.... | 207.46.96...  htkpeffconfig.mess...  GET 200  HTTR):
.ﬁ.ci;i%es 10:58:14  192,168,...  131,107.1...  httpoffwew sqmum... | POST 403 HTTRY:
10:58:26  192.168.... | 219.153.4... http:ffimages.zhao...  GET 200 | HTTR{:
@ 10:53:26  192.163.... | 219.153.5... bttpffimages.love... | GET 200 | HTTR{:
15326 192.168.... | 219.153.4... httpeSfmsn bitauko... | GET Z00 | HTTR|:
M;i;ﬂger 105826 192.168....  202.104.2... htkpefimecdn.allve...  GET 200  HTTR):
Ackivities 10:58:26  192.163.... | 202.104.2... httpf/mscdn.allve... | GET 200 | HTTR{:
; 10:58:27  192.168.... | 125.76.23... httpf/public.marry...  GET 200 | HTTR{:

| 10:58:27  192.168.... | 60.28.241... httpffhouse, vnet....  GET 200 HTTF‘,I'ZV

[0 < T B | >.|_

HTTP Requests view - presents the information of captured web accesses. You can open a URL with double
clicks on it or use the Open command from the context menu.

Email Messages view - lists captured emails and such information as client, server, sender name, receiver name,
etc.... To view the reconstructed contents of email, just double click the selection to open it with your email client,
or use the Open command from the context menu.

Note: Captured emails may contain virus, please be cautious when you open an email.

. FTP Transfers view - offers the records of FTP uploads and downloads.

. DNS Analysis view — presents the analysis results of DNS requests and replies.
. MSN Activity view - offers the records of MSN activities

. AIM Activity view - offers the records of AIM activities.
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. ICQ Activity view - offers the records of ICQ activities.
. Yahoo Messenger Activity view - offers the records of Yahoo Messenger activities.

Generating log files
To generate log files, you should first enable the log file feature. Open the Log page by clicking the icon in

the toolbar, select a type on the left, then enable the selected log file on the right. Click the button Q to open the
Log File Settings dialog, where you can name the log file and designate file path. Colasoft Capsa will
automatically generate log files if you check Multiple files and set the parameters; you may also customize the
count of log files saved in your system.

Project Settings |z|

| General || fdapter || “F Filter || A Netwnrkl £ Log |% Diagnnsisl

=-[+] DNS Log B HTTP Log

- +[] WS Conditions Log Buffer Size (KE) 2045

=[] Email Lag Apache Log File {s) Disable Q
- [0 conditions Extended Log File (5) Disable

B FTF Log
S R VN | og File Settings

HTTP Log

[] conditions [¥]save log file to disk
=-[#] M3M Lag

-~ [] Conditions (O single file

=-[¥] &M Log _

[ Conditions File: name:

=-[#] 120 Log

Cwverrite the existing file

: [ <Conditions
=-[+] Yahoo Messenged (%) Mulkiple files

------ Conditions

Save in folder: |C:'|,F‘rogram FilestZalasoft Capsa 6.5 |

L]
(7]

Base file name: |HTTF‘ |

Split file every |1 - | |Day w |

(Jkeep allfiles (%) Keep most recent 15 = | files
[l 5ave as default settings L 8t I [ Cancel ] ’_ Help ] Heln

By clicking the browse button E] and check Save log file to disk, you can select to save all captured email logs
to a single file or multiple files which are split by time or size.

Single file
All packets are saved to a same file.

File name

Specifies a name for the packet file. Click the E] button on the right to open a dialog for defining a save path for
the packet file.

Multiple files
Packets are saved to the files split by time or size. To reduce the total size, you may choose to only keep the most
recent files.

Save in folder

Specifies a folder name and the save path for all files. Click the Q button on the right to open a dialog for
defining a save path for the folder.

Base file name
The portion of a file name to the left of the period separator. Colasoft Capsa allows very long file names. Click the

© 2009 Colasoft. All rights reserved. Colasoft®, the Colasoft logo, Capsa® are among the trademarks or registered trademarks of the company in

the United States and/or other countries. All other trademarks are property of their respective owners. 103/103




,}:Colasoft“

Maximize Network Value

E] button to view a example of the base file name.

Split file every
Chooses a rule for splitting the file if the file size is too big. You can split files by time or file size - months, days,
hours, minutes, KB, MB.

Keep all files
Saves all split files in the defined save path.

Keep most recent
Specifies the number of most recent files for saving.

Log file formats

Colasoft Capsa generates HTTP, email, FTP or DNS log files only when these logs are enabled in the Project
Settings - Log page, where you can designate analysis ports, set filters, select log location or customize other
options. The format of log files is: name%year-%month-%day hour.minute.second.log. For example, a log
generated on August 18th, 2005 09:25:23 AM with the base file name "http" is shown as http2005-08-18
09.25.23.log.

Logs can be saved to a single file or split files. If you select split files, Colasoft Capsa will automatically split log
files by month, day, hour, minute, KB or MB.

File Edit Wiew Faworites Tools  Help

eﬁack - O I_Z% pSearch E—}Fnlders v

Address |E C:\My DocumentsiColasoft Capsallogs V| G

] httpz005-08-16 09.25.230oq  [£] http2005-08-18 09,39, 30.log
] http2005-08-15 09.26.24.0oq  [£] http2005-08-18 09.40,40.log
] httpz005-08-18 09,27, 2600 [Z] http2005-08-18 02,41,46.log
] httpz005-08-15 09.28.2%.00g  [£] http2005-08-15 09,42,47.log
[E] httpz005-08-15 09.29.34.log  [£] http2005-08-15 09.44,06.log
[£] httpz005-08-15 09,3034, log  [£] http2005-08-15 09,45,06.log
[£] httpz005-08-15 09.31,35.log  [£] http2005-08-18 09,46,07.log
E] httpz005-08-16 09.32.35.000  [£] http2005-08-18 09,47, 23.log
] httpz005-08-16 09.33.36.000  [£] http2005-08-18 09,45, 23.log
] http2005-08-15 09.35.14.0oq  [£] http2005-08-18 09,49, 30.log
£] httpz005-08-158 09,36, 14.log

E] httpz005-08-15 09,37.2%.10g

£] httpz005-08-15 09,38,29.10g

File and Folder Tasks ¥

Other Places -

o]

Details

Logs
File Folder

Date Modified: Yesterday,
August 17, 2005, 5:46 PM

< Il ] >
| 707 KE ' My Computer
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Decoding Packets

Colasoft Capsa analyzes and decodes packets and displays detailed packet information in the Packets tab view
and its sub-views. Packet decoding information lets you look through the packets themselves, which is very useful
in troubleshooting your network to track down security vulnerability or learning more knowledge about protocols
and network services.

The following sections introduce the Colasoft Capsa decoders, describe how to read a packet's information and
decode.

Packet decoders

The packet decoders are the essential engines to decode packets. All available decoders are enabled by default,
but you can close those you don't need to increase the program performance.

To open the Options - Decoder page, select Options... from the Tools menu and then press the Decoder tab.
All decoders are listed by protocol and marked with a tick indicating they are enabled, use the check box before

everé decoder to disable it.

| General || £ Formatl L Decoder | R nnalvzer|
Protocol Decoder I
aH Colasaft &H Packet Decoder
ARP Colasoft ARP/RARP Packet Decoder
BOOTP Colasoft BOOTP Packet Decoder =
CIFS Colasoft CIFS Packet Decoder
COPS Colasoft COPS Decoder -
CHZP Caolasoft DHCP Packet Decoder
DNS Colasaft DNS Packet Decoder
2= Calasoft EGP Packet Decoder
ESP Colasoft ESP Packet Decoder
Ethernet 802.2 Colasoft Ethernet Frame Decoder
Ethernet 802.3 Colasoft Ethernet Frame Decoder
Ethernet II Colasoft Ethernet Frame Decoder
Ethernet AP Calasoft Ethernet Frame Decoder
Finger Colasoft Finger Packet Decoder
FTP Ctrl Colasoft FTP Packet Decoder
FTF Data Colasoft FTP Packet Decoder
GRE Colasoft GRE Packet Decoder 3|
— . e e f =
‘ Ok, J [ Cancel J [ Help J

Note: The decoders are applicable to global packet decoding. When you disable a decoder in the Decoders
dialog, Colasoft Capsa will continue not to use that decoder to decode the packets of the same type until you
enable it again.
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Decode view

To view the decode information of the current packet, press the Show Decode icon in the toolbar to open the
decode sub-view, or double click on the packet to open the Packet Decode window.

The packet decode view presents information based on the protocol used in packet transmission, click on the -
minus or + plus signs in the margin to collapse or expand the view of any header section.

SUMMary rDiagnoses rEndpoints rProtocoIs rConversations rMatrVPackets Logs | Graphs rReports ] 4k
f- PR O WG
M, | absolute Time | Source | Destination | Prakocal | Size | Surmmary | 8
1l 17:E5:24.477E93 officeZ:l0z7 192,168 0 2. .. CIF: 178 | Client Reg... b
2 17:25:24.477652 192.162.0.... officeZ:1027 CIFS 97 | Serwver Res._ ..
3| 17:25:24.479693 | office2:1027 |192.168.0.2... |CIFS | 178 |Client Beg. .. |
4 | 17:25:74.420080 192.162.0.... |officeZ:1027 CIFS 97 | Serwver Res_ ..
£ 17:E5:24.6%610F localhost: . .. |localhost:1930  UDRP &d | Bro=1530;D._ ..
&  17:EE5:24.627E12 localhost:... |localhost:1320  UDLP &d | Bro=1520:D...

=% Packet Info:

-] Packet Mumber: 000003
2P Packet Length: 178 =
@ Capture Length: Pﬂckﬂt demdﬂ 174 e |
[ Timestaup: ZO06-01-04 17:25:24_ 479693
=-% Ehtermet - II 107141
----EﬁDestination Addre=s=: O0:ED:4E:10:F9:4C (Banyo Denki) [0s
Eﬁ Zource Address: 00:0B:eA: BA:CF:7A (hsiarock) [&7E]
-@P Protaocal: 0x0800 {Internet IF (IPwd
=% IP - Internet Protocol [14s201]
12l Tersion: 4 [1471] Ox0O0F0
2

-(Z Header Length: 13 (E0 Bytes) [1441]1 0Ox
Differentiated Serwvices Field: aooo oooo [15751] Ox0OO0FF
E Differentiated Services Codepoint: agoo aa. . (Defanlc) [1E/11 00
b o] ECH-Capahle Transport: PR I I [15751] Dx0o0z

The following decode information is added by Colasoft Capsa.

ame De ptio

Packet Number | The packet number which is set automatically by Colasoft Capsa.
Packet Length | The bytes size of this packet.

Capture Length | The bytes size captured by Colasoft Capsa.

Timestamp The actual time when the packet was captured.

The data in the decode view can be copied and pasted to the clipboard.
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HEX and ASCII view

Push the Show Hex icon in the Packets view or Packet Decode window to view the actual packet contents
in Hex on the left and ASCII on the right (by default), or change ASCII decode to EBCDIC by choosing Show
EBCDIC from the context menu with a right click on the Hex view.

The Hex view is graphically linked with the decode view, when you select a portion of packet contents in the
decode view, Colasoft Capsa highlights the selected portion and the corresponding Hex data and ASCII/EBCDIC
data in the Hex view.

Packet decode

\

=% Packet Info:

~{F] Packet Bunher: 044725
&P Packet Length: 1510
#‘Capture Length: 1506
: Timestamp: EOOE-03-18 10:Z3:52. 108324
E—:IT Ethernet IT Header [Os14]
EPDestination Address: 00:0B:6A:1F:1A: 98 isiarack [0/6]
E@Source Addre=ss: O00:80:C8:21:64:D4 D-Link Sys [ESE]
@ Protaocol: Ox0s00 Internet IP (IPwd) [12/Z]
EI?=I IP - Internet Protocol [14720]
% | il ]
o0 08 00 45 00 05 D4 88
ooLs A2 00 44 00 50 OB 65
JozZe 46 DF 00 00 z2 C4 E2
Jozs ZZ 21 1C AR CC 3E Z&
oo4c 41 37 SA 40 47 DE E7

JO5F
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Tools

Colasoft Capsa provides users several useful tools - Colasoft Packet Builder, Colasoft Ping Tool, Colasoft
Mac Address Scanner and Colasoft Packet Player, let users can build packet, ping IP addresses, scan IP and
MAC addresses, replay packet file. Besides these four useful and handy tools, user can also customize to invoke
other applications or tools from Colasoft Capsa, such as the Tracert, Microsoft Office Word 2003, Notepad, and
etc.

Colasoft packet builder

Packet Builder is a tool used for constructing your own custom packets and sending them into the network. You
could use this feature to check your network for protection against attacks and intruders.

There are three ways to invoke Colasoft Packet Builder:
Click the Colasoft Packet Builder command in the Tools menu.

Open the Start button of Windows and choose All Programs. Click the Colasoft Packet Builder from the
Colasoft Capsa application.

Choose the Run... command from the Start button of Windows, input PktBuilder.exe command and click the
Enter key.

You can select one of the provided templates and change the parameters in the decoder editor, hexadecimal
editor and ASCII editor to create a packet. Any changes are immediately displayed in the other two windows.

To custom the layout of the three windows, please click the window header, hold on mouse and move it.

EIEETEE | Packets | 15 | selected 1
Mo, Dielta Time | Source Destir |22 Praotocol Size | Summary |
il 0.000000 | 192,168.0,20,,. | 192.168,0.255:.., MBMNS 96 | O NAME=OFFICE -
2 0.002020  192,168.0.20,,,  192.168,0.255:... MBMS 95 O NAME=OFFICE
3 0,193754  192,168.0,93:,,,  192,168,0,255:,,,  MNBDGM 256 | Transaction Ma
4 1134533 192,168.0.28:.., Z19.133.49.72:.., QO 82 | C:Keep alive(393
5 0.336778 | 219.133.49.7... 192.165.0.28:4... QQ 102 5 Keep alive v
£ il ] )l_
ode Editor | Packet M 1
acket Info: . Ead
" [E] racket Huuber: 000001 —
1 @ DPacket Length: =1} e
H S — - DSOS S T e —
< i | 3
He:: Editar | Total | 92 bytes
Qo0 FF FF FF FF FF FF 00 50 56 40 34 3D 08 00 45 ....... V4=, .E i
OO0F 00 00 4E 00 00 40 00 40 11 B7Y 81 CO 45 00 CE .. N..E.&....... =
O01E CO &3 00 FF 00 &9 00 8% 00 3}&2 1 T 3

Hold on and drag your mouse to the position displayed in the below figure.
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Packets | 15 | Selected | 1 m

i
Ma, Delka Time | Source Diesti Pratacol Size | Summary 5
1 0.000000 | 192.168.0.20.., | 192.168.0.255:... | MBMS 96 | T NAME=OFFICE =
2 0.002020  192.168.0.20.., | 192.168.0.255:... MBMNS 96 | T MAME=OFFICE
3 0193754 192.168.0.93:...  192,168.0,255:,., MNBDGM 256 C: Transaction Ma
4 1134533 192.168.0,28:.., | 219.133.49.72:.,, QO g2 Cikeep alive(393
S 0336778 219133497, | 192,168.0.28:4.,, QO 102 5 Keep alive w
< | i ] ¥
ode Editar | Packetr 1 |
acket Info: & A
" racker Humber: 000001 —
; @ Packet Lencgth: =1
ERG S ¥ S o T e s
£ il | >
He:x Editar |- | Total | 92 brytes
0000 FF FF FF FF FF FF 00 50 56 4002 %02 00 45 ....... PVEd=..E ]
000F 00 00 4E 00 00 40 00 40 11 7 | [ PR N =
001E CO A8 00 FF 00 &% 00 &9 00 L 1 AR A e 2
Then you will see the Packet List window move to the bottom.
Decode Editor | Packet No. | 1 |
=W Packet Info: -
i |[E racker Mumber: 000001 =
#‘ Packet Length: =1}
&P Capture Length: az
i [FHrelta Time: 0.000000 Second ¥
< i | >
Hesx Editar | Total | 92 bytes
Q000 FF FF FF FF FF FF 00 50 56 40 34 3D 08 00 45 ....... PVA4=..E A
OO0F 00 00 4E 00 00 40 00 40 11 BY 81 CO 48 00 CE ..N..E.&....... 3
O01E CO &8 00 FF 00 &9 00 &% 00 34 0O&A C5 02 14 01 ... ..vvieanns i
o020 10 00 01 00 00 00 00 00 00 20 45 50 45 47 45 ......... EFPEGE
003C 47 45 44 45 44 45 46 43 41 43 41 43 41 43 41 GEJEDEFCACACACE bl
Packets | 15 | Selected | 1 |
Mo, Dielta Time | Source Destination Protocol Size | Summary |
1 0.000000 | 192.168.0.20... | 192.1658.0.255:... | MBNS 96 | C: NAME=OFFICE
z 0002020  192,168.0.20.,,  192.168,0.255:... MBNS 96 O NAME=OFFICE
kel [ i ~F | 107 182 N a2 10T 1&9 M S0, L= Tl T} el =1 Te e ki Bl :
2 Ilii
Toolbar

@ # & & b B X | & § 9 F =w H B 0

Import Export = | Add  Insert | Copy Paste Delete | Mowe Up Mowe Down Checksurn  Send Send &l Adapter | About

Button Description

Import Colasoft Capsa supports import files in *.cscpkt, *.cpf, *.dmp, *.pkt and *.rawpkt format. The
current packets will be cleared if you import a packet file.

Export The packets listed in the Packet List and related information can be exported to a file
in .cscpkt format.

Add Creates a packet and it will be listed as the last packet in the Packet List. You can define the
packet type from the five templates provided by Colasoft Capsa and the delta time.

Insert Creates and Inserts a packet into the Packet List and it will be listed after the current packet.

You can also define the packet type from the five templates provided by Colasoft Capsa and
the delta time.

Copy Copies the selected text or items in the three windows. In the Decode Editor, you can copy all
involved items in a tree as a text file and puts it on the clipboard.

Paste Pastes one or more packets in the Packet List window or paste some content in
the Decode Packet window.

Delete Deletes a packet in the Packet List or delete a period Hex/ASCII code in the Hex Editor.

© 2009 Colasoft. All rights reserved. Colasoft®, the Colasoft logo, Capsa® are among the trademarks or registered trademarks of the company in

the United States and/or other countries. All other trademarks are property of their respective owners. 109/109




Maximize Network Value

,};Colasoft“

Move Up Clicks this button to move a packet once towards the first packet in the Packet List.

Move Down Clicks this button to move a packet once towards the last packet in the Packet List.

Checksum Clicks this button if you want Colasoft Packet Builder calculate the checksum automatically
when you editor a packet decode.

Send Sends selected packets to the wire.

Send All Sends all packets in the packet list to the wire.

Adapter Defines an adapter for sending packets to the wire.

About Displays program information, version number and copyright.

Packet list

This Packet List window displays packets and the relative information, allows users to edit the listed packet, such
as copy, paste, delete, add, move up and so on.

| Packets | 15 | Selected | 1 |
M, Delta Time | Source Drestination Protocal Size | Summary ]
1 0.000000 | 192.168.0.20... | 192.166.0.255:... | NEMS 96 | C: MAME=OFFICE <10
2 0002020 192,168.0.20.,,  192,168.0.255:,.. MNENS Q6 | Ci NAME=COFFICE <1D>
3 0.193754  192,168.0,93:,.,  192,165.0,255:,., MNEDGM 256 | Ci Transaction Mame =",
4 1,134533  192,168.0028:,., 219.133.49.72:... Q0 82 | C: Keep alive(393622003)
o 0336778 219,133,497, 192,168.0.28:4.,. QO 102 | 5: Keep alive =
[ 3905421 00;00:88:47:...  FR.FFFF.FRFF...  ARP 64 | Whois 192,168,0,627 T..,
7 0.304263  67.15.229.15...  192.166.0.28:1... HTTPS 64 | Seq=0833105606,8ck=...
g 0.000420  192.168.0.28:... 67.15.229.157:... HTTP3 58  Seq=0073580173,8ck=...
El 1.598414  192,1658.0.28:.,, 192.168.0.208:... TCP 64 | Seq=0623693%60,8ck=...
10 0000026 192, 168.0.28:...  192,168.0.208:,.. TCP 64 | Seq=0843293359,8ck=...
11 0000013 192,168.0.28:,,, 192,168,0,208:,., TCP 64 | Seq=3222455537,8ck=...
12 0.108485  192,168.0,20,,,  192,168.0.28:1,., TCP 64 Seq=1361267039,Ack=...
1 fulalalulutl 10 4 0 103 1 ful 1 T A ek N =i=lrTulul 1

Right-clicks to open the context menu, you will see the available commands in this window. Users can define the
display column and edit packets.

#4  Send Selected Packets, ..
Send All Packets. ..

)

| Colurn [

@ Copy ” Chel+C

[y Paste Chrl+y

> Delete el

gF Add... ChrbN

@ Insert... Chrl+1

2 Mowve Up Chrl+Up Arrow Seurce Physical

-ﬁ Move Down Cerl-+-Down Arrow DEsansisniihiac

Source IP
Select Al Chrl+a

Destination IP

Source Port

Destination Port

Summary

Reset
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Import packets

Colasoft Packet Builder supports *.cscpkt (Capsa 5.x and 6.x Packet File) and *.cpf (Capsa 4.0 Packet File)
format, you may also import data from *.cap (Network Associates Sniffer packet files), *.pkt (EtherPeekv7/
TokenPeek / AiroPeekv9 / OmniPeekv9 packet files), *.dmp (TCP DUMP) and *.rawpkt (raw packet files).
There are two ways to import packets into Packet Builder:

Click the import &3 button in the toolbar or the Import... command from the File menu.
In addition, users can transmit captured packets from Colasoft Capsa application by right-click and choose the
Send to Packet Builder command in the context menu of the Packets view.

Export packets
Users can export packets and relative information to a file in .cscpkt format.

Editing packet

All listed packets and their decode information are editable. Users can create a most poplar packet according to
the template provided by Colasoft Packet Builder conveniently.

Create packet

There are two ways to create a packet - Add and Insert. The difference between these two ways is the new added
packet's position in the Packet List. The new packet will be listed as the last packet in the list if add a packet,
while the insert means the new packet will be listed after the current packet.

Click the add/insert E button to open an Add Packet dialog.

Add Packet

Select Template: EthEer'nEet Packet

Delta time: 100 = | ms

L 0K J[ Cancel J [ Help J

Select Template

To create a packet, you need to specify the packet type by selecting the name from the Select Template combo
box first. The templates contain several kinds of common-used packet - Ethernet Packet, ARP Packet, IP
Packet, TCP Packet and UDP Packet.

Delta Time

Then defines the delta time for the new packet. Delta time means the length of time between the new packet and
the last packet in the Packet List, 100 millisecond in default. If you are inserting a packet, the delta time means
the length of time between the current packet.

Notes: If there are no packets in the Packet List, this feature will not be enabled.

Editor packet

In addition to create packets, Colasoft Packet Builder allows users to edit the decoding information in the two
editors - Decode Editor and Hex Editor. The feature of editing decoding information of packet is unique to
Colasoft Packet Builder, as it is not supported by others packet builder program.
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Decode Editor window
Users can edit the packet decoding information by double clicks the decoding item. The corresponding information
in the Hex Editor window and Packet List window will change with the modification of the decoding. Check the

Checksum @ button in the toolbar if you want system calculates the packet's checksum automatically.

Except the Delta time, Colasoft Capsa provides the changeable decoding groups are different in every kind of

packet.
ARP Packet Ethernet Type Il, Address Resolution Protocol
IP Packet Ethernet Type I, Internet Protocol
TCP Packet Ethernet Type Il, Internet Protocol, Transport Control Protocol
UDP Packet Ethernet Type I, Internet Protocol, User Datagram Protocol

For a TCP packet, the decoding information grouped in the Ethernet Type Il, IP - Internet Protocol and TCP -
Transport Control Protocol are all changeable.

de Editar ) | Packet MNo. | 14 |
Packet Info: Y
-[E racket Muuber: 000014 E|
@ Packet Length: &4 -
_@ Capture Lenotlic &0
Delta Time: Second
iy Packet No. | 14 |
[0/14] ~
2 [075]
e 00:0D:88:47:E8:E4  [6/6] =
< 0x0800 [12/2]
ecode Editor i Packet No. | 14 |
=% IP - Internet Protocol [14/20] ~
) Werziom: 1 [1a/1] OxFO b |
£ | --(E Header Length: £ {Z0 Bytes) [l4/1]
— | b-@ pEE [15/1] OxFF
28 Total Length: 40 {40 Bytes) [16/Z]
ooo 2P Identification: 0x009D {157y [lEs2] e
0oa g3 F: olo. ... {Don't Fragment) 7
001 g Fragment 0ffsat: o [20/2] OxLFFF
----- @ Time To Liwe: 128 122711 B
s B L @ Protocol] ' Packet Mo. | 14 |
& Checksunl 2o pry Transport Control Protocol [34/20] ~
SD“’“?E I g Source Port: 5001 (54,21 |
EAgbestanat &P Destination Port: 1145 [36/2]
@ No TP 0p P Secuence Humber: B [3844]
=T ICP - Trams - Aok Nuuber: 548233358 14z/41
L - TCP Offset: 5 [46/1] D0xFO
Flags: -.01 oooo [47/1] Ox3F
Urgent pointer: G R [47/71] Oxz0
Loknowledgment number: AL AL e [47/1] 0O=xl0
Push Function: AR T § T [47/71] 0x0s
Beset the conhection: I ] i ) [47/1] 0O=x04
Svnchronize sequence: FRRR T 1 [47/71] 0x0z E
L@ End of data: s i) [47/11 0x0l F
2P Window: 18771 [48/2]
&0 Checksumn: OxEEEL (Correct) [50/2] = |
-2 Urgent point: il [52/%]
-5 Wo TCP Option [54/0] 3
N . e, =
< 1l | >l

Notes: Colasoft Capsa will validate the entries in the editor. It will popup a window to inform you if the entry is
incorrect and undo the modification. You may save the incorrect entry with the click the Esc key if you confirm the
entries, though.
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Colasoft Packet Builder |g|

' E Please input a valid value,

In addition, users can execute other operations, such as copy all involved items in a tree, expand/collapse content
and so on, by right-click and choose the command from the context menu.

[ Edi
[ Copy

Copy Tree
Expand All
Collapse Al
Select Al

|#] Refresh  FS

Hex Editor window

The Hex editor displays the actual packet contents in raw hexadecimal on the left and its ASCII equivalent on the
right. For you convenience, both the Hex and ASCII are changeable. The Hex used for modifying the hexadecimal

code while the ASCII used for changing the packet text.

Sending packet

In addition to build packet, Colasoft Packet Builder supports sending packet too. This feature allows users to
define many parameters than the Send Packet feature in the Packets view, such as define the interval between

every packet and the delay between loops.

mn
Click the send E# button to open the Send Packet dialog.

Send Packet

Opkions

[ Burst Made (no delay between packets)
[JLoop Sending: loops (zero For infinite loop)

Delay Between Loops: milliseconds

Sending Information

Tatal Packets: 1*%1=1
Packets Sent: a
Progress: [ ]

Stop L Close J [ Help

J
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Adapter

Users can define a adapter for sending packet from if there are more than one adapters in the PC. Clicks the
"Select" button on the right of "Adapter:" to open the Select Adapter dialog, chooses an adapter from the combo
box. The window under the combo box will display the detailed information of the selected adapter.

Select Adapter

Adapter: =1 1515 900-Based PCI Fast Ethernet Adapter

Physical Address:  00:0B:6A:54:CF: 7A(G02.3)

Link Speed: 100.0 Mbps
Mazx Frame Size: 1500 bytes
1P Address: 192,168,0,28/255,255,255.0

Defaulk Gateway:  192,168.0.1 (00:D0:41:26:3F:9E)
Adapter Status: Cperational

L oK, J [ Cancel ] [ Help ]

Bust Mode
Check this option, Colasoft Packet Builder will send packets one after another without intermission. If you want to
send packet as the original delta time, please do not check this option.

Loop Sending
Defines the repeated times of the sending execution, one time in default. Please enter zero if you want to keep
sending packets until pause or stop it manually.

Delay Between Loops
Appoints the interval between every loop if you defined the loop times more than one. Colasoft Packet Builder will
send without interval between every loop in default.

Total Packets
Displays the number of sending packets. For example, 4*5 means four packets are selected and each one will be
sent five times. So Colasoft Packet Builder totally sent out 20 packets.

Packets Sent
Shows the number of packets have been sent successfully. Colasoft Packet Builder will display the the packets
sent unsuccessfully too if there is a packet did not sent out.

Process

The process bar simply presents an overview of the sending process you are engaged in at the moment.
The Stop button will enable after start sending, let you can pause/stop the execution. You can modify the
parameters after click the Stop button and then continue to send packets as the new settings.
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Send Packet

Options

Adapter:  SiS 900-Based PCI Fast Ethernet Adapter

[ Burst Made (no delay between packets)

[JLoop sending: loops (zero Faor infinite loop)
Delay Between Loops: milliseconds

Sending Information

Total Packets: 4*5 =20

Packets Sent: 1

Progress: mn ]
Skart [ Stop ] [ Close ] I_ Help ]

After sending packets complete, the Start button will be enabled while the Stop

button will be disabled.
Send Selected Packets

Options

Adapter:  SiS 900-Based PCI Fast Ethernet Adapter

[]Burst Made (no delay between packets)

Loop Sending: loops {zero For infinite loop)

Delay Between Loops: milliseconds

Sending Information

Total Packets: 4% 5 =20
Packets Sent: 20
Progress:

’IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII

sop |

Close ] [ Help ]
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Colasoft packet player
Colasoft Packet Player is a replayer tool which allows you to replay packet files in .cscpkt.

There are three ways to invoke Colasoft Packet Player:
Click the Colasoft Packet Player command in the Tools menu.

Open the Start button of Windows and choose All Programs. Click the Colasoft Packet Player from the Colasoft
Capsa application.

Choose the Run... command from the Start button of Windows, input PktPlayer.exe command and click the
Enter key.

%= Colasoft Packet Player

Adapter: | Si5 900-Based PCI Fast Ethernet Adapter hd | B
Packet File: || w | E
Opkions

[ Burst Mode (no delay between packets)

[]Loop Sending: loops (zero For infinite loop)
Delay Between Loops: | 1000 milliseconds

Sending Information

Total Packets:  Please specify a packet File.
Packets Sent: 0

Shakus: Please select a adapter and a packet file, Click Play button to start,

Progress: ’ ]

Skop [ Close ] [ Help ]
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Adapter

Users can define a adapter for sending packet from if there are more than one adapters in the PC. Clicks the
"Select" button on the right of "Adapter:" to open the Select Adapter dialog, chooses an adapter from the combo
box. The window under the combo box will display the detailed information of the selected adapter.

Select Adapter

Adapter: =1 1515 900-Based PCI Fast Ethernet Adapter

Physical Address:  00:0B:6A:54:CF: 7A(G02.3)

Link Speed: 100.0 Mbps
Mazx Frame Size: 1500 bytes
1P Address: 192,168,0,28/255,255,255.0

Defaulk Gateway:  192,168.0.1 (00:D0:41:26:3F:9E)
Adapter Status: Cperational

L oK, J [ Cancel ] [ Help ]

Packet File
Defines the packet file you want to send. Packet player supports Colasoft Capsa Packet File (.cscpkt) and Raw

Packet File (.rawpkt) formats now, you can select a packet file by clicking the E] button. Users also can replay a
packet file have been sent out before from the combo box.

Bust Mode
Checks this option, Colasoft Packet Builder will send packets one after another without intermission. If you want to
send packet as the original delta time, please do not check this option.

Loop Sending
Defines the repeated times of the sending execution, one time in default. Please enter zero if you want to keep
sending packets until pause or stop it manually.

Delay Between Loops
Appoints the interval between every loop if you defined the loop times more than one. Colasoft Packet Builder will
send without interval between every loop in default.

Total Packets
Displays the number of sending packets.

Packets Sent
Shows the number of packets have been sent successfully. Colasoft Packet Builder will display the the packets
sent unsuccessfully too if there is a packet did not sent out.

Progress
The process bar simply presents an overview of the sending process you are engaged in at the moment.
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Replay packet

Sets the parameters as the below figure. It means the HTTP.cscpkt packet file will be replayed five times from the
SIS 900-Based PCI Fast Ethernet Adapter, five hundred milliseconds delay between every loop, and the packets
will be replayed without delay in one loop . The Total Packets: 14*5=70 means that there are fourteen packets in
the selected packet file, every packet will be replayed five times and seventy packets will be replayed totally.

%= Colasoft Packet Player

Adapter: | B 5is 900-Based PCI Fast Ethernet Adapter
Packet File: |D:'|,Capsa|5'|,HTTP.cscka:
Opkions

Burst Mode {no delay between packsts)
Laop Sending: loops (zero For infinite loop)

Delay Between Loops: rilliseconds

Sending Information

Taotal Packets: 14 *5=70
Packets Sent: 0

Stakus: Packet file playback stopped.

Progress: ’ ]

Skop [ Close ] [ Help ]

Then, click the Play button to start replay. After the replay is complete, the Packets Sent will change into 70 (see
the below figure).

¥4 Colasoft Packet Player

Adapker: | 5i5 900-Based PCI Fast Ethernet Adapter R | E
Packet File: |D:'|,Capsa6'|,HTTP.cscpkt “ | B
Opkions

Burst Mode (no delay between packets)

Loop Sending: loops (zera For infinite loop)

Delay Between Loops:  |500 : miliseconds

Sending Information

Total Packets:  14%5=70
Packets Sent: 70

Status: Packet file playback stopped.

Progress: l ]

Stop [ Close ] [ Help ]
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Colasoft MAC scanner

Colasoft MAC Scanner is a scan tool using to scan IP address and Mac address. It can automatically detect the all
subnets of the NICs installed on the machine and scan the MAC addresses and IP addresses of defined subnets
as your need.

There are three ways to invoke Colasoft MAC Address Scanner:
Click the Colasoft MAC Scanner command in the Tools menu.

Open the Start button of Windows and choose All Programs. Click the Colasoft MAC Scanner from the Colasoft
Capsa application.

Choose the Run... command from the Start button of Windows, input Cmac.exe command and click the Enter
key.

™ Colasoft MAC Scanner

File Edit Wiew Scan  Help
‘ Ib x @ Local Subnet 192.168.0.0 - o o o {ﬁ]
Export &l Export Selected | Copy  Delete  Find Stark Pause  Stop | Setting
P MAC Address Host Mame IManufacturer
&l I | lll
MAC Address Scanner ,:EI
In the toolbar, there are some quick button let you can custom the type of graph.
Button Description
Export All Exports the whole scan results to a *.txt and *.csv file.
Export Selected | Exports the selected item(s) of the scan results to a *.txt and *.csv file.
Copy Copies the selected item(s) and puts it on the clipboard.
Delete Deletes the selected IP addresses from the results list.
Find Finds a specific item in the san results.
Start Start to scan a network.
Pause Pause the scan operation for a while.
Stop Stop the scan operation.
Settings Defines the subsequent threads.
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Scan network

Choose a subnet from the Local Subnet combo box and click the Start button or F5 to execute scan. Colasoft
Capsa will display the scanned results, including IP address, MAC address, Host Name and Manufacture in the
list. It will group all IP addresses according to MAC address if a MAC address configured multiple IP addresses.
The scanned results can be exported into .txt file for future reference.

W Colasoft MAC Scanner,

Eile Edit Yew 3Scan  Help
@ lb x @ Local Subnet 192,165.0.0 - 0

Export Al Export Selected | Copy Delete  Find Stark <

IF MaC Address Host Mame rManufackur ey |
9 192,168,060 Beosm mr = 60.0,168,192.in-addr .arpa

a 192,168.0.208 EPw o e enie 208.0,168,192.in-addr.arpa - D-Link

a 192.168.0.212 EFw m ek or s 212.0.168.192.in-addr.atpa Asiarock

a 192.168.0.838 Epwe e aa m 55.0.168.192.in-addr.arpa Realtek Semi

a 192,168,0,89 oo »m e 59.0,168,192.in-addr . arpa IEM

a 192,168.0,61 Eww e oo w LIME-TESTP W are

a 192,168.0.211 EPw ek or % 211.0,168. 192 in-addr.arpa Asiarock

a 192, 1658.0.210 | e 210.0.168.192.in-addr.arpa D-Link

a 192,165.0.205 205.0.168.192.in-addr.arpa

= EPow s % w0 x . YW are

ﬂ 192,168,0,206 206.0,168,192.in-addr . arpa

a 192,168,0,249 249.0,168,192.in-addr . arpa

9 192,165.0.248 248.0,168, 192 in-addr. arpa )

= HPw o ea jor; % - Asiarock

j 192,168.0.250 250.0,168, 192, in-addr. arpa

a 192.165.0.243 243.0.168.192.in-addr.arpa =
a 192,168,0,207 EFm w0 % w0 o 207.0,168,192.in-addr.arpa YMWare

a 192,168,0.242 DEVELOP

9 192,168.0,245 EPw ek or s 245.0,168.192.in-addr.arpa Asiarock

i 192.168,0.244 DEVELOP =]
MAC Address Scanner Found 39 hosts, _:;I

Users can custom own scan process by clicking the Setting button to open the Setting dialog.

General
Scan threads number: 100
L Ok, J [ Cancel ] [ Help ]

You can custom the subsequent threads, range from 1 to 100. It will take more time to finish the scan operation if
the subsequent thread is more less.

1 - Colasoft MAC Scanner will scan all address one after another.

10 - Colasoft MAC Scanner will generate 10 threads.
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Colasoft ping tool

Colasoft Ping Tool is a handy ping utility for users.
There are four ways to invoke Colasoft Ping Tool:

Click the Colasoft Ping Tool command in the Tools menu.

Select a packet in the Packets view or a node in the Project Explorer, right-click and choose the Ping command
from the context menu (if applicable).

Open the Start button of Windows and choose All Programs. Click the Colasoft Ping Tool from the Colasoft
Capsa application.

Choose the Run... command from the Start button of Windows, input Cping.exe command and click the Enter
key.

2" Colasoft Ping Tool

File Edit Chart Options  Help
Legend box = {(tart Fing

o [ s

s!ave \ G\ﬁ&JN

3D view Chart types

Ready CAP NUM  SCRL -l

In the toolbar, there are some quick button let you can custom the type of graph.

Button Description

Save Saves the graph to a *.bmp file.

3D view Shows the graph in three-dimensional view.

Legend box | Shows or hides the explanation of the colors appearing on the graph.

Gridline Shows or hides the gridlines on the graph.

Chart types | The chart types which are available for the current node and the selected graph title.

Enter an IP address and click the Start G button, stop the execution after a while.

2= www.colasoft.com - Colasoft Ping Tool

File Edit Chart Options Help

vy, colasoft,.cam - °Start Ping

a [F[E[L ][] &

. sy colasoft.com

sponse Timef(l
[ £ o
o o =
o o o
o o =
o o o
—

‘ ‘ ‘Scroﬂ' bar

R T T
2008-10-25 13:16:52 2006-10-25 131702 2%08-1 0-25131712
Cals A o

Auto Sci

@ |E +— Copy All Copy —+ @ www.colasoft.com
www.colasoft.com TimeStamp pjspfay Status | Bytes Rime TIL |~
Copye &7.15.229.157 2006-9-25 13:17:05 | Success 64 438 50
-2 Location:United States Z2006-9-25 1317:06 | Success 64 437 S0

12 Packets Senti49 2006-9-25 13:17:08  Success 64 439 =)
() Packets Received:44 2006-9-25 13:17:09  Success 64 435 =)
12 Packets Loski5(10% loss) 2006-9-25 13:17:11 Success &4 444 =)
2006-9-25 13:17:12 | Success 64 440 =)

12 Respanse time Minimum: 433ms 2006-3-25 13:17:14 | Success 64 533 50

@ Response time Maximum:S60ms || 200e.0.55 13:17:16 | Success | 64 | 443 |50 | =
(2 Responsetime Average:llms || 2006-0-25 13:17:17 | Success | 64 448 50 ¥
Ready cap_numM_ ScRL i
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There are three windows in the interface.

Graphic window

The upper window reveals every ping command in graphic way, used for viewing the secular trend in Ping time.
The X axes indicates the Ping real time, the Y axes reveals the Ping response time in ms. Moves the scroll bar in
the graph to view historical graph.

Ping - Summary
The Ping - Summary window lists all required IP addresses or domain names with its summary, such as IP
address, location, packets Sent/received/lost and response time.

Ping - Details

The Ping - Details window displays the details information of ping execution. When you select an IP address or a
domain in the Ping - Summary window, the Ping - Details window will display the corresponding results. There are
two kinds of display type classical and list. The classical view is same to the output of windows ping. While, the list
view used the display format of Colasoft own, such as TimeStamp (in second), Status, Bytes, ResponseTime (in
millisecond) and TTL. ResponseTime is the real time of local host receives the destination response.

The buttons in the Ping - Summary and Ping - Details window:

Button Description

Copy Copies the selected domain's summary information and puts it on the
clipboard.

Copy All Copies the all domains' summary information and puts it on the clipboard, if
ping more than one address.

Copy Copies the selected item in the details window and puts it on the clipboard.

Select All Select all items listed in the details window.
Auto Scroll | The details list will display the newest packet always if check this button.
Display Shows the details in classical view, Windows display type, or list view.

For a clear view, please move your mouse cursor to the graph. Colasoft Ping tool will highlight the specific node
and node border upon it. An annotation will automatically popup which contains the domain name and response
time. The response time in the annotation will be a range of time when your mouse cursor puts on the grid, while it
will be a time if your mouse cursor puts on the grid line.

& (o] B [k & wp

. vy colasoftcom

~= E00.00 rd

E bl T I T

= S S 2

a I

I 1 wiraw, colasaft, cam

H =200.00 464,00 - 438,00

.
000 | T T T T T T T T T L T T T T T T T T T T T T T T T LT L1 T [}
2006-10-25 131652 2006-10-2513:17:02 2006-10-23 131712
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Ping multiple addresses/domains

Colasoft Ping tool allows you to ping multiple IP addresses and domain names at one time without upper limit of
the addresses' number. Enters IP addresses and domain name into the address pane, separate each other with a

blank space, comma or semicolon, then clicks the Start 0 Ping button to execute ping command.

For example, ping 67.15.299.157 and www.download.com. For a clear view of the graph of 67.15.299.157,
highlight the item of 67.15.229.157 with move your mouse cursor on it.

&® 67.15.229.157 www. download.com - Colasoft Ping Tool

File Edit Chart Cptions Help
67.15.229,157,www download.com - OStart Ping
a (B[ B[] [k & ug
W7 15229157
£ 90000
E
(= 60000 -
]
5 £7.15.229.157
2 507.00 - 403.00
- 0.00 MT T T T T T T T T T T T T T T T T T T T T T T T A T T T T A T T T T T T TP (] | e 7T
2006-10-25 14:52:37 2006-10-25 14:52:47
ERE 67.15.229.157
' 67.15.229.157 A || Timestamp | status | Bytes | RTme [ TTL |~
12 67.15.228.157 2006-9-25 14:53:01 | Success | &4 379 43
1= Location:United States _ ||| 2006-9-25 14:53:02 | Success 64 37z 43
1Z) Packets Senk:212 b Z006-9-25 14:53:04  Success & 518 40
(5 Packets Received: 135 2005-9-25 14:53:05 | Success o4 529 42
{3 Parkets Lost:24(11% lass) Z006-9-25 14:53:07  Success | 64 444 49
o e 2006-9-25 14:53:09  Success | 64 617 40
p ’ it 2006-9-25 14:53:09  Success | 64 606 439
12 Respanse time Maximum:670ms 2006-9-25 14:53:11 | Suceess | 64 513 43
(2 Response time Average:394ms 2005-9-25 14:53:13 | Success | B4 406 49 |
" www.download.com o] ~
Ready AP NUM SCRL _:gl

To view the details of www.download.com, select the domain name in the Ping - Summary window and move
mouse to its graph. The Ping - Details window will display the corresponding information.

—__' 67.15.229.157 www.download.com - Colasoft Ping Tool

Eile Edit Chart Options Help
67.15.229,157 www, download. com - ostart Fing
al [F]E[L] ko] & ug
. sy clovenilioscd com
E 900.00
E
= H R r 4
= B00.00 o g A AP
@ P VL S
@ — vy, download, com
£ 30000 J £09.00 - 609,00 I
o
] v, 7
000 | FTT T T T T T T T T T T IT T TTTT T T T T T ITTTITT T 1] e T TJ
2006-10-25 14:52:57 2006-10-25 14:52:47
@ E E www.download.com
D) 67.15.229.157 # || [205] bytes = 56 bime = 625ms TTL = 238 o
2 Location:United States 1| [208] b.\y'tes = 56 kime = 659ms TTL = 233 D |
© Packets Sent:212 [207] TimeCut.
5 Packsts Received: 158 | | [208] bytes = 56 time = 614ms TTL = 238
= i ) oy || [209] bytes = 56 time = 615ms TTL = 238
/D Packets Lost:24({11% loss) [210] bytes = 56 time = 615ms TTL = 236
2 Response time Minimum: 364ms [211] byybes = 56 Hime = 724ms TTL = 238
-[Z] Response time Maximum:670ms [21Z2] TimeCut,
“[Z) Response time Average:394ms [213] bytes = 56 time = 690ms TTL = 233
9 www.download.com [214] TirmeOut. =)
D 216.233,122,235 ||| [215] TimeOut. ~If
Ready AP NUM  SCRL J
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Options
Users can custom own parameters of the Ping command. Click the Options... command in the Options menu to
open the dialog and modify the listed parameters.

The below figure is the parameter settings in default.

Options |§|
Packet Size 64 Bvtes
HaEF
-
Packet Time-To-Live 255
g
Ping Timeouk 500 miliseconds
1)
Delay Between PINGs 1500 milliseconds
-
=]
Address kransmitted 3 times pre Host
-
-
Pall Inkerval 500 miliseconds
-
-
Load Default L 8 i [ Canicel J [ Help

Packet Size
Sets the size of ICMP packet when execute Ping command. The packet size range from 1 to 1024 bytes.

Packet Time-To-Live
Indicates how many more hops this packet should be allowed to make before being discarded or returned, range
from 1 to 255.

Ping Timeout
The amount of time to allow for a response from the peer equipment, range from 100 to 2000 millisecond.

Delay Between PINGs
The interval time between two pings, range from 100 to 10000 millisecond.

Address transmitted
The amount of host or domain resolution, range from 1 to 5.

Poll Interval
The refresh interval of graph, range from 100 to 5000.

Load Default
Clicks this button to reset all parameters to default position.
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External tools

In addition to the four tools referred previous, users can customize to add other Windows applications and tools
into Colasoft Capsa with the External Tools. You can not only invoke but also execute the added applications
and tools via Colasoft Capsa.

The following figure is the tools menu in default.

Tools

&5 Mame Table
&4 Filer Table

Packet Capture Drivers. ..
MAC Address Scanner
Packet Builder

Packet Player

Ping

External Toals...

i_gfi] Cptions. ..

Click the External tools... command from the Tools menu to open the External Tools dialog page. The following
is an example of how to add the Tracert command of Windows into Colasoft Capsa.

Click the New... button to enable the Property dialog box.

Name the tool as Tracert.

Enter the path of the program C:\WINDOWS\system32\tracert.exe or click the E] button to choose the path.
Add the parameter $(IP) into Arguments.

External Tools

Packet Player MNew
Packet Builder
MAC Address Scanner
CPing

Tracert

Moeee Diown

Properky
Title: |Tracert |
Command; |C:'\WINDOWS'l,systemSZ'l,tracert.exe | E

Arguments: |$(IP) |

Command Line:

CHAWINDOW S, system32 tracert, exe

[ QK ][ Cancel J[ Apply J [ Help ]

© 2009 Colasoft. All rights reserved. Colasoft®, the Colasoft logo, Capsa® are among the trademarks or registered trademarks of the company in

the United States and/or other countries. All other trademarks are property of their respective owners. 1257125




,}:Colasoft”

Maximize Network Value

Click the E] button to open the Arguments dialog.

Arguments |X|

= e

Click the Macros >> button to view the details.

Arguments lg|

Mame Descripkion
$(PHY) Single Physical
${MPHY) Ml Pheysical
$(IPY Single IP
$EMIPY Multi TP
$PCRTY Single Port
FMPORT) Ik Port
${PROY Single Protacol
${MPRCO) Multi Protocol

‘ Macros << J [ Insert J [ CE ] [ Cancel J

Colasoft Capsa lists the parameters IP Address, Physical Address, Port and Protocol in the window. You can
add a parameter by selecting it's name and clicking the Insert button. If the parameters did not listed, you can
enter the parameters into the upper window manually, like as -d, -h, -j and -w in Tracert command. Every
parameter should be separated with a blank space

1. Choose the IP Address and click Insert button. Click the OK button to save the settings and back to the
External Tools dialog.

2. Click the Tracert command in the Tools menu to execute the program.

Tools | Window  Help
&2 Namne Table
&4 Filer Table

Packet Capture Drivers...
MaC Address Scanner
Packet Builder

Packet Plaver

Ping

| Tracerk

[~
External Toals, H\E

& options. .
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In addition, you can execute to trace an IP with Colasoft Capsa conveniently. Select a packet in the Packets view
and right click, choose the Tracert command. The source and destination IP address of the selected packet will
be listed out, you can trace either one by its hame or both by the All command.

| Tracert V| aomaszeis |
Select Related Packets 3 192%8. 0.90
Hide Selected Packets w11

Now let's trace 207.46.26.109 by click its name. System will trace the this IP address and display the details of the
execution in the popup window.

\systemi2\tracert. exe

Tracing route to byZmsgl242814._phx.gbl [287.46.26.16891]
over a maximum of 38 hops:

28
11
8
11
18
18
43
111
33z

E 3

i8
11
22

?

?
18
43

192.168.8.1

222.218.172.1
220.167.24.21
221.237.185.21
222.213.1.177
282 .97.78.198
2082 .97.43.157
282 .97.33.158
282 .97.51.230

3
3
2

3
3
2

3
3
2

3
3
2

3
3
2

3
3
2

El El
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El
El

El
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El
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Send packet

Users can send the captured packets listed in the Packets view and Packets list sub-view of Conversations view.
Select one or more packets and right click, choose the Send Packet command to open the Send Packet dialog.

Send Packet

Opkions

[ 1Burst Mode {no delay between packets)
[ ]Loop Sending: loops {zero for infinite loop)

Delay Between Loops: milliseconds

Sending Information

Taokal Packets: 180 =1
Packets Sent: ]
Progress: [ ]

Skop L Close J [ Help ]

Adapter

Users can define a adapter for sending packet from if there are more than one adapters in the PC. Clicks the
"Select" button on the right of "Adapter:" to open the Select Adapter dialog, chooses an adapter from the combo
box. The window under the combo box will display the detailed information of the selected adapter.

Select Adapter

Adapter; [ ased PCI Fast Ethernet Adapter

Physical Address:  00:0B:68:58:CF7A(502,3)

Link. Speed: 100.0 Mbps
May Frame Size: 1500 bytes
IP Address: 192,168.0.28)255,255,255.0

Default Gateway:  192,168.0,1 (00004 26:3F9E)
Adapher Status: Cperational

L Ok J [ Cancel ] [ Help

Bust Mode

Check this option, Colasoft Packet Builder will send packets one after another without intermission. If you want to
send packet as the original delta time, please do not check this option.

Loop Sending

Defines the repeated times of the sending execution, one time in default. Please enter zero if you want to keep
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sending packets until pause or stop it manually.

Delay Between Loops
Appoints the interval between every loop if you defined the loop times more than one. Colasoft Packet Builder will
send without interval between every loop in default.

Total Packets
Displays the number of sending packets. For example, 4*5 means four packets are selected and each one will be
sent five times. So Colasoft Packet Builder totally sent out 20 packets.

Packets Sent
Shows the number of packets have been sent successfully. Colasoft Packet Builder will display the the packets
sent unsuccessfully too if there is a packet did not sent out.

A dialog will display the results of the execution. The sending parameters can be seen on the top on the dialog.

Send Selected Packets

Options

Adapter:  SiS 900-Based PCI Fast Ethernet Adapter

[ ]Burst Mode ino delay between packets)

Loop Sending: loops (zero For infinite loop)

Delay Between Loops; milliseconds

Sending Information

Tokal Packets; 4#*5=20
Packets Sent: z0
Progress: [IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII

Shop [ Close J [ Help ]
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Customizing User Interface

Customizing User Interface

Colasoft Capsa 's user interface is flexible and easy to use, sometimes you can change it's settings to get a
clearer view. Basically the customizable sections or commands include the following:

Name Description Applicability \
Toolbar* Adds new toolbars or commands, | toolbar

shows or hides toolbar text ...
Columns* Shows or hides columns, changes | Summary view, Endpoints view, Protocols

the position of columns.

view, Packets list view, Conversations view,
Logs view

Docked windows*

Shows or hides the project
explorer bar...

Project Explorer, Project Status

Sorting* Sorts the listed data on a specific Endpoints view, Protocols view,
condition. Conversations view
Highlight Highlights the packet selected. Packets list view

Packet Comment

Makes a comment for the current
packet.

Packets list view

Show/Hide Packet List

Shows/hides the list of captured
packets.

Packets view

Hide Selected/Unselected
Packets

Filters the packets displayed.

Packets list view

Show/Hide Decode

Shows/hides the packet decode
information.

Packets view

Show/Hide HEX

Shows/hides the HEX code of the
current packet.

Packets view

Name Table

Makes an alias for the selected
item.

Project Explorer docked window, Endpoints
view, Packets list view, Conversations view,
Matrix view, Logs view

Expand/Collapse All

Displays/undisplays all available
data.

Project Explorer docked window, Summary
view, Endpoints view, Protocols view, Matrix

view, Packets decode view

The sections below give details about the items marked with *; for the explanation about those features not
described in this chapter, please see the corresponding sections in this manual.

Toolbar

The toolbar includes some icons of frequently used commands, such as New, Open, Save , Start, and so on, you
can customize the commands or options in the toolbar.

Hide toolbar

Colasoft Capsa shows the standard toolbar by default. To hide the toolbar, open the View menu and put the
mouse cursor on Toolbar, then uncheck Standard.

Hide toolbar text

Colasoft Capsa shows the text under toolbar icons by default. To hide the toolbar text, open the View menu and
put the mouse cursor on Toolbar, then uncheck Icon Text.

Customize toolbar

Colasoft Capsa allows you to customize the toolbar commands, which is similar as the operation of Microsoft
Office. You may open the View menu or right click on the toolbar, then select Customize... to modify the toolbar
commands.
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Columns

Colasoft Capsa displays captured data with corresponding column headings, you can select more columns to
show more information, or alter the position of columns.

Show more columns
Right click a column heading in a tab view (except the Summary and Graph view), select the More... command to
open the Select Column dialog, check the columns to show or uncheck to hide.

Column display options
By default the data displayed in a column are aligned left, but they also can be aligned center or aligned right with
the alignment options in the Select Column dialog.

Column width
To increase or decrease the width of a column, just hold down the mouse button on the column line and move
horizontally; or you may fix the width in pixel in the Select Column dialog.

Change position

To change a column's position, move your mouse to the column, hold down the mouse button and drag the
column to your intended position. You may also do the operation in the Select Column dialog with the Up or
Down buttons.

Select Column

Select column ko show:

Mo. | Shiow
Absolute Time
Source
Destination
Pratacol =

Surnmary
|:| Drate
] pelta Time W

] relative Time
] 1P 1dentifier
[] source Physical
[] Destination Physical i e

width of selected column (in pixels):

L Ok, I [ Cancel

e

© 2009 Colasoft. All rights reserved. Colasoft®, the Colasoft logo, Capsa® are among the trademarks or registered trademarks of the company in

the United States and/or other countries. All other trademarks are property of their respective owners. 131/131




Maximize Network Value

,‘\;Colasoft“’ Customizing User Interface

Sorting data

Just with a click or double clicks on the column headings in the Endpoints view, Protocols view and
Conversations view, the sort order will be changed. Theicon " indicates the data in this column is displayed by
descending, and the icon + indicates the data in this column is displayed by ascending.

Sort endpoints by Total Bytes

SurMmary rDiagnosgstndpuints rProtoc‘,':ls rConversations rMatrix rPackets Logs | Graphs rReports ]

| Type Al SEER g o= 2P
Mame | Tokal By'tes\_ Bvtes COut | Bytes In | Tokal Packets | Packets In | Tokal Bytes%:
@--@Local Segmenk 3086 ME 22625 MB 55,357 24,095 99.918%

= % Local Host | 27.308 M| 2767 MB | 24,521 MB 53,428 29,693 97.204%
=B asiarock: 1F: 1895 N 2787 MB  24.521 MB 53,428 29,693 97.204%

L W Eva EEEE 2.783MB | 24.518MB 53,325 29,651 97.182%

A Realek Semitad:7a:CE I 2,335 ME 1,920 ME | 425,723 KB 10,722 4,915 8.313%
a officel I 2,299 ME 1,884 ME 425,723 KE 10,366 4,915 8.185%

a 192, 168.0.2 | 29,445 KE 29,445 KE 0e 238 0 0.102%
D-Link:65:75:49 | o58.794 KB 247 0ZLKE  1L.773KE 3,289 103 1.942%
a office? | 208,074 KB 200,953 KB TAZ1KE 1,643 == 0.723%

Dock windows

The Project Explorer and Project Status are both dock windows which are on the left section of display by
default, you can hide or alter their positions.

Hide dock windows
Click the & icon to hide a dock window; to show it again, put your mouse cursor on the dock window button, then
click the & icon again.

Close dock windows
Click the = icon to close a dock window. To recover the display, click the Explorer or Status icon in the toolbar,
or make selection from the View menu.

Change position
To change a dock window's position, move your mouse cursor to it's title bar, hold down the mouse button and
drag the whole bar to your intended position.

Reset
Double click the title pane, the dock window will be reset to default position.
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Performance Optimization

The performance of Colasoft Capsa depends on many factors like network environment, network scale, traffic size,
etc. To get the most out of Colasoft Capsa you can take the following measures to optimize its performance.

Program configuration
By default, Colasoft Capsa captures and analyzes all the traffic passing through your network. When you only
need to analyze segmental packets, the efficiency will play down if you maintain the default settings.

Packet filters
The packet filters in Colasoft Capsa are flexible and customizable, you can discard undesired packets by setting
filters to increase the analysis speed.

Logs
The logs can be disabled in the Project Setting - Log page. When you disable a log, Colasoft Capsa will not
display the logged data corresponding to it.

Packet buffer size
The packet buffer size is set to 16384 KB by default and should be customized according to your system memory
size, it might slow down the system performance if you set a big value.

Project settings

Some project settings may increase the resource occupation of your system, such as resolve host name of
captured IP addresses, enable logs, save log file to disk, etc. You can enable such optional functions only when
necessary.

Analyzer
The more analyzers are enabled the more system resource and memory will be occupied. You can disable some
analyzers in the Options - Analyzer dialog.

Packet decoders
The more decoders you enable for packet decoding, the more system resources are occupied. You can disable
some packet decoders in the Options - Decoder dialog.

Multiple projects
It will increase system's resource occupation when multiple projects are capturing. It would be better not to use
multiple projects if a single project can fulfill the monitoring work.

Monitoring multiple adapters

Colasoft Capsa can monitor the traffic passing through different adapters (unique to enterprise edition), but
opening multiple adapters simultaneously may play down the program performance. To ensure the capture and
analysis efficiency it is recommended to open an adapter at a time.

Hardware optimization

The minimum requirements for Colasoft Capsa are PllIl 500 CPU and 256 MB RAM. With the minimum
requirements Colasoft Capsa can work well in a small network; however, it may occur such problems as slow
analysis speed, unstable system performance or even crash in a big network (e.g. a network with over 1024
hosts). If so, you need to optimize your hardware facilities.

CPU

CPU is one of the most important symbols for system performance, you can enhance the system and program
performance using a CPU with quicker process speed.

System memory
Another important symbol for system performance is system memory. Sufficient system memory can ensure the
speediness of project storage.
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Hard disk/NIC
Such system assistant facilities also may affect the performance of Colasoft Capsa, it is recommended to use
high-speed hard disk and 100M - 1000M adapters.

Operation system and system services

The performance of Colasoft Capsa may also be influenced by other running processes, enabled services or
defined virtual memory. On the server installed with Colasoft Capsa you should enable as few
applications/services as possible, expand virtual memory and do not offer outbound services. In addition, since
higher operation system occupies more system resources, it is recommended to adopt the most appropriate
operation system in view of different configurations.

Network topology optimization

The network topology is very important for network monitoring and analysis, too many broadcast, multicast or
loop-back packets will add the resource occupation. You should check your network topology, avoiding loop-back
traffic or improper connections to reduce trash packets in your network.
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